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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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1.4

1.41

When you invoke the application, the Sign In screen is displayed.
ORACLE: O

Financial Services Lending and Leasing

sign In

Please enter userid and password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane
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e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

ovn - EISEE O

DashBoard
4 Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

About

Oradke Finandal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1885,2017, Oracle andior fs afflstes. Al ights reserved.

Oracke and Java are registered trademarks of Oracke andlor s af filates. Otfer names may be trademarks of thei respective owners.

property laws. Except as expressly perited in your lcense agreement or alowied by law, you may not use, copy, reproduce, ranslate, broadcast, modify, liense,
transmit, distribute, exhibd, perform, publish or display any part in any form, o by any means. Reverse engineering, disassembly, or decomplation of tis software,
unless required by law for nteroperabilty,is prohibted.

The information is subject

If you find any errors, please report them o us in wriing.

that US. Government or behalf of the U S. Govemment, the following notice i
appicable:

U.S. GOVERNMENT END USERS: g tem, any hardware, andior
documentation, delivered o U.S. - Jation and agency-
‘specific supplemental reguiations. As Such, use, duplication, disclosure, modificaton, and adaptation of the: programs, inciuding any operating system, inegrated
software, any programs installed on the hardware, andior documentation, shal be Subject o icense terms and icense restrictons applicable to the programs. o
other rights are granted to the U.S. Government

This software or hardware is developed for general use n 3 variety r use in any nherently
dangerous applications, including create 5 risk o pe jury. f you use this soft hardware in dangerous applications, then you shal
be responsibe to take all appropriate falsafe, backup, redundancy, use.

liabitty for any damages caused by use of this Software or hardware in dangerous applicafions.

may informaton on content, products and services from third parties. Oracle Corporation and ts
y respect o third-party content, products, and services. Oracle Corporation and
s affilates wil not be responsile for any loss, costs, or damages incurred due {0 your access to or use of tird-party conten, products, or Services.

| Qo |

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

AIDYA ~

* Welcome, & Sign Out[QA]
Change Password

m  UserInfo i3]

— Change Password — Click to change the current password.
L 7 I— TR

-
ek

Ir

s
e
-
-
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division U301 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDVA Company US/CENTRAL (CENTRAL STANDARD
) i Branch Time TIME)
Responsibility SUPERUSER S
GLPost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|5 Submit | 3% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on := List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
BatchJobs  Jobs  Services Database Server Log Files = Parked Transactions | Users -
Database Server Log Files
View v Format~ Freeze i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 lob 5706 D2/18/2016 06: 1% 11 AD »
ALERT lob 395 02/22{2016 03:58:16 AN_|
CSYPRC_EN_100_01 DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSYPRC_EN_100_01_DB12C_3854338 lob 116750 02/22/2016 05:36:42 A} 7
JSVPRC_EN_000_01_DB12C_2004362 lob 5706 02/18/2016 10:57:09 AP =
4 m ] r
r
File Content
View = Format ~ Freeze I Detach &l Wrap o0} 7 Beginning @ End  # of Lines ' 50 [E] Show File
Text
0 7:44:11: 45:FLL:1v_use BI::¥ [
o 7:44:11: cmnsyp cl_DOD_Dl.get_syp parameter value value: weblagic
0 4:11 .get_syp parameter value value: http://ofss2221142.in.oracle.com:.
0 4:11 .get_syp_parameter_value value: http://ofss2221142.in.oracle.com:
o 4:11 .get_syp parameter value value: /scratch/work area/DEV/QAL43REL/r. |
0. S JSV_BI_USER
o} 4:11 1.get_syp_parameter_value parame J5V_REPORT_ARCHIVE_DIRECTICRY
0 4:11 1.get_syp_parameter value parameter: JSV_REPORTS SERVER TIMECUT A

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
e Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.
e Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and < to collapse them.

» DashBoard
> Origination
Servicing
Eles 5
Customer Service Il
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions

m

Account Documents d
Collateral Management |
Reparts
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions -
> Collections
> WFP
» Tools

> Setup
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’
Financial Services Lending and Leasing

A @ | Access x (0 Gose
Applcation Retrieval{Originatior) Data Sween Reports | Corespondence | Transaction
Applcation Documents (Crigination)
hsset Types(setup Products) Aeoes Gild Fpadd || ZEdt | [Fvien || At
, 3
Account Documents(Servicing) Vew~ Fomat~ | B Freeze (o Detach virap ®
Access(Setup User)
P ————— Organization Divion Company Branch Alowsd
‘rsnssc ors(sevieng ntefoces e R AL AL ¥
Applcation Entry(Origination) e e AL AL ¥
Audit Tables(Setup Systerm) e B AL AL \
Advances(Servicng Batch Transactions) e P04 AL AL A

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

RACLE
Financial Services Lending and Leasing

& Welcome, VAVAIDYA + [=}

Sales ead x Close
> DashBoard s L.

/Le;aknl’l’v Follow-p | Maintenance
% Fresze

Applicant Information

= )
e

L-00003002 121772015 uso1 £onD rES rorE
L-o0002002 121212015 uso1 usii PIANINDRA ciioa tore
L-o0002004 12/12/201 uso1 usii DoRCH oocRT 1ot X
Looooco02 02/02/2010 uso1 usiio N 20510 CONSULTATION  OFTLINC APPLICA.. 1IOM ADD1 A
Loooo1001 121072015 uso: usko ANDRES ManTInez o8/06/1980 CONSULTATION  wes ENTRY HowE LeAD ey 22
L aoooson2 122372015 uso: usko A san 11232901 HowE UNITEDSTATES 123 ronce

ke || Reauest

b add || Z oo |[ Elview || o ave
rrrrrr 2 petact @

rrent

Te
CARJMOBILE PHONE

Phone Cur
(0045323923 ¥
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You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ORACLE"
Financial Services Lending and Leasing
5

o Efioctach

AUL) PAULA 02/09/2010 crarceporr error VeRourru
20160100014000:000 SUmAN G2ioa/200 Clianccoorr CRnon Vemoun
uetach wee | @
Vue e
o350t ¥
\ Y

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications at the same time as separate tabs in the right
window, provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'="Y’
in MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Applications in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Origination Module Master
Tab. In the Left Menu of Origination Module Master Tab, you can open multiple applications
by clicking on the following links. Each successive click, opens a new Origination tab.

e Simple Application Entry
e Application Entry

e Underwriting

e Funding

ORACLE' 1 ABSHEKAR ¥ g Signout O
Financial Services Lending and Leasing

a‘| Origination » || Origination 5 | Crigination x = Origination x (36 Close
Search/Task  Funding: 0000001010 | Review Requests (Pendng: 0) £
> DashBoard
Origination Application: 0000001010: MILLEN JOHN Elvew | o Audt
- - Fresze i Detach 0 virzp v Wam v
pr—— View ~ Format B i P W overide ok jarming CK MANUAL Contract
ot A= Sub Unit Status nanasen SE8E  produce tame mrd‘::fr COMBEL o geting Customer  Dupicate Appication Cantact 3
imple Application Entry
07/25/2036 0000001030 UNDEFINED APPROVED - FUND... FUNDED MN-00004: SOUT.. (612)451-2211 N ¥
Application Entry = & .
Underwriting
Funding
Application Retrieval
S Anys Summary | Appicant | Request | Decision | Contract | Colateral | Comments || Trackng | Document | Verification | Correspondence | Tools
Application Documents
Image Mantenance At
Reports
Producers Applicant
s Pl Relation Type First Name Last Name Brth Dt Own fRented
2| PRIMARY JOHN MILLEN 07/17/1991 UNDEFINED
Ratios
Ratios
Grade Score What IfPmt Amt. Assets Amt Lisbilties (3 Net-Worth Amt
> 0 0.00 0.00 0.00 0.00
Bureau
> Servicing
> Collections Bureau
> WEP Buresu Report Name FICO Score Tradelines Auto Tradelines ¢ P BI® Notices (FE)  Type ot
> Tools [ » [o0 CREDIT REPORT ... JONATHAN JENKINS 536 % % o 0 MANUAL 07/26,
> Setup bl . -
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Few screens in Origination are identical and are linked. Hence, when multi tab option is not
enabled, you can open only one screen at a time from the group. A sample of the grouping
structure is given below, based on stages of the screens:

Origination:
e Simple Application Entry
e Application Entry
e Underwriting
e Funding

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |:to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

ORACLE" # Welcome, VavAIDYA - ESTROWIGN O
Financial Services Lending and Leasing

Close.
> DashBoard Origination x —

origination Search/Tosk | Funding: 0000000378 | Review Requests (Pending: 0)

Application: 0000000378: TIFFANY RUSSEL / GRACE B view || o audt
Vieww Format~ B ] Freeze i Detach wap | @) OvemideOK ¥ WamingOK ¥

— Hentfication
Applcation Coptac ' i
01/01/2012 0000000378 UNDEFINED APPROVED - FUNDED FUNDED GA-00004 : ADVANCE LEA. N N

Origination Stage

ot App Sub Unit status e

pre
Producer liame Co Bxisting Customer
t
, Summary
Requested  Approved
1500000 1500000

8.9900 43900
3 3

Summary | Applicant | Request || Decision | Contract | Collateral | Comments | Tracking | Document || Verfication | Correspondence | Tools

> Applicant

‘ » Ratios

> Bureau

> Checklist Change Status

Status APPROVEE

Collateral

Collateral

Asset Type SubType Primary  Year Hake Hodel Hileage New Wholesale Value
~ Servidng VEHICLE AR Y 2012 CHEVROLET. MONTE CARLO on 10,000.00
> Collections Type =
3 Sub v
RAWED Trade-In Type
> Tools * Comment
> Setup Trade-In > -

Add Comment
= Alert

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
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Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

RACLE
Financial Services Lending and Leasing

Customer service EE
seach
Quick Search
Elven || Pasit ek
foen ® @ B ©CurenO shon O GoupFolowss
bt At = ot DayspastDue urency PayOfiAnt  amountue Stais OdestoueDt  DiQesson
oETED 0170100010057 | LOANVEHICLE () o 153855 2,21 (R opoporr steameToR.
Bwat| [ @oex
Servee | AcountDetal | Customer Detals | Customer Prferences | Transacion story | Pt Modes || Benknptcy | Repoffrecoare | Defency | Clatrl | Bureau | Timelne || Crossfp sl Acotes | Extena nterfoces
Q= =
Aerts Condtions
B tiextAccont
Alerts Conditions
At Account Condien ConditonstartDt Folowp 0t
. o e Accant
Nodata o deply Repossession pmy ooz L
oemaET csmy o P —
e RESAA 5]
sy B
Account Details OtherInformation o
Dues Colateral Information
sy ejomy  oomy  oeomy  osiop Py Descon Uertfatm s Year At AmetTipe  SbTie
g =m0 =0 3 9 sz v P6CEROETHONECRLO DR BAPASGORIRIS2 205 N Wz om
s 2
3 Customer Information Hpostgoment | | @0
T = e etien = oD o e oliaiil
7 oo HAOHAN ORACE ProwRy o casiises noened o =
ot ozwn «
=
o1 EDULSRSIQOMAL COM E . =
s Actve [
P Corrspdence N
Colector DEMOCOLL
Address Information =
pemsson
e Coment PSS ey adkess e )
Activities e v v e s &
x Charge offot =
- ity Dty N "
i 2 5 Employment Information

B Postcal ctvity | [ @ Clesr

e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘ldentification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search
and listed in Queue Assignment section.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to

increase the visible area of the screens. Click =u to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.
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Time Zone Preference

Oracle Financial Services Lending and Leasing %
User Info
Organization DMC Time Zone |JSER TIME ZONE v
Division S0 Level
First Hame VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)

Responsibility SUPERUSER Zone

G Bost Lere IR 20 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT b skin Family Skyros (Default) il

Debug Enabled Ind

DE Submit || ¥ Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.
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1.4.2

1.5

1.5.1

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘SEE\(\! Customer Service: 20120200010231 Pau\ewR!qhe:t‘\Penmng:D)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE [E]view | o audt
Vieww Format 5} Freeze PfiDetach | Jwap | @) & @ Curent O showAll © Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Uso1 USR1 UNDEFINED 2012020010231 LEASE VEHICLE 0 USD. 0.00 0.00 ACTIVE 02/10/2015

‘Eun'n'al‘,‘ Customer Service = Account Details | Customer Details | Transaction History | Pmt Modes =~ Bankruptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\u::,‘bpSeH»‘-L‘t\‘,‘\tie:‘

‘CallAdi\lilies Maintenance ~ Comments Promises = Checdists Tracking Attributes ~ References  Correspondence  Letters  Document Tracking

call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Follovup Dt Time Zone Adj Folloviup Dt Con
AT PH ANSWERING MACHINE N 12/30/2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
AT PH ANSWERING MACHINE N 12/302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM

b

You can click # to view the hidden tabs, if any.

Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations
e Basic Actions
e Personalization Options

Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
e Audit

e add | A Edit | S view | o Audit
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1.5.2

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

E Save and Add

E Save and Stay

E Sawve and Return

{3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

= [F[E

Click to navigate to the next record.

Click to navigate the last record.

A

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬂr Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

LI b showal
| Freez= + Product |
Detadh + Description ,
#ork » ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| e
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column = I

Column DESCRIPTION

width | 100 ] [pixels [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format{ Freeze i Detach o1l Wrap o)
¢ | | @) %) i_
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options Description

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

loan  lne  lesse
Product Definition dpadd | Sedt | Evew | Lot
view - [Faimats] | B | [Freee ffivetach | [EIWRBN | @ NewProduct Create Copy
! I | | |cotiateral Sub Tyoe |CreditBureau
Jproduct et Jenao [prea |Fextle Repayment |enabied Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME () p1/01/1800 12/31/4000 B 12 Y 'HOME COLLATERAL  REAL PROPERTY HOM INSTALLMENT
LOAN SECLRED
LOAN-SG 12/31/4000 N N Y HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
LOAN-UN i &1 /01/1800 12/31/4000 Y Y Y UNSECURED COLLATIUNSECURED INSTALLMENT
LOAN-VE LOANVERICLEFR)Y p1/01/1800 12/31/4000 N Y La VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MDP1 MOP1. 3/08/1863 12/31/4000 Y N id VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA ) A LMY 1/01/1800 03/13/2013 Y N Y HOME COLLATERAL REAL PROPERTY HON INSTALLMENT
s NORMDSER. 3/11/1853 12/31/3000 v N v UNSECURED COLLATIUNSECURED INSTALMENT
o1 e 1oy/201 12/31/000 v N v HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

View Last (2 1Day (7 1 Week(©) 1Month @) By Date  StartDt  07/01/2017 I'_?'@ EndDt 09/20/2017 E"@ &

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

Detach
opacLe
Financial Services Lending and Leasing g C)

—— Ly customer serce =
> Origination Search | G : quest (Pending: 0) -
Servicing
Setiia Account(s): 20120200010231: YUTAKA OZAKA / AKANE Bl view || «2 Audt
Cusbootns Senice Vieww Formatw [ Freeze 5 Detach o wrap W & @ curent O ShowAll C: Group Follow-up
Securitization Company Branch Sub Unit Account Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization usot Usk1 UNDEFINED 2012020000231 LEASEVEHICLE 01 000 0.00 ACTIVE o2j10/2015

Post Date Checks
Escrow Transactions =
e Summary | Customer Service | Account Details | Customer Details | Transaction History | Pmt Modes || Bankuptcy | Repo/Foreclosure  Deficiency  Collateral | Bureau | Cross/Up Sell Activites
ccount Documents

Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence  Letters Document Tracking

Repoits
Producers
Vendors Transaction Batch Information padd | At || Fview | & Auit
Batch Transactions Views Formatv [ Freeze B Detach Wrap W Frrost [ vod
bk Transaction Status Batch

ADD CUSTOMER ADDRESS PHONE POSTED
TERMINATE ERROR

Interfaces TERMINATE VoID 4
nunbnts EEusION o
Detached Table *
View~| Format v [ Frecze [[EBetadh vap @ ot [5hvoid
Date Monetary Transaction Status Batch
0aj10ja016 N ADD CUSTOMER ADDRESS PHONE POSTED 0
01/07/2016 id TERMINATE ERROR N
oy/05/2016 v TERMIATE von N
01/06/2016 i EXTENSION Vol N
Lot v PAYOFF QUOTE LEASE POSTED N
View~ Formatv [ Freeze £ Detach wap @
> Collections Transaction Processing Detils
SWER. (] | Direct Record Update, Transaction Posting Successful **++%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:
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e Drop-down list — Provides the selection option. You can either select a record from the
list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

ORACLE" % Welcome, VAVATDYA v o

Financial Services Lending and Leasing
i Customer Service x Wcloe
> Origination Search | G quest (Pending: 0)
Serviding
sarviing Account(s): 20151200010012: MADHU BOBBURI Eview |[ Pt

Customer Service View v Fomaty [ Freeze i Detach Nrap W & ® curent O showAll O Group Follow-up

Securitization Company Branch Sub Unit Account = Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt

skl uso1 usHg 2015120001002 LOANVEHICLE (FR), 5031881 ERUERT] ACTIVE:DELQ:NON PERFO.. (BTN

Transaction Batch Information

Escron Transactions 5
g B Sunmary | Customer Service | Account Detals || Customer Details | Transaction History | Pt Hodes || Bankruptcy | RepojForedos’ ¢ 2= =
Collateral Management Call Activities Maintenance Commen ts || Promises | Checkists | Tracking Attributes || References  Correspondence | Letters [ Jgearch T —
® a1 O any
Transaction Batch Information f o add |/ gat iew || < Audit
View v Formatv [ Freeze ! Detach Wrap (5] EPost  [G1 Void cription
Date Wonetary Transaction ACCOUNT CL r 3
a/10f2016 ¥ pltase Search: Transacti
‘ 01/25/2016 [ ACCOUNT SUB UNIT TRANSFER AiSTET
03/22/2016 », ACH MAINTENANCE esciplion Seany s
oyj072016 [ ACH ONE TIME PHONE PA pl i L
/ i ACHON NE PAY ADIUSTIENT Match @ all © Any
GLTransactions 12/15/2015 v ADJUSTMENT TO ADVANCE / PRINCIPAL - ADD by
o 5

Reset | | AddFields ~|| Rearder

Date 02/10/2016
* Monetary @

ok || Cancel
> Collections B | [ Freeze £ petach )
Cil Required
MR o data to dicplay.
> Tools
bisen Result ,

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
| * Channel | WEB ENTRY = * Producer Name [
NY-02 : PR : HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
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1.6

1.6.1

Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a

combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt +y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the

keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Operating

monic

Browser Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click

monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
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1.8

1.8.1

1.8.2

1.8.3

Shortcut Action

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.

Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users
without the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high
contrast mode and automatically render content that is compatible with OS high
contrast, eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built
on Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
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Usage of styles and formatting elements
Documentation in simple language to ensure easy understanding

Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate
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2. Administration System

In Administration > System, you can record setup data related to the application’s overall
functionality and performance. This data affects;

e The mechanics of the system
e The processes of the system
e The search for Location of files to complete the tasks.

Navigating to Administration System

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System

The System drop-down link records the following data:

e System Parameters
e Lookups

e User Defined Tables
e Audit Tables

e User Defined Defaults
e Transaction Codes
e Data Files

e Events

e Batch Jobs

e Producer Cycles

e Vendors

e Collection Cycles

e Reports

e Error Messages

e Translations

e Seed Data

Using these parameters, you can control the behavior of the system from a technical

perspective. For example, determine parameter values, define what information is audited,
and record default values. The product provides default values for all these screens.

System Parameters

System parameters define information or values used throughout the system. They act as
switches that control the manner in which a function is implemented, or whether or not the
system performs a particular task. Parameters are used throughout the system to control
everything from user access to what information is stored on any given form. Parameters also
define configuration data, such as the location of the system files, the URLSs for the report and
image servers, and other administration controlled data. Some of the system parameters are
setup when the system is installed, but the values associated with the parameters need to be
reviewed and maintained.
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There are three types of parameters in the system, grouped by what part of the system they
affect:

Parameter Type: Parameter Range:

System parameters These parameters apply to the entire system.

Examples: batch processes, archiving, aging.

Organization parameters These parameters apply to the organization, division,
and user responsibility.

Examples: User login control, password expiration.

Company parameters These parameters apply to the company and branch.

Examples: decision fax control, scoring model.

Hence, the System Parameters screen contains the following three tabs:

e System Parameters
e Organization Parameters
e Company Parameters

System Parameters Setup

The System Parameters Setup screen displays and records each system wide parameter,
along with its current value and whether or not it is enabled. These parameters relate to the
overall processing of the system, such as application server file locations and data purging
configuration.

Note

You can only define these parameters. Changing the values of any of these parameters
affects the related processing.

To set up the System Parameters

1. Click Setup > Setup > Administration > System > System Parameters > System. The
system displays the System Parameter screen
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2. In the System Parameters section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE

Financial Services Lending and Leasing

= Welcome, PRAKRRAO ~ o

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Sefup
Setup
Administration
System
System Paramets
Loakups
User Defined Tat
Audit Tables
User Defined Def
Transaction Code
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cycles
Vendars
Callection Cydles
Reports
Error Massages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondznce
General Ledger
Queaues
Printers
Bank Details
Chack Details
Standard Payees
Currencies
Zip Codes
Products

< >

System Parameter y; [3€] Close

System | Organization | Company

System Parameters deadd | FEdit | 2] view | & Audit

View v Formatv [ F
Parameter Paramater
AAIPRC_B]_100_0... AAIPRC_B)
ACAPRC_BJ 100_.. ACAPRC_B]
ACA_DLQ_AMT_E... EXCLUDE DE
ACA_PAYMENT_A
ACA_PRENGTE_D.

Paramater Value Enabled

2
2
NCY AMOUNT FOR ACCOUNT ACH N
ENT LOAD FROM ACOOUNT ACH ¥
DAYS FOR PRENOTE TO GOCUR FOR ACCOUNT ACH 7

2

'S BEFORE DRAFT DAY FOR ACCOUNT ACH PROCESS
AYS BEFORE DEEIT DAY FOR ACH PROCESS IN FIRST TIME/ONE-TIME CASE 32.00
100_01_DEBUG_LEVEL

ACCDMP_BT_100_
ACCVAL B 111__ A
ACCVAL B 112__ A
ACCVAL B] 121_
ACHPRC_BJ 100_... ACHPRC_E) 100 01

SRR

ACH_PAYEE_PREN... NI
ACMPRC_BI_112_
ACPPRC_BJ_100_
ACYPRC 1 100
AC(PRC_EM_100_
anmmv <FRvER

N
2
¥

¥
¥
=
N
N
N
N
Y
N
N
¥
N
N
N
N
v

bt Hashfnars o comeRnn T fer

System Parameters
Save and Add || [ Save and Stay || [ Save and Retun || (3 Retum

Parameter * Enabled []
* Parameter Des

* Parameter Value

A brief description of the fields is given below:

Field

Do this

Parameter System parameter of the specified parameter description is
displayed here.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Specify the value for the system parameter (required).

Value

Enabled

Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

FCUBS Integration

Oracle Financial Services Lending and Leasing (OFSLL) is integrated with Oracle
FLEXCUBE Universal Banking System (FCUBS) with the capability to integrate the
centralized CIF (Customer Information Files), ELCM (Enterprise Limits and Collateral
Management) and CASA (Current Account and Savings Account) modules.

To work with the integrated environment functionalities, you need to enable the following core
banking indicator.

Parameter

Parameter Description

CMN_CORE_BANK CORE BANKING INTERFACE INDICATOR
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Note

Re-qualification is pending for Core and Direct Banking Integration.

For detailed information about integration changes, you can refer to ‘FCUBS Integration
Documents’ section at OTN library (http://docs.oracle.com/cd/E59770_01/homepage.htm).

Organization Parameters

The Organization parameters control the system functions related to user log in, such as
passwords and expiration dates, responsibility levels and the ability to access the system
features. Individual parameters can be created with different values for uniquely defined
organizations, divisions, and responsibility combinations.

When determining which parameter to use, the system selects the best match based on a
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL
being a lower order match than an exact match.

For example:

Assume the organization parameter UIX_APP_VIEW_ALL_APPS (VIEW ALL
APPLICATIONS) is as follows:

e If auser belongs to an organization as ‘DMC’ with a responsibility of SUPERUSER and
is using the Underwriting screen of Lending menu, the system will return with a value N,
and the system will not allow the user to view all applications.

e If the user belongs to any organization with a responsibility of SUPERUSER, and is
using the Underwriting screen of Lending menu, the system will return with a value Y,
and the system will allow the user to view all applications.

Note

Be aware that while the system allows for Organization parameters to be defined at all
three hierarchical (organization, division, and responsibility) levels, not all will be applica-
ble to each parameter. For example, while you can define the UIX SMTP_SERVER
(EMAIL SERVER FOR USER) for a responsibility, you would normally want only to define
this parameter based on organization or division.

To set up the Organization Parameters

1. Click Setup > Setup > Administration > System > System Parameters >
Organization tab.
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2. Inthe Organization Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.

ORACLE

Financial Services Lending and Leasing

DashBoard
»> Origination
> Servicing
> Collections
» WFP
> Tools
Setup
Setup
Administration
System
System Paramets
Lookups.
User Defined Tat.
Audit Tables
User Defined Def:
Transaction Code.
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cydles
Vendors
Collection Cycles
Reports
Error Messages
Trenslations.
User
Organization
‘Comgpanies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queuss
Printers
Bank Details
Check Details
Standard Payess
Currencies
Zip Codes
Products

< »

~

System Parameter 36 Close
System  Organization  Company
Organization Parameters padd | edt | [Eview || of audit
View v Formate [ Freeze i Detach Wrap @
Parameter Parameter Description Parameter Value Organization Division Responsibility Enabled
MAX_PASSWORD._... SET THE NUMBER TO RESTRICT PASSWORD REPETL.. 0.00 AL AL ¥
UCS_GROUP_FOL .. DAYS TO CONSIDER FOR GROUP FOLLOW-UP, WHE... 10 AL ALL AL Y o]
UCS_REVIEW_QU... REVIEW QUEUE ALLOWED WITHOUT ENTERING CAL.. N AL AL ALL ¥
APPLICATIONS ¥ AL AL AL ¥
TRICTED DATE (FOR EXAMPLE 55N#) ¥ AL AL AL ¥
EMAIL SERVER FOR USER INTERFACE internal-maik-router.oraclecorp.com AL AL AL ¥
VIEW SECURED ACCOUNTS ¥ AL AL AL ¥
VIEW SECURED APPLICATION ¥ AL AL AL ¥
2] USER LOGIN DAY END HOUR 24 AL ALL ALL ¥
ULG_DAY_START  USER LOGIN DAY START HOUR o AL AL AL ¥
USER LOGIN MAXIMUM FAILED LOGIN TRIALS BEFO... 853999999999 AL ALL AL ¥
JSER LOGIN MAXIMUM INA DAYS BEFORE D... 99999999999 AL AL AL ¥
ALL AL AL ¥
AL AL AL ¥
AL AL AL Y
AL AL AL ¥
AL AL AL v
AL AL AL ¥
ALL ALL AL ¥ i
an an an v

A brief description of the fields is given below:

Field

Do this:

Parameter Parameter of the specified parameter description is displayed here.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Value Specify the value for the system parameter.

Organization Select the organization for which the parameter will be valid from
the drop-down list.

Division Select the department for which the parameter will be valid from

the drop-down list.

Responsibility

Select the responsibility for which the parameter will be valid from
the drop-down list.

IMPORTANT: In selecting which organization parameter to use,
the system searches for a best match using the following attributes:

1. Organization
2. Division
3. Responsibility

Hence, Oracle Financial Services Software recommends creating
a version of each organization parameter, where ALL is these
fields.

Enabled

Check this box to enable the parameter.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

Company Parameters

The Company parameters control the system processes associated with functions that may
vary for different companies or branches. These parameters address credit scoring, credit
bureau interfaces, fax services, and fax generation. Individual parameters may be set up with
different values for uniquely defined company and branch combinations.

When these parameters values are requested by the system, the system responds with the
“best” match based on a hierarchical sort ordered on company and branch fields, with values
of ALL being a lower order match than an exact match. For example, assume the company
parameter UIX RUN_AAI ACT (ONLINE ACCOUNT CREATION AND ACTIVATION) has
been defined as:

The system uses these two parameters to determine whether to create and activate an
account online.

e When processing items for the company US01, the system will return a value N and not
create and activate an account online.

e When processing items for the company other than US01 and within the value ALL, the
system will return with a value Y and create and activate an account online.

To set up the Company Parameters

1. Click Setup > Setup > Administration > System > System Parameters > Company
tab.

2. Onthe Company Parameters screen, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’
Financial Services Lending and Leasing
Close
DashBoard System Parameter x E3fe
> Origination System | Organization =~ Company
> Servicing
> Collections Company Parameters Hadd | Sede | Huvew | F audt
p— View v Fomatv [E Freeze i Detach o] Wrap o]
Faramster Parameter Description Parameter Valus Company Division Enabled
> Tools ™)
Setup AUD_ADV_REASO... AUTO DECISION ADVERSE ACTION REASON MODEL FICO AL AL ¥ ~
Sl AUD_SCORING_M... APPLICATION SCORING METHOD PRIM AL AL ¥
. P AUD_SCORING_M... APPLICATION SCORING METHOD WITH IN ALL BUREAU MAX_SCORE AL AL ¥
Administration
St CBU_DATA, R DATA SELECTION CRITERIA MONTHLY AL ALL ¥
EEr— CBU_DATA_SET_S... METRO 2 FILE DATA SELECTION CRITERIA MONTHLY uso1 usHQ N
LR CBU_FILE_FORMAT METRO 2 FILE FORM 830 AL ALL ¥
u
@ DD it CMN_ASE_VALIDA... VALIDATE A AKE MODEL DURING DATA ENTRY N AL ALL ¥
::’t : ;:e = CMN_CME_DEFAU... DEFAULT PRINTER NAME UNDEFINED AL ALL Y
& 'D'i Esd i CMN_WEEKLY_NO... WEEKLY NON-BUSIN Y UNDEFINED ALL AL ¥
e : COR_STORAGE_D... ORACLE DIRECTORY OBIECT NAME FOR CORRESPONDENCE DOC STORAGE COR_DIR_QA143REL_HQ ALL AL ¥
Transation Cocd DBR_JOINT_INC_... COMBINE INCOME AND DEBT WITH SPOUSE AND 2NDRY N AL AL ¥
Data Files DBR_JOINT_INC_ N AL ALL ¥
Detkipe DDP_CRE_EXPIRA... DEDUPING CREDIT BUREAU EXPIRATION DAYS 999008 AL AL Y
Secitiztion: DDP_DEDUP_DEB. . DEDUP CREDIT BUREAU LIABILITIES WITH SPOUSE AND SECONDARY N AL ALL ¥
e DDP_| DEDUP CREDIT BUREAU LIABILITIES WITH SPOUSE N AL AL ¥
Baich Jobs i) DOT_STOf ACLE DIRECTORY OBJECT NAME FOR ACCOUNT DOCUMENT LOADING  DOT_DIR_QA143REL_HQ AL AL ¥
Producer Cycles ECB_EDIT. BUREAU EDIT WILL FAIL IF ANY BUREAU FOR ANY APL WILL N AL AL ¥
Vendars ECB_U: RUN CREDIT BUREAU EDITS ONLY ON CURRENT SCORE Y A AL ¥ v
Callection Cycles FIN TMBGE STAT  NEFALIT TMAGE STATIIS FONF ENR FAY TN SERVICE n s an v
Reports
Error Messages Company Parameters
USJE"S‘E“MS saveand add || Bl save and stay || [ save and Retum | CaRetum
Organization
S Paromctr * Campany AL =
A Parameter Description - @ty (T =
Users . "
Parameter Value * Eriabled
Credit Bureau Enabled []
Comespondence
General Ledger
Queues
Printers
Bank Details
Cherk Details
Standard Payess
Currencies
Zip Codes w
Products
« i >
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A brief description of the fields is given below:

Field Do this:

Parameter The system displays the parameter, when you select parameter
description.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Value | Specify the value for the system parameter.

Company Select the portfolio company for which the parameter will be valid
from drop-down list.

Branch Select the portfolio branch for which the parameter will be valid from
the drop-down list (required).

IMPORTANT: In selecting which company parameter to use, the
system searches for a best match using the following attributes:

1. Company
2. Branch

For this reason, the Software recommends creating a version of
each company parameter where ALL is the value in these fields.

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

Lookups Setup screen

The Lookup Setups screen defines the contents in many drop-down fields used throughout
the system. Fields that make use of drop-down field will accept only entries that are stored on
this screen.

The Lookups screen contains two sections: Lookup Types and Lookup Codes. Lookup
types and codes can be system-defined or user-defined. The lookup types describe the
function of the related lookup codes.

For system-defined lookup types, only the Description field may be changed.

A system-defined lookup type (Lookup Types block, System Defined is selected) is one that
is critical to the system and cannot be changed. However, you can still modify the lookup type
description and Record indicator (Enabled/Disabled).

A user-defined lookup type (Lookup Types block, System Defined is not selected) is one
that can be modified, depending on a user's business needs. You can modify the description,
system indicator and record indicator. If a lookup type is user-defined, the lookup code
belonging to that lookup type can either be system-defined or user-defined.

A system-defined lookup code (Lookups screen, System Defined is selected) is one on

which the system processing is dependent. Without this lookup code, the process produces
incorrect results or fails.
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A user-defined lookup code (Lookups screen, System Defined is not selected) is one that
can be defined or altered by a user.

WARNING: System-defined lookup types are those that are required by the system. Their
related lookup codes will also be system defined. If you update and save a user-defined
lookup type as a system-defined-lookup type (that is, change the System Defined button from
No to Yes in the Lookup Type sub screen), the system will not allow you to change the lookup
type back to user-defined in the future.

Note

Lookup codes cannot be deleted, as they may have been used in the past, and the display
and processing of that data is still dependent on the existing setup.

Typically, the system Administrator would modify the descriptions of lookup codes and add
new lookup codes to the existing lookup types as needed.

To set up the Lookups

1. Click Setup > Setup > Administration > System > Lookups. The system displays the
Lookups screen. The details are grouped into two:

e Lookup Types
e Lookup Codes

2. Inthe Lookup Types section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

s
DashBoard o G

> Origination
Lookup Type dradd | At | [Hvew | o audic

> Servicil
% View » Fomatw [Ep Freeze ) Detach ol Wrap (5]

> Collections
> WEP
> Tools

Lookup Type Description

1098_POINTS_DISCOUNTS_ITM_CD 1098 ITEMIZATION TYPES
Setup
Setup
Admiristration
System
System Paramete
Lookups
User Defined Tat.
Audit Tables
User Defined Def
Transaction Codd ACH_ACCOUNT_TYPE_CD ACH ACCOUNT TYPE CODES
Data Files
Dedupe Lookup Type
Securitization
Events
Batch Jobs «
Producer Cydles
Vendors * Description
Callection Cydles * System Defined Yes/No () Yes®) No
Reports
5‘1;:s|:\::gh Lookup Code Fadd | FEdt || 5 view | o Audt
User View~ Fomatv Ep Fresze i Detach | ol wrap ®

ACCESS GRID TYPE CODES
ACCRUAL BASE METHOD CODES
ACCRUAL CALCULATION METHOD CODES

~

ACCRUAL START DT BASIS CODES
_TXN_] ACCRUED TXN BALANCE TYPE CODES

ACC_CONDITION_CD ACCOUNT CONDITIONS / ACCOUNT QUEUE TYPES (SUB OODE USED FOR DEFAULT QUEUE)
ACC_STATUS_CD ACOOUNT STATUS CODES

[ saveand add | [ save and stay Save and Return | 3 Return

“Enabled [

Organization =
rganization System Defined Enabled

Lookup Code: Description Sort Sub Code Ve

Companies
Access No data to display.
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products
< >

A brief description of the fields is given below:

Field Do this:

Lookup Type Specify the lookup type.
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Field Do this:

Description Specify the description for the lookup type .

System Defined | Select ‘Yes', if you wish to maintain the lookup type as system defined
Yes/No and ‘No’, if you wish to maintain lookup type as User defined.
Enabled Check this box to enable the lookup type.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Lookup Codes section, you can setup individual codes that a field or process using
the related lookup type can have. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Lookup Code Specify the lookup code. These are solely dependent on the
function of the Lookup Type.

Description Specify the lookup code description. This may be changed as per
your business requirement.

Sort Specify the sort order for the lookup code. This determines the
order these lookup codes are displayed or processed.

Sub Code Specify the sub code for the lookup code.

System Defined | Select ‘Yes', if you wish to maintain the lookup code as system
Yes/No defined and ‘No’, if you do not want to maintain it as system
defined. System defined lookup codes cannot be modified,
except for changing the Description or Sorting fields. If the lookup
type is not system defined, then the code can be modified.

Enabled Check this box to enable the lookup code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

User Defined Tables

In User Defined Tables you can maintain user-defined tables, such as the data attributes the
system uses on its Search screens.

In the following example, the list of attributes in the Criteria column are computed from the
User Defined Tables screen.

To set up a user-defined table, you must:

1. Define the fields on the table.
2. Join the related tables.

3. Assign the table a lookup type.
You can create tables for different products, funding, and collateral types.

After creating the user-defined tables, the system sorts the attributes to make the system
usage more efficient. These details are used with different functions of the system, including:
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e Searching applications and accounts

e Tracking follow-up items

e Creating details in bankruptcy, foreclosure/repossession, and deficiency

Note

Many of these tables, (ASSET TRACKING ATTRIBUTES for example) may be configured
during the initial setup of the application to provide for your specific business needs. Oth-
ers, such as APPLICATION SEARCH, may be changed whenever your business needs
change. Still others should not be changed without consulting Oracle Financial Services
Software, as changing them would require changes to existing code for the expected re-
sults to be implemented. As a thumb rule, it is better to add or disable information on the

User Defined Tables screen than to edit existing entries.

To set up the User Defined Tables

1. Click Setup > Setup > Administration > System > User Defined Tables. The system
displays the User Defined Tables screen. The details are grouped into two:

e User Defined Tables
e User Defined Table Attributes

2. Inthe User Defined Tables section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing
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Setup
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Administration
System
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Data Files
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Check Details
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Zip Codes
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User Defined Tables

User Defined Tables

View v Formatw By

Table User table Type

SEARCH_WFP_PR
SEARCH_UPD_AC

DLR_TRACI_MAP.
SEARCH_UBT_AD.

SEARCH : WEP PR.
SEARCH : POST D.
MAPPING: INTERF
SEARCH : ACCOU
SEARCH_UBT_FEE... SEARCH : ACCOU
SEARCH_UTA_DXN
SEARCH_UBT_PM
CHGOFF_TYPE D.
CPY_APP_SETUP

SEARCH: TRANSA,
SEARCH : ACCOU.
TABLE ATTRIBUT.

SETUP: APPLICAT,

User Defined Tables

*Table
* User table Type

* Description

* System Defined Yes/No

User Defined Table Attributes

Freeze i Detach

Description

WFP PRODUCER S
POST DATED CHE
DLR_TRACK MAPP.
BATCH ENTRY AC.

BATCH ENTRY AC.

BATCH ENTRY AC.
DEFICIENCY DETA.
APPLICATION CO.

Oves@®@no

View v Formatw (5 22 g Detach
Attribute Description Data Type

No data to display.

@
System Defined
Yes/No

Yes ® Mo

Length

Enabled

N
5
e
-
=
¥
==
¥
i
e

Product Type

Al
Al
AL
AL
AL
AL
AL
AL

AL

= Collatersl Type ALL

Sort Operator

I add | 7 Edi

Funding Type Collateral Type View Name
UNDEFINED
Al AL UNDEFINED
ALL AL UNDEFINED
Al AL UNDEFINED
ALL AL UNDEFINED
AL AL UNDEFINED
ALL ALL UNDEFINED
AL AL UNDEFINED
AL AL UNDEFINED
ALL ALL UNDEFINED

Save and Add

= View Name  UNDEFINED

[v] * 50 Statement
~
2]
Sort O
Faid | 2
System Defined

Enabled Sub Attribute

‘Yes/No

[ saveand stay | [ save and Retun | @ Retum

[ Close
7 Audit
SQL Statement

SELECT f*+ FIRS a
SELECT /*+ FIRS
SELECT 1 FROM [
SELECT /*+ FIRS
SELECT /*+ FIRS
SELECT f*+ FIRS
SELECT /*+ FIRS
SELECT 1 FROM [
SELECT 1 FROM [

v

LOV Type

A brief description of the fields is given below:

Field

Do this:

Table

Specify the user-defined table name.

User Table Type

Select the user-defined table type from the drop-down list. This
determines where and how the related data is being used.
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Field

Do this:

Description

Specify the description for user-defined table.

System Defined
Yes/NO

Select ‘Yes', if you wish to maintain the User table type as system
defined and ‘No’, if you do not want to maintain it as system
defined. System defined entries cannot be modified. If the entry is
not system defined, then it can be modified.

Enabled

Check this box to enable the user-defined table (optional).

Product Type

Select the product typefrom the drop-down list.

Funding Type

Select the funding type associated with the user-defined table from
the drop-down list.

Collateral Type

Select the collateral type associated with the user-defined table
from the drop-down list.

View Name

Specify the view name.

SQL Statement

Specify the SQL version of the statement.

For Example: For SEARCH_ACC_ACCOUNTS table, the SQL is as
follows:

SELECT /*+ FIRST_ROWS */ ACC_AAD_ID FROM ACCOUNTS
WHERE

Note: For the above SQL, the where criteria is part of the User
Defined Table Attributes

Sort

Specify the sort order for the user-defined table relative to other
tables of the same type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4. Inthe User Defined Table Attributes section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE
Financial Services Lending and Leasing
Close
T User Defined Tables 5, o
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T User Defined Tables Bl wew | o audit
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e View v Formatw B Freeze £ Detach ] Wrap o]
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Ser
;mehm" A SEARCH_UBT_AD.. SEARCH :ACCOU.. BATCHENTRY AC. Y AL AL ALL UNDEFINED SELECT /*+ FIR:
Sys;m SEARCH_UBT_FEE... SEARCH : ACCOU... BATCH ENTRY AC ¥ AL AL ALL UNDEFINED SELECT /*+ FIR
System Paramete SEARCH_UTA_TXN  SEARCH: TRANSA... TRANSACTION HI ¥ AL AL AL UNDEFINED SELECT /*+ FIR
Laokups SEARCH_UBT_PM... SEARCH : ACCOU... BATCH ENTRY AC. Y AL AL AL UNDEFINED SELECT /*+ FIR:
User Defined Tat PE_D.. TABLE ATTRIBUT.. DEFICIENCY DETA Y ALL AL ALL UNDEFINED SELECT 1 FROM
it Tabl
ek s UP  SETUP: APPLICAT... APPLICATION CO... ¥ AL AL AL UNDEFINED SELECT 1 FROM
User Defined Def v
Transaction Code SEARCH_ACC_AC.. SEARCH : ACCOUNT ACCOUNT SEARCH ¥ ALL AL ALL UNDEFINED SELECT /*+ FIR:
Data Files
Dedupe
Securitization
Events user Defined Table Attributes Hadd | FEde || Sl view | o audit
Batch Jobs “ = .
View v Format = Freeze ] Detach p
Producer Cycles & o @
Vendors Attribute Description Data Type Length Sort Operator Enabled Sub Attribute LOV Type
Collection Cyck
Collection Cydles w o
Reports
Error Messages PRO_NAME PRODUCER NAME CHARACTER 80 1 UKE Y NO LOV
Translations WPR_STATUS_CD PRODUCER STATUS  CHARACTER 30 2 LIKE ¥ O LOV
User WPR_TOT_CREDIT_L . TOTAL CREDIT LIMIT ~ NUMBER 30 3 EQUAL Y NO LOV
Organization >
Companies
Access -
i User Defined Table Attributes
Credit Bureau [ Save and Add saveand Stay | [ Ssve and Retun || {3 Retum
Correspondence
General Ledger * Attribute * Operator [~ = LOV Validation Ind []
Queues . " * €yctorn Defi INo = ookup Typ:
SR Description System Defined Yes/No () Yes®) No Lu:kuu vpe
Bank Details * Data Type [~] = Enabled (] Default Value
Check Details *Length 0 Sub Attribute
Standard Payees
ot 0 LOV Type v
Currencies (- & 22
Zip Codes -
Products
< mimiam >

A brief description of the fields is given below:

Field

Do this:

Attribute

Specify the user-defined table attribute.

Description

Specify the description for the user-defined table attribute.

Data Type

Select the data type for the attribute (CHARACTER, NUMBER, or
DATE) from drop-down list.

Length

Specify the maximum length of the user-defined table attribute.

Sort

Specify the sort order of the user-defined table attribute. If the sort
order is changed it will only affect new instances of the User Defined
Table, and will not affect existing data.

Operator

Select the operator for the user-defined table attribute from the drop-
down list.

System
Defined Yes/No

Select ‘Yes', if you wish to maintain the User table attribute as system
defined and ‘No’, if you do not want to maintain it as system defined.

System defined entries cannot be modified. If the entry is not system

defined, then it can be modified.

Enabled

Check this box to enable the user-defined table attribute so that the
attribute will be considered when creating new instances of the User
Defined Table.

Sub Attribute

Specify the sub-attribute for the attribute (sub attributes are used to
associate related attributes).
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2.4

Field Do this:

LOV Type Select the list of value (LOV) type for the user-defined table attribute
from the drop-down list.

LOV Validation Check this box to enable LOV validation of the user-defined table
Ind attribute. This indicates whether the data must come from the LOV.

Lookup Types Specify the lookup type of the LOV associated with the user-defined
table attribute.

Default Value Specify the default value for the user-defined table attribute.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Audit Tables

The system allows you to track changes in the database during origination. This includes the
tracking of:

e Application status history
e Account status history
e Audit history of specified fields

The Audit Tables Setup screen records the tables and columns requiring an audit. the system
stores the following details for the fields you want to audit for changes:

e Current value in field

e New value field

e User who changed the field’s content

e Date and time when the value was changed

IMPORTANT: The system recommends that only a database administrator perform the
following steps.

To set up the Audit Tables

1. Click Setup > Setup > Administration > System > Audit Tables. The system displays
the Audit Tables screen. The details are grouped into two:

e Audit Tables
e Audit Columns
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In the Audit Tables section, perform any of the Basic Operations mentioned in Navigation

DashBoard
 Origination
> Servicing
> Collections
 WEP
» Tools
Setup
Setup
Administration
System
System Paramet:
Lookups
User Defined Tat.
Audit Tables
User Definad Def
Transaction Code
Data Files
Dedupe
Securitization

A

Vendors
Collection Cycles
Reports
Error Messages
Translatians
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queuss
Printers
Bank Details
Check Details
Standard Payess
Currencies
Zip Codes
Products

< >

Audit Tables » [ Close.
Audit Tables [ et | Elview | o audi
View v Format~ [ Freeze g Detach I Wrap ) 45 cenerate
Table Description Display Dascription  Display Column Reset RowID Enabled Primary Key 1 Primary Key 2 Primary Key 3 Primary Key 4
INDEX_RATES INDEX RATE DETA... TYPE IRT_INDEX_TYPE.. N ¥ TRT_INDEX_TYPE.. TRT_START_DT
INSURANCES INSURANCES DET... INSURANCE TYPE  INS_INSURANCE_.. N ¥ INS_AAD_ID INS_ID ()
1085 OB DETAILS DESCRIFTION J0B_DESC N Y 1OB_JBS_CODE 1OB_CODE
108_BUCKETS 108 BUCKET DET... ID JBB_ID N ¥ JB8_ID
J0B_HOLIDAYS  JOB HOLIDAY DET... DESCRIPTION JBH_DESC N Y IBH_DT
JOB_SETS JOB SET DETAILS ~ DESCRIPTION JBS_DESC N Y JBS_CODE
JOB_THREADS 0B THREAD DET... CODE JBT_3JOB_CODE N ¥ JBT_IBS_CODE JBT_JOB_CODE JBT_THREAD
LOOKUPS LOOKUP DETAILS  DESCRIPTION LKC_DESC N i LKC_LKT_TYPE  LKC_CODE
LOOKUP_TYPES LOOKUP TYPE DE.  DESCRIPTION LKT_DESC N Y LKT_TYPE
MESSAGES MESSAGE DETAILS TEXT MSG_TEXT N Y MSG_CODE MSG_PTC_COMPA_ MSG_PCB_BRANCH MSG_SUPER_PR
< >
Audit Tables
{a Retum
Table INDEX_RATES Primary Key 2 IRT_START_DT Primary Key 9
Description  INDEX RATE DETAILS Primary Key 3 Key 10
Display Description TYPE Primary Key 4 1
Display Column IRT_INDEX_TYPE_CD Primary Key 5 12
Enabled ¥ Primary Key & 3
Resef RowID _ Primary Key 7 Primary Key 14
Primary Key 1 IRT_INDEX_TYPE_CD Primary Key 8 Primary Key 15
Audit Columns FPadd | Fede | [Evew | o audit
View v Format~ (5 Freeze Eff Detach o) Wrap o]
Column Description Data Type Enabled

No data to display

A brief description of the fields is given below:

Field

Do this:

Table

The table name on which audit trigger needs to be
created is displayed here (the system table being
audited).

Description

Specify the table description.

Display Description

Specify the column description to be displayed on audit
screen.

Display Column

Select the table column to be displayed on audit screen
from the drop-down list.

Enabled

Check this box to enable the audit table so that it will be
considered while generating the database triggers.

Reset Row ID

Check this box to allow resetting the row identifier.

Primary Key 1 (unlabeled)

The table primary key column 1 is displayed here.
(These columns define how to access the data in the
table.)

Primary Key 2 (unlabeled)

The table primary key column 2 is displayed here.

Primary Key 3 (unlabeled)

The table primary key column 3 is displayed here.

Primary Key 4 (unlabeled)

The table primary key column 4 is displayed here.

Primary Key 5 (unlabeled)

Table primary key column 5 is displayed here .
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2.5

Field

Do this:

Primary Key 6 (unlabeled) Table primary key column 6 is displayed here.

Primary Key 7 (unlabeled) The table primary key column 7 is displayed here.

Primary Key 8 (unlabeled) The table primary key column 8 is displayed here.

Primary Key 9 (unlabeled) The table primary key column 9 is displayed here.

Primary Key 10 (unlabeled) | The table primary key column 10 is displayed here.

Primary Key 11 (unlabeled) The table primary key column 11 is displayed here.

Primary Key 12 (unlabeled) | The table primary key column 12 is displayed here.

Primary Key 13 (unlabeled) | The table primary key column 13 is displayed here.

Primary Key 14 (unlabeled) | The table primary key column 14 is displayed here.

Primary Key 15 (unlabeled) | The table primary key column 15 is displayed here.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Audit Tables Columns section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Column Specify the column name on which the audit needs to be created from
drop-down list (column in the table that is being audited)

Description Specify the column description (description of the data contained in the
column).

Data Type The data type for the attribute is displayed here.

Enabled Check this box to enable the audit column.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

User Defined Defaults

The User Defined Defaults Setup screen allows you to set up default values to automatically
populate in frequently used fields on the Application Entry screen. This streamlines the data
entry process when entering an application.

To set up the User Defined Defaults

1. Click Setup > Setup > Administration > System > User Defined Defaults.The system
displays User Defined Defaults screen.
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2. In the Application Defaults section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

# Welcome, PRAKRRAO o

DashBoard
» Origination
> Servicing
> Collections
> WFP
> Tools
Setup
Setup
Administration
System
System Paramete
Lookups
User Defined Tak
Audit Tables
User Defined Def
Transaction Code
Data Flles
Dedupe
Securitization
Events
Batch Jobs
Producer Cycles
Vendors
Collection Cydles
Reports
Error Messages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Comrespondence
General Ledger
Queuss
Printers
Bank Detsils
(Chack Details
Standard Payess
Currencies
7ip Codes
Products
< s >

User Defined Defaults
Application Defaults
View ~ Format~  [Ep Fresze i Detach
Organization Division Company
DMC NLoZ NLO2
DMC sA03 usot
DMC usoL us01
DMC P04 P04
L4

Application Defaults

* Organization DMC
= Division |US01
Application Defaults
Company
Branch
Priority
Channel
Producer Type
Class
Purpose
Product
Override 0k []
Warning OK []

Applicant Defaults

Relation Type
Gender
Marital Status
Language
ECOA

Class Type NORMAL

wer | @

Branch

NLR1
USHQ
UsHQ
JPRL

&

&l

I <] (¢ [ [« T e ]

] [« <] <] [ [¢]

Priority Channel
NORMAL
HIGH

NORMAL

FAX IN
WEB ENTRY
WEB ENTRY

Postal Type NORMAL ADDRESS

Country UNITED STATES
Rent Amount | 0.00

Stated Frequency MONTHLY

Actual Fi MONTHLY

Ounership
Employment Defaults
Type FULLTIME
COccupation
Country UNITED STATES
Stated Frequency MONTHLY

Actual Frequency MONTHLY

Telecom Defaults

Income Defaults

Income Type

Freauency

Producer Type
DEALER

DEALER
DEALER.

I save and Add

[ [¢ [ [<] &)

Kl & &

FEEEER

vl

4k add | 7 Edit

Class Purpose
SMALL BUSINESS
SMALL BUSINESS
INDIVIDUAL

VEHICLE LOAN O.
HOME EQUITY LO.
VEHICLE LOAN O.

I save and sty

Status NOT DEFINED
Condition
Country UNITED STATES

Vehicle Defaults

Asset Type
Sub Type
Class

Valuation Source

Home Defaults

Asset Type
Sub Type
Class
Occupancy

Waluation Source

Other Defaults

Asset Type
Sub Type

Class

(B

[ save and Retum

30 Close:

7 Audit

Product

LOAN VEHICLE (
TIARA HOME LO\
LOAN VEHICLE (

>

<A Retum

[<] [<] [e]

[ [« [« [<]

KEEEE

EEE

~

<

A brief description of the fields is given below:

Field

Do this:

Org

Select the organization for which these defaults are applicable from
drop-down list.

Division

down list.

Select the division for which these defaults are applicable from drop-

Application Defaults

Company

Select the company from the drop-down list.

Branch

Select the branch from the drop-down list.

Priority

Select the priority from the drop-down list.

Channel

Select the channel from the drop-down list.

Producer Type

Select the producer type from the drop-down list.

Purpose

Select the purpose from the drop-down list.

Product

Select the product from the drop-down list.

Applicant Defaults

Relation Type

Select the applicant relation type from the drop-down list.

Gender

Select the applicant gender from the drop-down list.
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Field

Do this:

Marital Status

Select the applicant marital status from the drop-down list.

Language Select the applicant language from the drop-down list.
ECOA Select the applicant ecoa from the drop-down list.
Class Type Select the applicant class type from the drop-down list.

Race National
Origin

Select the applicant race or national origin from the drop-down list.

Privacy Opt-Out

Check this box to indicate that the applicant has elected to refrain
from the non-public sharing of information.

Address Defaults

Address Type Select the address type from the drop-down list.
Postal Type Select the postal address type from the drop-down list
Street Pre Select the street pre type from the drop-down list.
Street Type Select the street type from the drop-down list.

Street Post

Select the street post type from the drop-down list.

Country

Select the country from the drop-down list.

Rent Amount

Specify the rent amount. The system defaults this rent amount if the
rent amount received from the interface is zero.

This rent amount will be defaulted for a new application also.

State Frequency

Select the stated frequency from the drop-down list.

Actual Select the actual frequency from the drop-down list.
Frequency
Ownership Select the ownership type from the drop-down list.

Employment Defaults

Type Select the employment type from the drop-down list.
Occupation Select the occupation from the drop-down list.
Country Select the country from the drop-down list.

Stated Select the stated frequency from the drop-down list.
Frequency

Actual Select the actual frequency from the drop-down list.
Frequency

Income Defaults

Income Type

Select the income type from the drop-down list.

Frequency

Select the frequency from the drop-down list.
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Field

Do this:

Liability Defaults

Liability Type

Select the liability type from the drop-down list.

Frequency

Select the frequency from the drop-down list.

Asset Defaults

Status Select the asset status from the drop-down list.
Condition Select the asset condition from the drop-down list.
Country Select the country from the drop-down list.

Vehicle Defaults

Asset Type Select asset type from the drop-down list.
Sub Type Select asset sub type from the drop-down list.
Class Select the asset class from the drop-down list.

Valuation Source

Select the asset valuation source from the drop-down list.

Home Defaults

Asset Type Select asset type from the drop-down list.

Sub Type Select asset sub type from the drop-down list.
Class Select the asset class from the drop-down list.
Occupancy Select the occupancy type from the drop-down list.

Valuation Source

Select the asset valuation source from the drop-down list.

Other Defaults

Asset Type Select asset type from the drop-down list
Sub Type Select asset sub type from the drop-down list.
Class Select the asset class from the drop-down list.

Valuation Source

Select the asset valuation source from the drop-down list

Comment Defaults

Comment Type

Select the comment type from the drop-down list.

Comment Sub
Type

Select the comment sub type from the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.6

Transaction Codes

The system uses transaction codes to define the actions and tasks it can perform; for
example, activating an account, changing a due date, applying a late fee, and charging off an
account.

The system uses transaction codes to define the actions and tasks it can perform; for
example, defining itemization, menu items, setting up lock and unlock, and generating
reports.

The Transaction Codes Setup screen catalogs and defines these core system actions.
Three sub screens, Parameters, Access Grid, and Products, record any additional information

required to perform a transaction, the user types that can perform the transaction, and the
product type to which the transaction codes apply.

Note

The Software recommends that you restrict the access to the seed data once you are in
production.

To set up the Transaction Codes

1. Click Setup > Setup > Administration > System > Transaction Codes. The system
displays the Transaction Codes screen.

2. In Transaction Super Group section, you can view the following information

ORACLE
Financial Services Lending and Leasing
Close
S Transaction Codes Eife
'+ Origination ;
_ Transaction Super Group
1 Servicing -
View v Formatw | [ fresze gfiDetach | lwep | @
> Collections
Super Group.
WP ACCOUNT MONETARY TXN fal
* Tools ACCOUNT NOMN MONETARY TXN v
AMORTIZATION TXN
Setup
Setup
Administration ' Transaction Codes o | Aedit | [Fview || o audit
SpiEn View w Format = Freeze fiDetsch ol wirsp
System Parameter & oeze g Detac @
System Defined
Lookups Tan Code Description Group Adtion vonetary (YIS Enabled Tan/Bal Type Statement Txn Type Batch
User Defined Tables
e EADV ESCROW ADVANCE  ESCROW pOST 7 ¥ ESCROW ADVANCE ESCROW ADVANCE Bl
User Defined Defaults EADV_AD]_MINUS ADJUSTMENT TO_.  ESCROW ADIUST MINUS L Y ESCROW ADVANCE ADIUSTMENT TO ESCROW.. N
Trensaction Codes EADV_ADJ_MINUS_REV ~ REVERSE ADJUST.. ESCROW REVERSE ¥ ¥ ESCROW ADVANCE REVERSE ADIUSTMENT TO.. N
Data Files: EADV_AD]_PLUS ADJUSTMENT TO... ESCROW ADIUST PLUS Y Y ESCROW ADVANCE ADJUSTMENT TO ESCROW... N
EADV_AD]_ PLUS REV  REVERSE ADJUST.. ESCROW REVERSE Y ¥ ESCROW ADVANCE REVERSE ADJUSTMENT TO... N
EADV_BILL ESCROW ADVANC... ESCROW BILL Y Y ESCROW ADVANCE ESCROW ADVANCE BILLED N
§  EADV_BIL REV REVERSE ESCRO...  ESCROW REVERSE Y ¥ ESCROW ADVANCE REVERSE ESCROW ADVANC.. N,
EADV_CHGOFF CHGOFF ESCROW... ESCROW CHARGE OFF/WRITE... Y ¥ ESCROW ADVANCE CHGOFF ESCROW ADVANCE N
Vendors >
Collection Cydles
Reports = 5
Parameters | AccessGid | Products
Error Messages
Translations
Aeee Transaction Parameters Aeadd | Ledt | Fview | of audit
i View~ Fomat~ [ Fresze §4 Detach I wrap 7))
Companies
e Parameter code Defaut Sort Displayed? Yes/No Required? Yes/No
5 No data to display.
Users
Credit Bureau
Comespondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Fzyess
Currencies
Zip Codes
Products )
Asset Types
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A brief description of the fields is given below:

Field Do this:

Super Group | Select the Super Group you want to work with in the Transaction

Codes screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Transaction Codes section, perform any of the Basic Operations mentioned in

Navigation chapter

ORACLE" . . PRAKRRAO v o
Financial Services Lending and Leasing
i Close:
DashBoard Transaction Codes x [Hd
» Origination )
~ Transaction Super Group (o}
»» Servicing 7
View v Fomat- [} Fresze §Z) Detach I wrap ®
» Collections
Super Group
> WFP ACCOUNT MONETARY TXN ~
> Tools ACCOUNT NON MONETARY TXN v
AMORTIZATION TXN
Setup
Setup
Administration ~ | Transaction Codes +ud | SE ] View | hud
SyEm View~ Format= | Freeze ) Detach Wray
System Paramets & we B Dei | @
Lookups [v] z
Lieer Defist il Txn Code Description Group Action Monetary 3"“;”" Desmieh | o T Bl Tjpe Statement Tn Type Batch M
Audit Tables esfNo
User Defined Def N Yes® No N N N
i ~
Transaction Code EADV ESCROW ADVANCE ESCROW POST i ¥ ESCROW ADVANCE ESCROW ADVANCE NN
Dat; Files ADIUSTMENT TO.. ESCROW ADIUST MINUS Y ¥ ESCROW ADVANCE ADIUSTMENT TOESCROW.. N ¥
D
r:::f: 40 REVERSE ADJUST... ESCROW REVERSE ¥ Y ESCROW ADVANCE REVERSE ADIUSTMENTTO.. N ¥
- ADIUSTMENT TO... ESCROW ADIUST PLUS Y Y ESCROW ADVANCE JENTTOESCROW.. N Y
Ba obs ‘< EADV_ADJ_PLUS_REV REVERSE ADJUST... ESCROW REVERSE L Y ESCROW ADWANCE ADJUSTMENT TO. N il
Producer Cycles EADV_BILL ESCROW ADVANC... ESCROW BILL ¥ i ESCROW ADVANCE ESCROW ADVANCEBILLED N N,
Needore EADV_BILL_REV REVERSE ESCRO... ESCROW REVERSE ¥ Y o Y ESCROW ADVANCE REVERSE ESCROW ADVANC.. N N
Collection Cycles < >
Reports
Error Messages
Translations Transaction Codes
deer System [ save and add || [ save and Stay || [ Save and Retum || Ga Retum
Organization Indicator
Companies =T Code OY=® o =Manual []
Access 5
i * Description Statement Print g
:}edlt Bureau * Group 2] = /Bl Type = -
Correspondence Wi =
Genersl Ledaer Diiny ¥+ statement T Type -
Queuss *monetary [] P—
Printers
Bank Details Parameters | Access Grd | Products
Cherk Details
fi’;::::ayees Transaction Parameters Fadd | A Ed w 37 Aud
Zin Codes Vieww Fomatv b Freeze i Detach lwep | @
Products I Parameter code Default Sort Displayed? Yes/No Required? Yes/No
< mmimmiis - No data to display.

A brief description of the fields is given below:

Field Do this:

Txn Code Specify the transaction code (required).

Description Specify the description for the transaction.

Group

Select the transaction group (the group within the Transaction Super
Group that the transaction code belongs to) from the drop-down list.

Action Select the action type code for the transaction (what action will take
place when the transaction occurs) from the drop-down list.
Monetary Check this box to maintain the transaction as a monetary transaction. If

unchecked, then the transaction is nonmonetary.

System
Defined Yes/
No

Select ‘Yes', if you wish to maintain the transaction code as system
defined and ‘No’, if you do not want to maintain it as system defined.
System defined entries cannot be modified. If entry is not system
defined, then it can be modified.
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Field Do this:

Enabled Check this box to enable the transaction.

Txn/Bal Type | Select the transaction / balance type affected by the Transaction from
the drop-down list.

Statement Select the statement transaction type (how the transaction should

Txn Type appear on the customer statement) from the drop-down list.

Batch Check this box to perform the transaction in a batch process.

Manual Check this box, if the transaction is a manual transaction. If you define a

transaction as manual, the system recommends that the transaction
that reverses it also be defined as manual.

Stmt Print Check this box to print the transaction on customer statements.

GL Check this box, if the transaction is a general ledger transaction.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6.1 Transaction Codes sub screens

The Transaction Codes screen contains three sub screens:
e Parameters
e Access Grid
e Products

Note

Please contact your System Administrator / Implementation Manager before making any
changes in these sub screens.

2.6.1.1 Parameters

Here, you can define the parameter information for the associated transaction. The
Parameters apply exclusively to these super groups:

e ITEMIZATION TXN

e AMORTIZATION TXN

e PRODUCER MONETARY TXN
e FUNDING TXN

e ACCOUNT CONDITION TXN

e CORRESPONDENCES

e FEE ASSESSMENTS

(For manual transactions, these are the parameters that appear when you click Load
Parameters on the Customer Service screen’s Maintenance screen.)
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2.6.1.2

Note

Treat the Transaction Parameters sub screen as containing view-only information. This is
very sensitive data and you should not change it without consulting Oracle Financial Ser-
vices Lending and Leasing.

To set up the Parameters

1. Click Setup > Setup > Administration > System > Transaction Codes > Parameters.

2. Inthe Transaction Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Parameter Select the parameter code associated with the transaction code, from
Code the drop-down list.

Default Specify the default value for the transaction parameter (value to initially

populate, or used if no value is supplied).

Sort Specify the sort order for the transaction parameter.

Displayed? Select ‘Yes’ to display the parameter and ‘No’ if you do not want to
Yes/No display in current use.

Required? Select ‘Yes’ if the parameter is required and ‘No’ if you do not require the
Yes/No parameter. (You must select Required as empty values are not allowed.)

3. Perform any of the Basic Actions mentioned in Navigation chapter.
Access Grid

The Access Grid sub screen allows you to control access to each transaction according to
user responsibility, account status, and account condition. It allows the administrator to
control when these transactions may be conducted. Normally, you would create or modify the
access based on either the user responsibility or account condition. Account status access is
left unchanged.

To set up the Access Grid sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Access Grid.

2. Inthe Transaction User Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Access Type | Select the access grid function type (ACCOUNT CONDITION AND
ACCOUNT STATUS) that is being used to control the creation of the
associated transaction, from the drop-down list.

Access Select the access function grid value from the drop-down list (based on a
Value lookup associated with the Access Type. Multiple entries for each access
type may be created as long as each has a different access value).
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Field Do this:

Allowed? Select ‘Yes’ if the access is allowed and ‘No’ if the access is not allowed
Yes/No (indicates whether the current Access Type / Access Value may create
the associated transaction).

System Select ‘Yes’, if you wish to maintain access type as system defined and

Defined Yes/ | ‘No’, if you do not want to maintain it as system defined. System defined

No entries cannot be modified. If entry is not system defined, then it can be
modified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6.1.3 Products

2.7

The Products sub screen allows you to define the products to which the transaction codes
apply. It allows the administrator to control if the associated transaction code will be available
for use for specific product types and or funding types.

Normally, an Access Value of ALL is defined for one or more Access Types with a given
Allowed value. Additional Access Values are then defined for the same Access Types with the
opposite Allowed value. This controls access to the associated transaction.

To set up the Products sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Products.

2. Inthe Transaction Product Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Product Type Select the product type associated with the transaction code from
the drop-down list.

Funding Type Select the funding type associated with the transaction code from
the drop-down list.

Allowed? Yes/No | Select ‘Yes’ if the transaction is allowed and ‘No’ if the transaction is
not allowed (indicates whether the current Access Type / Access
Value may create the associated transaction).

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Data Files

The Data Files Setup screen organizes information pertaining to the various input/output data
files that the system can generate. The system uses the Data Files Setup screen to outline
the file layouts of each data file produced/received within the system, including the length and
data type of each column name.

These files are typically produced during the nightly process.
One major advantage for the system-defined data files is the format mask of each column

name within each data file. A format mask is like a stencil that forces data input to be of the
same format before accepting the data.
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2.71

2711

You can change the order in which the fields are displayed in the file.

Note

Any addition or removal of a field or change in the data type length requires the Software
involvement.

Data Files screen consists of the following two tabs:

e Output
e Input

Output tab

The Output tab in the Data Files screen allows you to define the structure of output data file
through the following sections:

e Data File Definitions

e Record Definitions

e Column Definitions

Data File Definitions

The Data File Definitions section defines specific data files. Each is associated with a specific
Output Data Definition (ODD) batch job that gathers the data that the file will contain. While
new data file definitions may be created they will have no use unless a batch job is also
created to populate the data.

To set up Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Outpout tab.

2. Inthe Data Files Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE'
Financial Services Lending and Leasing

ABSHEKAR + 1@ Sgnout

@ Barkiuptcy x| Data Files x (%] Close
Output | Input 2
»> DashBoard
b Onokmatior Data File Definitions o acd || it || [Evew |7 nue
i Vens romet~ [ [IFrecze EfiDetmch wen @Y
> Collections ¢ et =
- Neme Description File Name: Directory Path System Defined Yes/No
s UNDEFINED Ves(Gito
Gtk BANKO_INTERFACE LIX BANKO INTERFACE Lx_banko_output_S(COMPANY_CODE... UNDEFINED Yes@Mo
Setup “ i "
Setup
Adrministration Data File Definitions
System L Save and Add Seve and stay || [ Seve andRetum || GaRetum
System Parameter 8 =
Lookups *Name * Directory Path UNDEFINED
User Defined Tables
=t *Descripton *System Defined Yes Mo @ Yes@ No
User Defined Defauits *Fie Name et A
Transaction Codes
DstaFies Record Definitions ot | Zese | Eyew || o mit
Dedupe View v Format~ | B Freeze jfi Detach
Ssasilzata Record Type Description Delimiter Terminator
Else No data to display.
Batch Jobs
Producer Cydes
;E";dués o Column Definitions Hadd | S i o At
Rz;tr;" T Vien v Format~ B Freeze i Detach
o e Seq Column Name Length Data Column  Output Cokumn
e < Nodatatodsplay. 4

A brief description of the fields is given below:

Field

Do this:

Name

Specify data file type (name of data file definition).
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Field Do this:

Description Specify data file description.

File Name Specify data file name. Prefix used for files generated for this Data
File. This is the only field on the Data File Definitions screen that can
or should be modified by your Administrator. The generated file name
will be in the form of <FILE NAME> <COMPANY ID> <BRANCH
ID> <MMDDYYYY> <PROCESS ID>.DAT. The inclusion of
_<COMPANY ID>and <BRANCH ID> depends entirely on the
associated batch process.

Directory Path Specify the directory path.

System Defined | Select ‘Yes', if you wish to maintain the data file definition as system
Yes/No defined and ‘No’, if you do not want to maintain it as system defined.
System defined entries cannot be modified. If the entry is not system
defined, then it can be modified.

Enabled Check this box to enable the data file definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Record Definitions

Each data file definition is made up of one or more record definitions. These define
organization of the data. The associated batch file determines how these records are used.
The order in which the data is populated determines the order in which those records will
appear in the output file. This is generally related to the order the records appear in the Data
File Definition section.

1. In the Record Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:
Record Type Specify the type of record being defined.
Description Specify record description.

Record Format Select the format of output data (FIXED, VARIABLE) from the drop-

down list.

Delimiter Specify the delimiter (column separator used with VARIABLE
format).

Terminator Select the record terminator code (how the end of each record is

indicated within the file -- CARRIAGE RETURN, LINE FEED, or
CARRIAGE RETURN AND LINE FEED) from the drop-down list.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Column Definitions

Each record definition is made up of one or more column definitions. These define the output
of the data. Much of this data is informational; it indicates what data is being provided by the
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associated batch job. Unless otherwise noted, the data should not be changed without
changing the associated batch job.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field

Do this:

Seq

Specify the order in which the output data dump will process the
column information.

Column Name

Specify name/description of the column (informational only).

Data Type

Specify the data type. This describes the type of data the column is
expected to contain (CHARACTER, DATE, or NUMBER). This effects
how the ODD process handles the data, and should not be changed

Format Mask

Select the format mask for the column from the drop-down list. For
DATE or NUMBER columns, this field defines the output format of
the data. For example; Date fields may be entered using the MM/DD/
YYYY format, Number fields may be entered as decimal numbers
with varying degrees of precision. Other formats for each data type
are available.

Length

Specify the column length (the maximum number of characters of the
output data to be included in the output file). Each output data details
column may contain up to 240 characters of data. If the output data
details column contains more data than the length value the data will
be truncated. For VARIABLE records the length should be set to “-1”
or a Delimited file will be created with FIXED LENGTH columns.

Data Column

Specify the data column sequence. This is the column that will be
used to select the data that is being output. This should not be
changed.

Output Column

Specify the output column sequence. This is the column that will
appear in Output File. The Output Data Dump process allows for the
output of 250 columns of data per record. No output column should
be repeated in the setup for a record.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Input tab

Oracle Financial Services Lending and Leasing facilitates processing of a input data file
received from external interface into the system through an automated batch job
(IDDPRC_BJ_000_01) triggered on regular intervals.

The Input tab in the Data Files screen allows you to define the input data file through the

following sections:

e Input Data File Definitions

e Column Definitions

2-26 ORACLE



2.7.2.1 Input Data File Definitions

In the Input Data File Definitions section, you can define and maintain the structure of input
data file to populate data from external system.

To set up Input Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Input tab.

2. In the Input Data Files Definitions section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE’ HEKAR = 1g sgnout
Financial Services Lending and Leasing
@8 Bankipicy x  Data Files x. [®Close
Cutput | Input =
> DashBoard
b Onraibac Input Data File Definitions dhadd | FEit | Even | o Audt
View = Format + Freeze il Detach Nrap
> Servicing =4 o 50}
Name Description Directory Path Delimiter Record Format. Enabled
> Collections P
o WFP BANKO_NEW NEW BANKO FILE BN ' VARIABLE Y
> Tools BANKO_UPDATE UPDATE BANKO FILE BU ' VARIABLE Y
CURE_LTR CURE LETTER UPLOAD L . VARIABLE Y
Setup
Setup - 2
4« Input Data File Definitions =
Administration 4 5
E- Saveand Add | [ SaveandStay | [ SaveandRetun | CaRetun
System
System Parameter "
. -
Lodkips Name Delimiter
User Defined Tables * Description Record Format VARIABLE
Audt Tables * Directory Path Enabled [¥]
User Defined Defaults
Transaction Codes o 4 o z T
Column Definitions 4 add | Edit S| view | & Audit
Data Files B _ B Detach . ®
wr - B Freeze e virap
A View v Format of &
Securitization Seq Column Name Column Description DataType  FormatMask Length Sort Enabled
S No data to display.
Batch Jobs i -

A brief description of the fields is given below:

Field Do this:
Name Specify a unique name for the input data file.
Description Specify data file description.

Directory Path Specify the directory path configured within OFSLL Database server
to process the input data file.

Delimiter Specify the delimiter used to separate column data. (Ex: Comma).

Record Format | System defaults the record format as ‘VARIABLE'.

Enabled Check this box to enable the input data file definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.2.2 Column Definitions

Each input data file definition is made up of one or more column definitions. These define the
structure of data to be loaded from external system.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field Do this:

Seq Specify the order in which the input data dump will process the
column information.

Column Name Specify name of the column.

Column Specify description of the column.
Description
Data Type Select the data type from the drop-down list. The selected data type

describes the type of data the column is expected to contain such as
INTEGER/DATE/NUMBER/CHARACTER. This effects how the input
data file processing handles the data, and should not be changed.

Format Mask Select the format mask for the column from the drop-down list. The
list displays the format depending on the Data Type selected.

For example; Date fields may be entered using the MM/DD/YYYY
format, Number fields may be entered as decimal numbers with
varying degrees of precision. Other formats for each data type are
available.

Length Specify the column length (the maximum number of characters of the
data to be included in the input file).

Each input data details column may contain up to 240 characters of
data. If the output data details column contains more data than the
length value the data will be truncated. For VARIABLE records the
length should be set to “-1” or a Delimited file will be created with
FIXED LENGTH columns.

Sort Specify the order in which the column definitions are to be sorted for
display in the external interface screen (Customer Service > External
Interfaces). There can be a maximum of 61 column definitions.

Enabled Default selected. If not, you can check this box to enable the column
definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.
Events

During Origination, when an application moves from one status/sub status to another, or
changes condition, the system can trigger an event and perform the associated event actions.
This can occur either online or in batch mode.

Note

Only predefined events and actions can be set up on the Events Setup screen. You cannot
create new event types or action types.

As processing events and associated actions require additional processing at the server level,
the performance of the transactions, for which the events are setup, may be adversely
affected dependent upon your specific configuration.

2-28 ORACLE



2.8.1

2.8.11

Events

In the Events screen you can setup “trigger events” with associated actions which the system
performs during application entry. The fields on this form are both system and user defined.
There are four sub screens on the Events screen to set up and maintain these events:

e Events Types

e Event Action Types
e Online

e Batch

Event Types and Action Types sections of this screen provide a master table for setting up
the online and batch events. This setup triggers the event, which in turn triggers the actions
associated with the events, during application entry.

Navigating to Events

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Events.

Event Types

1. Click Setup > Setup > Administration > System > Events > Lease > Events Types.

2. Inthe Events Type section, perform any of the Basic Operations mentioned in Navigation

chapter.
ORACLE'
Financial Services Lending and Leasing
»» DashBoard Brents x [ e
> Origination Loan | line | Lease
 Servicing Event Types | EventActonTypes  Orline | Batch
> Collections
> WEP Event Types o Add ] View | < Au
> Tools View = Formatv [ Freeze fi Detach Wrap 5]
Setup EventType Code  Desciption Process Type Entity Type Engine Type Enabled Sys
EVEO1 ACCOUNT LEVEL BATCH EVENT #01 BATCH ACCOUNTS MONETRARY TRANSACTIONS PROCESSING Y -
Sen;;mmsh - 2 EVEO1 APPLICATION LEVEL BATCH EVENT #01 BATCH APPLICATIONS CREDIT BUREAU PROCESSING Y =
System EVEO2 ACCOUNT LEVEL BATCH EVENT #02 BATCH ACCOUNTS MONETRARY TRANSACTIONS PROCESSING Y
System Parameter £vE02 APPLICATION LEVEL BATCH EVENT 202 BATCH APPLICATIONS ~ CORRESPONDENCE v
Lookups EVEO3 ACCOUNT LEVEL BATCH EVENT #03 BATCH ACCOUNTS CCONDITION/ASSIGNMENT PROCESSING Y
User Defined Tables EVEO3 APPLICATION LEVEL BATCH EVENT #03 BATCH APPLICATIONS APPLICATION STATUS CHANGE Y
Audit Tables EVE04 ACCOUNT LEVEL BATCH EVENT #04 BATCH ACCOUNTS CONDITION/ASSIGNMENT PROCESSING Y
User Defined Defaults
et s EvEDs APPLICATION LEVEL BATCH EVENT 504 BATCH APPLICATIONS Y
Data Files EVEDS ACCOUNT LEVEL BATCH EVENT #05 BATCH ACCOUNTS CONDITION/ASSIGNMENT PROCESSING Y L)
Dedupe EVEOS APPLICATION LEVEL BATCH EVENT #05 BATCH APPLICATIONS Y @~
Securitization i i I 4
Events
Batch Jobs Event Types
Producer Cydes
Vendiest [ save andstay || [ SaveendRetum || GaRetwm

Collecton Cydes i
Reports Event Type Code EVED1 Entity Type ACCOUNTS System Defined @) Yes ) No

Error Messages * Desaription ACCOUNT LEVEL BATCH EVENT #01 Engine Type  MOMETRARY TRANSACTIONS PROCESSING
Translations Process Type BATCH % Enabled ¥

User
Organizaton
Comparies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bark Detals
Check Details
Standard Payess
Currendes

A brief description of the fields is given below:

Field: Do this:

Event Type Code Specify the event type code.

Description Specify the event description.
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Field:

Do this:

Process Type

down list.

Specify the process type (BATCH or ONLINE) from the drop-

Entity Type

the drop-down list.

Specify the entity type (ACCOUNTS or APPLICATIONS) from

Engine Type

Specify the engine type (MONETARY TRANSACTIONS PRO-
CESSING, NON-MONETARY TRANSACTION PROCESSING,
CONDITION/ASSIGNMENT PROCESSING, APPLICATION STA-
TUS CHANGE, CREDIT BUREAU PROCESSING, LETTERS
PROCESSING or CORRESPONDENCE) from the drop-down list.

Enabled

Check this box to activate the event type.

System Defined

Select ‘No’ to indicate that the event type is user defined.

Select ‘Yes’ to indicate that the event type is system defined.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Event Action Type

The Event Action Types section is system defined and lists the action codes supported in

the system.

1. Click Setup > Setup > Administration > System > Events > Lease > Event Action

Types.

2. Inthe Events Action Types section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

APKELKAR » (]

~ DashBoard

> Origination

> Servicing

> Collections

> WFP

> Tools

Setup

Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transacton Codes
Data Files
Dedupe
Seauitization
Events
Batch lobs
Producer Cyces
Vendors
Collection Cycles
Reports
Error Messages
Transiations
User

Organization
Comparies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Detais
Standard Payees
Currencies

Events x

Loan  Lne  Lease

EventTypes  Event Action Types | Onine | Batch

Event Action Types o add | S Edt || [E] View
View v Formatw Fresze EfiDetach ol wirsp b}

Action Code Description Process Type Entity Type Engine Type
POST_CONDITION_TRANSACTION_ACC_ONLINE  POST CONDITION TRANSACTION ONLINE ACCOUNTS CONDITION/ASSIGNVENT PROCESSING
POST_MONETARY_TRANSACTION_ACC_ONLINE  POST MONETARY TRANSACTION ONLINE ACCOUNTS MONETRARY TRANSACTIONS PROCESSING
POST_NON_MONETARA TRANSACTION_ACC_ON... POST NON MONETARY TRANSACTION  ONLINE ACCOUNTS NON-MONETRAY TRANSACTION PROCESSING
SEND_CRB_REQ_ACC_ONLINE SEND CREDIT BUREAU REQUEST ONLINE ACCOUNTS CREDIT BLREAU PROCESSING
SEND_CRB_REQ_APP_ONLINE SEND CREDIT BLREAU REQUEST ONLINE APPLICATIONS  CREDIT BLREAU PROCESSING
SEND_LETTER_ACC_BATCH SEND LETTER BATCH ACCOUNTS LETTERS PROCESSING
SEND_LETTER_ACC_ONLINE SEND LETTER ONLINE ACCOUNTS LETTERS PROCESSING
SEND_LETTER_APP_BATCH SEND LETTER BATCH APPLICATIONS ~ LETTERS PROCESSING
SEND_LETTER_APP_ONLINE SEND LETTER ONLINE APPLICATIONS ~ LETTERS PROCESSING
« i

Columns Hidden 1

Event Action Types

[ save and stay. Save and Returm

Action Code  POST_CONDITION_TRANSACTION_ACC_ONLINE System Defined @ ves ) No
* Description POST CONDITION TRANSACTION

Process OMLINE
Type

Entity Type ACCOUNTS
Engine Type  CONDITION/ASSIGNVENT PROCESSING
Enabled ¥

[ Gose

o hudit

Enabled

W= =<

{aRetum
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A brief description of the fields is given below:

Field: Do this:

Action Code Specify the action code.

Description Specify the action description.

Process Type Select the process type (BATCH or ONLINE) from the drop-
down list.

Entity Type Select the entity type from the drop-down list.

Engine Type Select the engine type from the drop-down list.

Enabled Check this box to activate the action.

System Defined | Select ‘Yes’ to indicate that the event type is system defined.
Select ‘No’ to indicate that the event type is user defined.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
2.8.1.3 Online

The Online screen allows you to set up the online events by defining all online events and the
event criteria actions. The system supports the following online events:

e CHG OFF Reversal

e Paid Off Reversal

e BKRP is closed

e BKRP Is Opened

e When Queue is Closed

e When status/ Sub status changed to 'Approved- Rehashed'

e Account condition SCHG is closed

e Account condition SCHG is Opened

e Change in application status / sub status to APPROVED — REHASHING

The events that can be performed online after each of the events listed above are as follows:

e Generate correspondence for an application
e Send a credit bureau request for an application.

To setup Online Event
1. Click Setup > Setup > Administration > System > Events > Lease > Online.
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2. In the Events section, perform any of the Basic Operations mentioned in Navigation

chapter.

ORACLE’

Financial Services Lending and Leasing

PrEkR - T ©

©* DashBoard
» Origination
> Servicing
» Collections
> WP
» Tools
Setup
setup -
Administration I
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transaction Codes  |=
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cydes
Vendars
Collection Cycles
Reports
Error Messages
Translations
User
Organization
Companies
Access
Users
CreditBureau
Correspondence
General Ledger
Queues
Frinters
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Standard Payees
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Fvents [36) Close
Lloan Lne Lease
Event Types || Event Acton Types | Onfine | Batch
Events ] vie P Ay
Vew Fomat~ [ ||Fres= idivewmch e | @
Event Code Event Type Frequency Synchronous Enabled
EVE_TCN_ONLINE_OPEN_SCHGOFF ALWAYS 8 ¥
TEST DALY N N
e I | b
Events
[ saveandstay | [ saveandRetum | (aRetun
Event Code EVE_TCN_ONLINE_OPEN_SCHGOFF * Synchronous [
*Event Type EVENT TO PROCESS ACTIONS WHEN =] *Enabled [9]
*Frequency ALWAYS [+
Event Criteria qradd | FEdt | [Few | of audt
vew Fomat~ [ [|Frees divewmch wep | @ o Cheskcrmena
Query Name Description Enabled
EVE_TCN_ONLINE_CO1 EVE_TCN_ONLINE_CD1 ¥
Criteria Details | Action
Criteria dpadd | FEdt | [Fuew | of Audit
View~ Formatv [ Freeze G Detach Wirap 5]
Seq ( Parameter Comparison Operator Criteria Value ) Logical Expression  Enabled
1 PRODUCT CODE EQUAL LOAN-VE Y
2 ACCOUNT STATUS EQUAL OPEN v

A brief description of the fields is given below:

Field:

Do this:

Event Code

Specify the event code.

Event Type

Specify the event type from the drop-down list.

Frequency

Specify the event frequency from the drop-down list.

Synchronous

Check this box to set the event as synchronous (any failure in trigger-
ing the event will fail to trigger the entire transaction). If unchecked,
then the event is asynchronous (any failure in the event will not affect
the transaction, which will be successfully completed).

Enabled

Check this box to activate the event type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

The Event Criteria section allows you to name and describe the query for an event, as well
as enable or disable the query.

4. In the Event Criteria section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Query Name

Specify the query name.

Description

Specify the query description.
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Field: Do this:

Enabled Check this box to activate the event criteria.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Criteria Details

The Criteria Details sub screen allows you to define the selection criteria for the event. The
event engine uses these criteria to determine which application to include in the event action.

6. Inthe Setup > Setup > Administration > System > Events > Lease > Online > Criteria
section, you can define the event selection criteria. Perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator | Select comparison operator from the drop-down list.

Criteria Value Specify criteria value.
) Specify right bracket.
Logical Expression Specify logical operator from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Actions

The Actions section records the actions the system performs after the event is triggered.
8. Inthe Setup > Setup > Administration > System > Events > Lease > Online > Action
section, define the action you want the system to perform for the event by entering the

following information. (You can set up more than one event action for a particular event,
then use the Seq field to define the order in which the events will occur)

A brief description of the fields is given below:

Field: Do this:

Description Select the event action description from the drop-down list.
Seq specify sequence number.

Enabled Check this box to activate the event action.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

10. For each event action, use the Action Parameters section to set up the required action
parameters and values. Perform any of the Basic Operations mentioned in Navigation
chapter.
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A brief description of the fields is given below:

Field: Do this:

Description Specify the parameter description from the drop-down list.

Value Specify parameter value.

11. Perform any of the Basic Actions mentioned in Navigation chapter.
Batch

The Batch screen allows you to set up the events performed as a batch transaction by the
system. The system supports the following predefined batch events for application
processing. (These batch events are listed in the Events Types section on the Setup screen):

e APPLICATION LEVEL BATCH EVENT #01

e APPLICATION LEVEL BATCH EVENT #02
e APPLICATION LEVEL BATCH EVENT #03
e APPLICATION LEVEL BATCH EVENT #04
e APPLICATION LEVEL BATCH EVENT #05
e APPLICATION LEVEL BATCH EVENT #06
e APPLICATION LEVEL BATCH EVENT #07
e APPLICATION LEVEL BATCH EVENT #08
e APPLICATION LEVEL BATCH EVENT #09
e APPLICATION LEVEL BATCH EVENT #10

To setup the Batch Event
1. Click Setup > Setup > Administration > System > Events > Lease > Batch.

2. In the Events section, perform any of the Basic Operations mentioned in Navigation
chapter.

ORACLE’
Financial Services Lending and Leasing

Close
> DashBoard Events e

 Origination loan | Line  Lease
2 Servicing Event Types || Event Action Types || Online | Batch

> Collections

> WFP Events dpadd | ZEdt || E]vew || of Audt
> Tools View v Format+  E Freesz i Detach ol Wrap @

Setup Event Code Event Type Frequency Synchronous Enabled
TESTS ALwAYS N N

Setup
Administration
System
System Parameter

Event Criteria qpadd | AEdt | B Vvew | o Audit
View = Format v | Freeze pliDetach o wrap T o chedkcriteria
Query Name Descripton Enabled
TESTS TESTS N
Criteria Details  Action
Criteria dpadd | AEdt | Fven | o Auit
View v Formatv [ esze fiDetach (o]
Seg ( Parameter Comparison Operator Criteria Value ) Logical Expression  Enabled
0 SECURED ACCOUNT EQUAL TEST ¥
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A brief description of the fields is given below:

Field: Do this:

Event Code Specify the event code.

Event Type Specify the event type from the drop-down list.

Frequency Specify the event frequency from the drop-down list.

Synchronous | Check this box to set the event as synchronous (any failure in triggering

the event will fail to trigger the entire transaction). If unchecked, then the
event is asynchronous (any failure in the event will not affect the transac-
tion, which will be successfully completed).

Enabled Check this box to activate the event type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The Events Criteria section allows you to name and describe the query for an event, as well
as enable or disable the query.

4. In the Events Criteria section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Query Name | Specify the query name.

Description Specify the query description.

Enabled Check this box to activate the event criteria.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Criteria Details
The Criteria Details sub screen allows you to define the selection criteria for the event. The
event engine uses these criteria to determine which application to include in the event action.

6. Inthe click Setup > Setup > Administration > System > Events > Lease > Batch >
Criteria section, you can define the event selection criteria. Perform any of the Basic
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.
Comparison Operator Select comparison operator from the drop-down list.
Criteria Value Specify criteria value.

) Specify right bracket.
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Field: Do this:

Logical Expression Specify logical operator from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Action

The Action sub screen allows you to define the actions performed in the batch event. The
system supports the following batch event actions:

e Send letter for an application
e Generate correspondence for an application
8. Click Setup > Setup > Administration > System > Events > Lease > Batch > Action.

9. Inthe Actions section, define the action you want the system to perform for the event by
entering the following information. (You can set up more than one event action for a
particular event, then use the Seq field to define the order in which the events will occur.)
Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Description Select the event action from the drop-down list.
Seq Specify sequence numbers (required).
Enabled Check this box to activate the event action.

10. Perform any of the Basic Actions mentioned in Navigation chapter.

11. For each event action, use the Action Parameters section to set up the required action
parameters and values. Perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Description Select the event action from the drop-down list.
Value Specify sequence numbers (required).

12. Perform any of the Basic Actions mentioned in Navigation chapter.

Monitoring Events

You can verify the status of events and event actions on the Monitor Jobs screen of the
Utilities form.
To monitor events

1. On the Oracle Financial Services Lending and Leasing home screen, clickDashboard >
Dashboard > System Monitor > Jobs > Back Ground.

The system displays the status for all asynchronous events that have been completed
or failed for an application.

For further details, on monitoring events refer Dashboard Chapter of this Guide.
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Batch Jobs

“Batch jobs” refer to the back-end processes that automatically run at a certain time. There
are two types of batch jobs:

e Business processes (such as billing and delinquency processing)
e Housekeeping tasks (such as application aging and application purging)

Batch Jobs

The Batch Job screen allows you to set up, monitor, and maintain batch jobs in the system.

Batch jobs can be set up to be performed on a daily, weekly, monthly, and ad-hoc basis. Batch
jobs can also be configured to trigger an e-mail or phone message if a batch job fails.

Critical batch jobs control job flow and system date rollover to allow recovery during errors.
Errors are instances where a process did not successfully complete. Failures indicate that a
particular job encountered errors that require remedial action. The number of errors allowed
before failure is defined for each job. Some errors automatically result in a failure.

Navigating to Batch Jobs:

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Batch Jobs. The Batch Jobs details are further grouped
into two tabs:

e Batch Jobs tab
e Job Holidays tab

Batch Jobs

In the Batch Job Setup screen, you can track and maintain all batch processes within the
system. Using this form, the system administrator can configure the frequency and start time
of each batch process, as well as set the number of threads to improve performance.

“Threading” allows a specific job to be separated into smaller units that are processed at the
same time. This allows Oracle Financial Services Lending and Leasing to complete the job in
less time.

You can set up multiple batch jobs within a batch set. In the Batch Job Sets section, each
process is listed with the last run date (Last Run Dt field) and the next scheduled process date
(Next Run Dt field). In the Freq Code and Freq Value fields, you can determine the frequency
of each batch set, such as daily, weekly and monthly. You can also set up batch sets to
incorporate a dependency on another batch set. This way, if the initial batch fails, the
dependent set will not be processed.

In the Batch Jobs section, you can configure the process to run on weekends and holidays
using the respective option boxes.

CAUTION: As the batch job setup widely affects the Oracle Financial Services Lending and
Leasing system, Oracle Financial Services Software suggests that the system administrator
has a clear understanding of the various functionalities within Oracle Financial Services
Lending and Leasing before creating and updating the batch processes.

For the standard job set please review the Visio document,
dbk_std_detail_design_job_sets.vsd

To setup a Batch job
1. Click Setup > Setup > Administration > System > Batch Jobs.
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2.

Navigation chapter.

In the Batch Job Sets section, perform any of the Basic Operations mentioned in

ORACLE’

Financial Services Lending and Leasing

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Setup
Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Ruct Tables
User Defined Default
Transaction Codes
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cycles
Vendors
Collection Cycles
Reports.
Error Messages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers.
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products

< >

Batch Jobs [®] Close
Batch Jobs  Job Holidays
Batch Job Sets Fadd | Sede | [Hy o Aud
View » Formatw B Freeze B Detach @
Set Code Job Set Description Frequency Frequency value  Start Time Critical Enabled Last Run [
N N o1fot/180
SET-AAL ACCOUNT CREATION DAILY DAILLY 10:00 AM N N ogfogf200 ™
SET-ACR ACCRUALS AND DELINQUENCY DAILY DAILLY 10:30 PM ¥ N 08/07f20C
SET-ADT UPDATE AUDIT TABLE (AFTER TABLE EXPORT-IMPORT)  SPECIFIC DAY SPECIFIC DAY 10:00 AM N N
SET-AGE AGING DAILY DAILY 12:00 AM N N
SET-AGS SALE LEAD AGING DAILY DAILY 10:30PM ¥ N
SET-APT APL SPECIFIC DAY SPECIFIC DAY 2:00 PM N N
SET-8LK BULK UPLOAD SPECIFIC DAY SPECIFIC DAY 10:00 AM N N
SET-8MT1 BATCH TXNS (MONETARY) DAILY DAILLY 8:00 PM Y N
SET-BMT2 BATCH TXNS (NONMONETARY) DAILY. DAILY 8:01 PM N N
A
Batch Job Sets
[ seveand add || [ save and Stay | [l Save and Retumn || <3 Return
* Set Code * Start Time *Next Run Dt 12/31/1969 12:30:00 PM P@
= Job Set Description * Critical [] * Parent v
= Frequency [v] “Ensbled [] Dependency [¥]
Last Run Dt 01/01/1800
Frequency value -
Batch Jobs dadd | Ledt | Elview | o sudit
View = Formatw | [  Detach i o)
Seq Job Type Job Code Job Description Threads ‘Commit Count Errors Allowed We
No data to display.
< >
Batch Job Threads Fpadd | AEdt | Elview | o Audi
Vieww Formatw [ freeze B Detach Wrap. ®
Thread Trace Level Encbled
No data to display.

A brief description of the fields is given below:

Field:

Do this:

Set Code

Specify the code for the batch job set.

Job Set Description

Specify the description for the batch job set.

Frequency

Select the frequency at which the job set is to be executed
from the drop-down list.

Frequency Value

Select the frequency value from the drop-down list. The fre-
quency value will be displayed based on the frequency code
selected.

Start Time

Specify the start time for the job set.

Critical

Check this box to set job as critical. A “critical” job is one that
prevents the General Ledger (GL) post date from rolling for-
ward, should the job fail.

Enabled

Check this box to enable the job set.

Last Run Dt

The system displays the last run date of the job set.

Next Run Dt

Specify the next run date for job set. You can select the data
from adjoining calendar icon.

Parent

Select the parent job set from drop-down list.

Dependency

Select the type of dependency on the parent from drop-down
list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.

chapter.

In the Batch Job section, perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field: Do this:

Seq Specify the batch job sequence number.
Note: Within a job set, jobs are executed sequentially based on the
sequence number assigned.

Job Type Select the batch job request type from the drop-down list.

Job Code Specify the batch job request code.

Job Description

Specify the batch job description.

Threads

The system displays the number of threads used by the job.

Commit Count

Specify the number of rows after which auto-commit is triggered.

Errors Allowed

Specify the number of errors allowed.

Weekend Check this box to perform batch jobs on weekend.

Holiday Check this box to perform batch jobs on a holiday. (Holidays are
defined on the Job Holidays screen.)

Enabled Check this box to enable the batch job.

Parent Select the parent batch job from the drop-down list.

Dependency ISelect the dependency clause of the batch job from the drop-down
ist.

Command Specify the command line for the job (required).

RollbackSegment | If you choose, use this field to specify the rollback segment for job.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6.

In the Batch Job Thread section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Thread Specify the name of thread.

Trace Specify the SQL trace level (0, 1, 4, 8, 12). The higher the number, the
more activities the system can trace.

Enabled Check this box to enable the thread.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.9.1.2

Job Holidays

The system allows you to define holidays within the company on Job Holidays screen. You
can then use the Batch jobs screen to set up whether you want the system to perform batch
jobs on these days or not, using the Holiday box of Batch Jobs section .

To define job holidays

1. Click Setup > Setup > Administration > System > Batch Jobs > Job Holidays.

2. Inthe Job Holidays section, perform any of the Basic Operations mentioned in

Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools

Batch Jobs

Batch Jobs  Job Holidays

Job Holidays
View = Fomat~

Holiday Dt
02/11/2016

=4

Description
'UNDEFINED

Freeze i Detach

Setup 12/08/2015 TESTL
etup 12f25/2002 CHRISTMAS
I — THANKS GIVING DAY
st INDEPENDENCE DAY
System
CHRISTMAS
System Parameter
THANKS GIVING DAY
Lhee INDEPENDENCE DAY
i A D
User Defined Tables e
Audit Tables

User Defined Default

Transaction Codes Job Holidays
Data Files
Dedupe

Securitization

Producer Cycles
Vendors
Callection Cycles
Reparts
Error Messages
Translations

User

Organization
Companies
Access
Users
Credit Bureau
Correspondznce
General Ledger
Quauss
Printers
Bark Details
Check Details
‘Standard Payees
Currencies
Zip Codes

Froducts

< >

Enabled

N
N
v
¥
Y
¥
¥
¥
Y

Save and add || [ save and stay | [ save and Return | G Retumn

&

A brief description of the fields is given below:

Field: Do this:

Holiday Dt

Specify the date of the job holiday. You can select the date from the
adjoining calendar icon.

Description

Specify the job holiday description (required).

Enabled

Check this box to enable the holiday.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.9.2 Batch Jobs Available
The below table provides a list of Batch Jobs maintained in the system and a brief description
to each:
& 5 c
L o
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
AAE | Application aaiprc_b- | APPLICA- N Y | N | C | This process peri-
Account j_100_01 | TIONTO o | e | o | o | odically picks up
Interface ACCOUNT s m | applications in
INTERFACE m | 'Approved-Veri-
o | fied' status and
n | creates accounts.
ACH | ACH acaprc_b | ACCOUNT N |Y | N| C | This process pro-
Accounts j_100_01 | ACH PRO- 0 | e | o | o | ducesthe ACH file
CESSING s m | for the eligible cus-
m | tomer payments.
o}
n
ACH | ACH Produc- | acp- PRO- Y | Y | N| C | This process pro-
ers prc_b- DUCER e | e | o | o | ducesthe ACH file
j_100_01 | ACH PRO- s |s m | for the eligible pro-
CESSING m | ducer payments.
o]
n
ACH | ACH Ven- acvprc_b | VENDOR N |Y | N| C | This process pro-
dors j_100_01 | ACH PRO- o0 | e | o | o | ducesthe ACH file
CESSING S m | for the eligible ven-
m | dor payments.
o}
n
ACH | ACH Pro- acx- ACH Pro- Y | Y | N| C | This process pro-
ducer/Ven- prc_b- ducer/Ven- e | e | o | o | ducersthe ACH
dors/ j_100_01 | dors/ s |s m | file for the eligible
Customer/ Customer/ m | Producer/Vendors/
Third Party Third Party 0 | Customer/Third
n | Party
AGE | Aging Appli- | agaap- APPLICA- Y | N | N | C | This process puts
cations p_b- TION e | o | o | o | applications into
j_100_01 | AGING s m | 'Aged-Application’
PROCESS m | substatus.
o]
n
AGE | Aging Con- agcco- CON- Y | N | N | C | This process puts
tracts n_b- TRACT e | o | o | o | contracts into
j_100_01 | AGING S m | 'Aged-Contract'
PROCESS m | substatus.
o}
n
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
ALT- | ALLOT- PFSEFT- | BACKUP N [Y | N | C | This process cre-
PFS MENT PRC B- | EFT o | e |0 | o | atesthe Backup
EXTRACT J_ 110 s m | EFT file
FILE DUMP 1 m
o}
n
ALT- | ALLOT- PFSL- POSTING N | Y | N | C | This process posts
PFS MENT BAPRC_ | ALLOT- o | e | o | o | thepaymentsfrom
EXTRACT BJ_100_ | MENT PAY- S m | the allotment file
FILE DUMP 01 MENTS m | received from the
o | bank
n
ALT- | ALLOT- PFSOD- | ALLOT- N |Y | N| C | This process
PFS MENT DALT_B- | MENT o | e | 0o | 0| sends the allot-
EXTRACT J_100_0 | EXTRACT S m | mentdraft notice to
FILE DUMP 1 FILE DUMP m | the bank
o]
n
ALT- | ALLOT- PFSNS- | NSFBATCH | N | Y | N | C | This process posts
PFS MENT FPRC_B o | e | o | o |theNSFfile
EXTRACT J 100 0 s m | received from the
FILE DUMP 1 m | bank
o}
n
API API Accounts | accaa- API AAI N |[Y | N | C | This process cre-
ib- o0 | e |0 | o | atesaccountsfrom
j_100_01 s m | validated conver-
m | sion applications/
o | contracts
n
API API Accounts | accd- MOVE N | Y | N | C | This process cop-
mp_b- API_ XX TO o | e | o | o | iesdatafrom con-
j_100_01 | ITABS S m | version API tables
m | to conversion
o | applications table
n
API API Accounts | accval_bj | VALIDATE N |Y | N|L | This process vali-
_111_01 ITABS o | e | o | o | dateall conver-
(LOAN) s a | sion applications
n | loan accounts by
running the edits
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c - O O =
w Olw| O| o
API API Accounts | accval_bj | VALIDATE N |Y | N|L | This process vali-
_12_01 ITABS o |e | o |i | dateall conver-
(LINE) s n | sion applications
e | line of credit
accounts by run-
ning the edits
API API Accounts | acm- LOAD N [Y | N | C | This process cre-
prc_b- API_COM- o | e |0 | o | atesaccountcom-
j_100_01 | MENTS S m | ments from
m | conversion appli-
0 | cations/contracts
n
COL | Appointment | cap- APPPOINT- | N | Y | Y | C | This process can-
Cancellation | prc_b- MENT CAN- | o | e | e | o | cels all the expired
j_100_01 | CEL s | s | m| appointments.
PROCESS- m
ING o]
n
COL Payment cppprc_b | BROKEN N |Y | N| C | This process
Promise Pro- | j_100_01 | PROMISE o | e |0 | o | updatesany bro-
cessing PROCESS- S m | ken promises as of
ING m | the run time.
o}
n
CRB | Credit cbuutl_b- | CREATE N |Y | N| C | This process cre-
Bureau j_100_01 | METRO2 o|e |0 | o | atesthe METRO2
Reporting FILE S m | file for Credit
m | Bureau reporting
o | for the specified
n | date.
DOT | Document dolprc_b- | ACCOUNT N |[Y | Y | C | Thisprocessreads
Tracking j_000_01 | DOCU- o |e |e | o | acct doc load
Load MENT s | s | m | directory. Attach
LOAD m | the documents to
o0 | specified accounts
n | and move docu-
ments to appropri-
ate directory
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& 5| o €
Ea Description ?:ktfh Description § :E '% § Comment
=] o 2| 2|3
c = 0| O| =
w Olwm|O|a
DLX | Accounts ODX- ACCOUNTS | N | Y | Y | C | This process gen-
Dialer Exclu- | PRC_B- | DIALER o0 | erates a dialer
sion J _100_0 | EXCLU- m | exclusion file with
1 SION m | account details
o | and checks if the
n | maintained call
action result entry
is made on any
account during the
specified time
interval.
GLP GL Interface | gliprc_ b- | GLSUMMA- | N | Y | N | C | This process sum-
j_100_01 | RIZATION o |e |0 | o | marizes GL trans-
s m | actions for the day.
m
o}
n
GOV | Debt Report- | gdraap_ | IRS1099-A | N | Y | N | C | This process gen-
ing IRS bj_100_0 | PROCESS- |0 | e | o | o | eratesthe 1099-A
1099A / 1 ING S m | flat file for govern-
1099C m | ment reporting.
o]
n
GOV | Debt Report- | gdrcad_b | IRS 1099-C N [Y | N | C | This process gen-
ing IRS j_100_01 | PROCESS- | o0 | e | o | o | eratesthe 1099-C
1099A / ING S m | flat file for govern-
1099C m | ment reporting.
o}
n
GOV | HMDA ghr- IRS HMDA Y | N | N | C | This process gen-
Reporting prc_b- PROCESS- | e |o | o | o | erates the HMDA
j_100_01 | ING S m | flat file for govern-
m | ment reporting.
o}
n
GOV | Interest girprc_b- | IRS 1098 N [Y | N | C | This process gen-
Reporting j_100_01 | PROCESS- |0 | e | o | o | eratesthe 1098 flat
IRS 1098 ING S m | file for government
m | reporting.
o]
n
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& 5| o €
Ea Description ?:ktfh Description § :E '% § Comment
=] o 2|23
c = 0| O| =
w Olwm|O|a
JOB Scheduler jsctst_b- | Scheduler Y | Y | Y| C | This process test
j_000_01 e | e | e | o| thejob scheduler
s |s|s |m
m
o}
n
LBP Lockbox Ibxprc_b- | LOAD N | Y | N| C | This process loads
j_100_01 | LOCKBOX o | e |0 | o | anylockbox files
PROCESS- s m | available. This pro-
ING m | cess can be set to
0 | run periodically
n | throughout the day.
LNT Lien Tracking | OFD- OUTPUT N |Y | N| C | This process gen-
PRC_B- | LIEN 0 | erates output file
J 111 0 | TRACKING m | with changes in
3 FOR DATA m | customer informa-
CHANGE o | tion such as
n | Address/Phone
no./Borrower/Co-
borrower name.
LNT Lien Tracking | OFD- OUTPUT N [Y | N | C | This process gen-
PRC _B- | LIEN o | erates output file
J 111 _0 | TRACKING m | for '"Void Accounts'
4 FOR VOID m | to be sent to dealer
ACCOUNT o | track.
n
LTR Collections Icolt1_b- | GENERATE | N | N | Y | C | This process gen-
Letter j_100 01 | FIRSTCOL- | o | o | e | 0 | erates the first col-
LECTION s | m | lection letter for
LETTER m | eligible accounts.
o]
n
LTR Collections Icolt2_b- | GENERATE | N | N | Y | C | This process gen-
Letter j_100_01 | SECOND o | o |e | o | eratesthe second
COLLEC- s | m | collection letter for
TION LET- m | eligible accounts.
TER o]
n
LTR Collections Icolt3_ b- | GENERATE | N | N | Y | C | This process gen-
Letter j 100 01 | THIRDCOL- | 0o | 0o | e | o | erates the third col-
LECTION s | m | lection letter for
LETTER m | eligible accounts.
o}
n
2-45 ORACLE



& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
LTR Customer Icspdf_b- | PAID IN N |[Y | N|L | This process gen-
Service Let- | j 111_01 | FULL LET- 0 | e | o | o | erates the paid-in-
ter TER s a | full letter for the
n | relevant accounts.
LTR Customer Icspo- PAYOFF N Y | N | C | This process gen-
Service Let- q_b- QUOTE o | e |0 | o | eratesthe payoff
ter j_111_01 | LETTER s m | quote letter for the
m | requested
o | accounts.
n
LTR Customer Icsst- CuUs- N Y | N | C | This process gen-
Service Let- m_b- TOMER o | e |0 | o | eratesthe cus-
ter j_100_01 | STATE- S m | tomer statement
MENT LET- m | letter for requested
TER 0 | accounts.
n
LTR Customer Icswel b- | WELCOME N |[Y | N|L | This process gen-
Service Let- | j_111_01 | LETTER o | e | o | o | eratesthe wel-
ter S a | come letter for the
n | newly funded
accounts.
LTR Origination loraco_b- | Origination Y | N | N | L | This process gen-
Letter j_111_01 | Adverse e | o | o | o | eratesthe adverse
Action Let- S a | action letter for rel-
ter(Condi- n | evant applications.
tional)
(Loan)
LTR Origination loradv_b- | Origination Y | N| N | L | This process gen-
Letter j_111_01 | Adverse e | o | o | o | eratesthe adverse
Action Let- S a | action letter for rel-
ter (Loan) n | evant applications.
ODD | Coupon och- CUS- N Y | N | C | This process gen-
Book Dump prc_b- TOMER o | e | o | o | erates coupon
File j_100_01 | COUPON s m | books, if appropri-
BOOK GEN- m | ate.
ERATION o}
n
ODD | Output Data | odd- CREATE Y | Y |Y | C | This process cre-
Dump File prc_b- OUTPUT e | e | e | o | ates any defined
j_000 01 | DATADUMP | s | s | s | m | output data dump
FILES m | files set in the sys-
o | tem.
n
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
ODD | Collections olclt1_b- | COLLEC- N [N | Y | C| This process gen-
Letter j_100_01 | TION LET- o | o |e | o | erates the first col-
TER 1 FILE s | m | lection letter for
CREATION m | eligible accounts.
o}
n
ODD | Collections olclt2_b- | COLLEC- N [N | Y | C | This process gen-
Letter j_100_01 | TION LET- 0 |0 | e | o | eratesthe second
TER 2 FILE s | m | collection letter for
CREATION m | eligible accounts.
o]
n
ODD | Collections olclt3_b- | COLLEC- N [N | Y | C | This process gen-
Letter j_100_01 | TION LET- o0 | o | e | o | erates the third col-
TER 3 FILE s | m | lection letter for
CREATION m | eligible accounts.
o]
n
ODD | Origination olo- ADVERSE Y | N | N | C | This process gen-
Letter aco_b- ACTION e | 0 | o | o | eratesthe adverse
j_100_01 | CONDI- s m | action letter for rel-
TIONAL m | evant applications.
LETTER o}
FILE CRE- n
ATION
ODD | Origination oload- ADVERSE Y | N | N | C | This process gen-
Letter v_b- ACTION e | 0 | o | o | eratesthe adverse
j_100 01 | LETTER s m | action letter for rel-
FILE CRE- m | evant applications.
ATION o]
n
ODD | Customer olspdf b- | PAID IN N Y | N | C | This process gen-
Service Let- | j_100_01 | FULL FILE o |e |0 | o | eratesthe paid-in-
ter CREATION S m | full letter for the
m | relevant accounts.
o
n
ODD | Customer olspo- PAY OFF N | Y | N| C | This process gen-
Service Let- q_b- QUOTE o | e |0 | o | eratesthe payoff
ter j_100_01 | FILE CRE- s m | quote letter for the
ATION m | requested
o | accounts.
n
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
ODD | Customer ols- WELCOME N [Y | N | C | This process gen-
Service Let- wel_b- LETTER O | e | o | o | eratesthe wel-
ter j_100_01 | FILE CRE- s m | come letter for the
ATION m | newly funded
o | accounts.
n
ODD | Producer opsprc_b | DEALER N Y | N | C | This process gen-
Statement j_100_01 | STATE- o0 | e |0 | o | eratesthe dealer/
Dump File MENTS S m | producer state-
GENERA- m | ments at the speci-
TION o | fied frequency.
n
ODD | Customer ostprc_b- | CUS- N Y | N | C | This process gen-
Statement j_100_01 | TOMER o |e |0 | o | eratesthe cus-
Dump File STATE- S m | tomer statement
MENTS m | for eligible
GENERA- 0 | accounts.
TION n
PRQ | Payable pcu- CUsS- N |Y | N| C | This process cre-
Requistion prc_b- TOMER o | e | o | o | atesrequisitions
Customer j_100_01 | REFUND s m | for customer over-
PAYMENT m | payment refunds.
REQUISI- o}
TIONS n
PRQ | Payable ppores b | MONTH N [Y | N | C | This process cre-
Requisition j_100_01 | END o | e | 0o | 0 | atesrequisitions
Producer DEALER S m | for dealer compen-
RESERVE m | sation payments
PAYMENT 0 | on month-end.
REQUISI- n
TIONS
PRQ | Payable pvn- VENDOR N |Y | N| C | This process cre-
Requisition prc_b- INVOICE o0 | e | o | o | atesrequisitions
Vendor j_100_01 | PAYMENT S m | for vendor invoice
REQUISI- m | payments
TIONS o]
n
PUR | Archive pacarc_b | ARCHIVE N|Y |Y | C| This process
Accounts j_100_01 | ACCOUNT o | e | e | o | archives account
DATA TO s | s | m| data from
OTABLES m | ACCOUNTS table
o | to OACCOUNTS
n | table.
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
PUR | Archive pacarc_b | ARCHIVE N |Y | Y | C | This process
Accounts j_100_02 | ACCOUNT o | e | e | o | archives account
DATA TO s | s | m| data from OAC-
OOTABLES m | COUNTS table to
o | OOACCOUNTS
n | table.
PUR | Archive paparc_b | ARCHIVE Y | N| N | C | This process
Applications | j_100_01 | APPLICA- e | o | o | o | archives applica-
TION DATA | s m | tion-related data
TO m | from APPLICA-
OTABLES o | TIONS to OAPPLI-
n | CATIONS table.
PUR | Archive paparc_b | ARCHIVE Y | N | N | C | This process
Applications | j_100_02 | APPLICA- e | o | o | o | archives applica-
TION DATA | s m | tion-related data
TO OOT- m | from OAPPLICA-
ABLES 0 | TIONS to OOAP-
n | PLICATIONS
table.
PUR | Archive GL pglarc_b- | ARCHIVE N |Y |Y | C| This process
j_100_01 | GLDATATO | o | e | e | o | archives General
OTABLES s | s | m| Ledger data from
m | GL tables to OGL
o | tables.
n
PUR | Archive GL pglarc_b- | ARCHIVE N |Y |Y | C | This process
j_100 02 | GLDATATO | o | e | e | o | archives General
OOTABLES s | s | m | Ledger data from
m | OGL tables to
o | OOGL tables.
n
PUR | Purge Job pjrirq_b- | Purge Job Y |Y | Y| C | This process
Requests j_100_01 | Requests e |e |e | o | purgesjob
s | s | s | m| requests from the
m | system.
o]
n
PUR | PurgeOutput | pododh_ | PURGE N |Y | Y | C | This process
Data Dump bj_100_0 | OUTPUT o |e |e | o | purges Output
1 DATA s | s | m | Data Headers from
HEADERS m | the system.
o}
n
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§ 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c - O O =
w Olw| O| o
PUR | Archive ppaarc_b | ARCHIVE N |Y | N| C | This process
Securitiza- j_100_01 | POOLDATA |0 | e | o | o | archives securiti-
tion TO s m | zation data from
OTABLES m | TABLE to corre-
o | sponding OTABLE.
n
PUR | Archive ppaarc_b | ARCHIVE N |Y | N| C | This process
Securitiza- j_100 02 | POOLDATA | o | e | o | o | archives securiti-
tion TO OOT- s m | zation data from
ABLES m | OTABLE to corre-
o | sponding OOT-
n | ABLE.
PUR | Archive Pro- | pprarc_bj | ARCHIVE Y |Y | Y| C | This process
ducers 100 01 | PRO- e | e | e | o | archives producer
DUCER s | s | s | m| datafrom PRO-
DATATO m | DUCERS table to
OTABLES o | OPRODUCERS
n | table.
PUR | Archive Pro- | pprarc_bj | ARCHIVE Y | Y |Y | C | This process
ducers _100_02 | PRO- e | e | e | o | archives producer
DUCER s | s | s | m| data from OPRO-
DATATO m | DUCERS table to
OOTABLES o | OOPRODUCERS
n | table.
PUR | Archive Pro- | ppx- ARCHIVE N |Y | N| C | This process
ducers Txns | arc_b- PRO- o | e |0 | o | archives producer
j_100_01 | DUCER s m | transaction data
TXNS DATA m | from PRODUC-
TO o | ERS table to
OTABLES n | OPRODUCERS
table.
PUR | Archive Pro- | ppx- ARCHIVE N |Y | N| C | This process
ducers Txns | arc_b- PRO- o | e | o | o | archives producer
j_100_02 | DUCER s m | transaction data
TXNS DATA m | from OPRODUC-
TO OOT- o | ERS table to
ABLES n | OOPRODUCERS
table.
PUR | Archive pstarc_b- | ARCHIVE N |Y | N| C | This process
Statements j_100_01 | ACCOUNT o | e | o | o | archives account
STATE- s m | statement and
MENT AND m | transaction data
TXNS DATA o | from TABLE to cor-
TO n | responding
OTABLES OTABLE.
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PUR | Archive pstarc_b- | ARCHIVE N |Y | N| C | This process
Statements j_100_02 | ACCOUNT o | e | o | o | archives account
STATE- s m | statement and
MENT AND m | transaction data
TXNS DATA o | from OTABLE to
TO OOT- n | OOTABLE.
ABLES
PUR | Terminate ptuus- Terminate Y | Y| Y| C| This process termi-
User r_b- User e | e | e | o | nates user satisfy-
j_100_01 s | s | s | m| ingthe selection
m | criteria.
o]
n
PUR | Archive Txns | ptxarc_b- | ARCHIVE N |Y | N | C | This process
(To O tables) | j_100_01 | TXNS DATA | o | e | o | o | archives data from
TO S m | TXNS table to
OTABLES m | OTXNS table.
o]
n
PUR | Archive Txns | ptxarc_b- | ARCHIVE N |Y | N| C | This process
(To OO j_100_02 | TXNS DATA | o | e | o | o | archives data from
tables) TO OOT- S m | OTXNS table to
ABLES m | OOTXNS table.
o}
n
PUR | Purge User pululg_b- | Purge User Y |Y | Y| C | This process
Logins j_100_01 | Logins e | e | e | o | purges userlogin
s | s | s | m| datafrom the sys-
m | tem.
o]
n
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PUR | Archive Ven- | pvaarc_b | ARCHIVE N |Y | Y | C | This process
dor Assign- j_100_01 | VENDOR o | e | e | o | archives vendor
ments ASSIGN- s | s | m | assignment data

MENTS m | from TABLE to

DATATO o | OTABLE.

OTABLES " | The criteria for
archival is based
on following valida-
tion - Work Order
Status = Closed /
Completed /
Repossessed +
Days mentioned in
system parameter
‘PVA_ARCHIVE_-
DAYS'.

PUR | Archive Ven- | pvaarc_b | ARCHIVE N |Y |Y | C | This process
dor Assign- j_100_02 | VENDOR o | e | e | o | archives vendor
ments ASSIGN- s | s | m | assignment data

MENTS m | from OTABLE to

DATATO o | OOTABLE based

OOTABLES n | on the days men-
tioned in system
parameter
‘PVA_OAR-
CHIVE_DAYS'.

PUR | Archive Ven- | pviarc_b- | ARCHIVE N|Y |Y | C | This process

dor Invoices | j_100_01 | VENDOR o | e | e | o| archives vendor
INVOICES s | s | m| invoice data from
DATATO m | TABLEs to
OTABLES o | OTABLEs.

n The criteria for
archival is based
on following valida-
tion - Invoice Sta-
tus = ‘Close’ +
Days mentioned in
system parameter
‘PVI_ARCHIVE_-
DAYS'.
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PUR | Archive Ven- | pviarc_b- | ARCHIVE N |Y | Y | C | This process
dor Invoices | j 100_02 | VENDOR o | e | e | o | archives vendor

INVOICES s | s | m| invoice data from
DATATO m | OTABLEs to OOT-
OOTABLES o0 | ABLEs based on

n | the days men-
tioned in system
parameter
‘PVI_OAR-
CHIVE_DAYS'.

PUR | Archive Ven- | pvearc_b | ARCHIVE N |Y |Y | C | This process
dors j_100_01 | VENDORS o | e |e | o | archives vendor
DATA TO s | s | m| invoice data from
OTABLES m | TABLEs to

o | OTABLEs.

n The criteria for
archival is based
on following valida-
tion - Vendor end
date is less than
system date - Days
mentioned in sys-
tem parameter
‘PVE_ARCHIVE_-
DAYS'.

PUR | Archive Ven- | pvearc_b | ARCHIVE N|Y |Y | C | This process
dors j_100_02 | VENDORS o | e | e | o| archives vendor
DATA TO s | s | m| invoice data from
OOTABLES m | OTABLEs to OOT-

0 | ABLEs based on

n | the days men-
tioned in system
parameter
‘PVE_OAR-
CHIVE_DAYS'.

QUE | Queue Cus- | qcsprc_b | CUS- N |Y | Y| C| This process cre-
tomer Ser- j_100_01 | TOMER o | e |e | o | atesthe customer
vice SERVICE s | s | m| service/collections

QUEUE m | queues
PROCESS- 0
ING n
RDB | RDB1 racd- Data Dump N |Y | Y | C | This process trans-
1 Accounts mp_b- Accounts o | e | e | o | ferstheaccount
j_100_01 s | s | m| datafrom (OLTP)

m | Regular tables to

o0 | Temporary T tables

n
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RDB | RDB1 Appli- | rapd- LOAD Y | N | N | C | This process trans-
1 cations mp_b- APPLICA- e | o | o | o | fersthe applica-
j_100_01 | TION s m | tion data from
RELATED m | (OLTP) Regular
DATA INTO o | tables to Tempo-
T TABLES n | rary T tables
RDB | RDB1 Asset | ratd- LOAD N |Y | N | C | This process trans-
1 Tracking mp_b- ASSET o | e |0 | o | fersthe account
j_100_01 | RELATED s m | asset data from
DATA INTO m | (OLTP) Regular
T TABLES o | tables to Tempo-
n | rary T tables
RDB RDB1 Bank- | rbkd- LOAD N | N|Y | C | This process trans-
1 ruptcy mp_b- BANK- o | o | e | o | fersthe account
j_100_01 | RUPTCY s | m | bankruptcy data
DATATO T m | from (OLTP) Regu-
TABLES o | lar tables to Tem-
n | porary T tables
RDB | RDB1 Call rcad- LOADCALL | N| N | Y | C | This process trans-
1 Activities mp_b- ACTIVITIES | o | o | e | o | fers the account
j_100_01 | DATA INTO s | m | call activity data
T TABLES m | from (OLTP) Regu-
o | lar tables to Tem-
n | porary T tables
RDB | RDB1 Defi- rchd- LOAD DEFI- | N | N | Y | C | This process trans-
1 ciency mp_b- CIENCY o | o | e | o | ferstheaccount
j_100_01 | DATA INTO s | m | deficiency data
T TABLES m | from (OLTP) Regu-
0 | lar tables to Tem-
n | porary T tables
RDB | RDB1 Con- rcod- LOADCON- | Y |Y | N | C | This process trans-
1 tracts mp_b- TRACT e | e | o | o | fersthe account
j_100_01 | DATA INTO s |s m | contracts data from
T TABLES m | (OLTP) Regular
o | tables to Tempo-
n | rary T tables
RDB | RDB1 rfod- LOAD N | N |Y | C | This process trans-
1 Reposses- mp_b- REPO o | o | e | o | fersthe account
sions j_100_01 | FORECLO- s | m | bankruptcy data
SURE DATA m | from (OLTP) Regu-
INTOT o | lar tables to Tem-
TABLES n | porary T tables
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RDB | RDB1 Pro- rprd- LOAD PRO- | N | Y | N | C | This process trans-
1 ducers mp_b- DUCER o | e |0 | o | fersthe producer
j_100_01 | ANDITS s m | and producer
TXNS DATA m | transactions data
INTOT o | from (OLTP) Regu-
TABLES n | lar tables to Tem-
porary T tables
RDB | RDB1 Setup | rstd- LOAD Y | Y| Y| C | This process trans-
1 mp_b- SETUP e | e | e | o | fersthe setup data
j_100_01 | RELATED s | s | s | m| from (OLTP) Regu-
DATA INTO m | lar tables to Tem-
T TABLES o | porary T tables
n
RDB | RDB1 Txns rtxd- LOAD TXN N |Y | N | C | This process trans-
1 mp_b- DATA INTO o | e | o | o | fersthe account
j_100_01 | T TABLES s m | transactions data
m | from (OLTP) Regu-
o | lar tables to Tem-
n | porary T tables
RDB | RDB2 racac- Load N |Y | Y | C| This process trans-
2 Accounts c_b- Reporting o | e | e | o | fersthe account
j_100_01 | Tables s | s | m| datafrom T tables
Accounts m | to RDB tables
o}
n
RDB | RDB2 rac- Update N |Y |Y | C | This process
2 Accounts drv_b- Reporting 0 | e | e | 0 | updates the codes
(Derived j_100_01 | Tables s | s | m | with description for
Fields) Accounts m | account RDB
o | tables
n
RDB | RDB2 Appli- | rapap- Load Y | N | N | C | This process trans-
2 cations p_b- Reporting e | o | o | o | fersthe applica-
j_100_01 | Tables Appli- | s m | tion data from T
cations m | tables to RDB
o | tables
n
RDB | RDB2 Appli- | rap- Update Y | N | N | C | This process
2 cations drv_b- Reporting e | 0 | o | o | updates the codes
(Derived j_100_01 | Tables Appli- | s m | with description for
Fields) cations m | application RDB
(Derived o | tables
Fields) n
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RDB | RDB2 Asset | ratase_bj | Load N |Y | N | C | This process trans-
2 Tracking _100_01 | Reporting o | e |o | o | fersthe account
Tables Asset s m | asset tracking data
Tracking m | from T tables to
o | RDB tables
n
RDB | RDB2 Asset | ratdrv_b- | Update N |Y | N| C | This process
2 Tracking j_100_01 | Reporting 0 | e | 0 | 0 | updates the codes
(Derived Tables Asset s m | with description for
Fields) Tracking m | account asset
(Derived o | tracking RDB
Fields) n | tables
RDB | RDB2 Bank- | rbkab- Load N | N|Y | C | This process trans-
2 ruptcy d _b- Reporting o | o | e | o | fersthe account
j_100_01 | Tables s | m | bankruptcy data
Bankruptcy m | from T tables to
o | RDB tables
n
RDB | RDB2 Call rca- Load N | N |Y | C | This process trans-
2 Activities cac_b- Reporting o | o | e | o | fersthe account
j_100_01 | Tables Call s | m | call activities data
Activities m | from T tables to
o | RDB tables
n
RDB | RDB2 Defi- rchaof_bj | Load N | N|Y | C | This process trans-
2 ciency _100_01 | Reporting o | o | e | o | ferstheaccount
Tables Defi- s | m | deficiency data
ciency m | from T tables to
o | RDB tables
n
RDB | RDB2 Con- rco- Load Y | Y | N| C | This process trans-
2 tracts con_b- Reporting e | e | o | o | fersthe account
j_100_01 | TablesCon- |s | s m | contract data from
tracts m | T tables to RDB
o | tables
n
RDB | RDB2 Con- rcodrv_bj | Update Y | Y | N| C | This process
2 tracts _100_01 | Reporting e | e | o | o | updates the codes
(Derived TablesCon- | s | s m | with description for
Fields) tracts m | account contract
(Derived o | RDB tables
Fields) n
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RDB | RDB2 rfoafr_b- | Load N [N | Y | C | This process trans-
2 Reposses- j_100_01 | Reporting o | o |e | o | fersthe account
sions Tables s | m | repossession data
Reposses- m | from T tables to
sions o | RDB tables
n
RDB | RDB2 Pro- rprdrv_b- | Update N |Y | N| C | This process
2 ducers j_100_01 | Reporting 0 | e | 0| o | updates the codes
(Derived Tables Pro- S m | with description for
Fields) ducers m | producer and pro-
(Derived 0 | ducer transactions
Fields) n | RDB tables
RDB | RDB2 Pro- rprpro_b- | Load N |Y | N | C | This process trans-
2 ducers j_100_01 | Reporting o|e |0 | o | fersthe producer
Tables Pro- s m | and producer
ducers m | transactions data
o | from T tables to
n | RDB tables
RDB | RDB2 Setup | rststp_b- | Load Y | Y |Y | C| This process trans-
2 j_100_01 | Reporting e | e | e | o | fersthe setup data
Tables s |s |s | m|fromTtablesto
Setup m | RDB tables
o}
n
RDB | RDB2 Txns rixdrv_b- | Load N |Y |Y | C | This process trans-
2 j_100_01 | Reporting o | e | e | o | ferstheaccount
Tables Txns s | s | m | transaction data
m | from T tables to
o | RDB tables
n
RDB | RDB2 Txns rixtxn_b- | Update N|Y |Y | C | This process
2 (Derived j_100_01 | Reporting o0 | e | e | 0 | updates the codes
Fields) Tables Txns s | s | m | with description for
(Derived m | account transac-
Fields) o | tions RDB tables
n
SEC Pool Sum- ssm- POOL SUM- | N | Y | N | C | This process popu-
mary prc_b- MARY o|e |o | o |lates summary
j_100_01 | TABLE s m | tables for all pools
POPULA- m
TION o}
n
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SET- | OVERPAY- PFSTX- OVERPAY- N |Y | N| C | This process han-

OVR | MENT NOVR_B | MENT o | e |0 | o | dlesthe overpay-
REALLOCA- | J 100 0 | REALLOCA- s m | ments/overages
TIONS 1 TIONS m | existing on an

o | account
n
TPE Earning/ tam- AMORTIZA- | N | Y | N | C | This process cre-
Amortization | prc_b- TION o|e |o | o | atesthe month-
j_100_01 | TRANSAC- S m | end interest
TIONS m | accrual transac-
PROCESS- 0 | tions on month-
ING n | end.
TPE Earning/ tam- MONTH N |Y | N|L | This process cre-
Amortization | prc_b- END AMOR- | 0 | e | 0 | 0o | ates the month-
j_111_01 | TIZATION s a | end interest
TRANSAC- n | accrual transac-
TIONS tions on month-
end.

TPE Escrow Non tenbmt_ b | EscrowNon | N | Y | Y | C | This process posts
Monetary j_100_01 | Monetary O | e |e | o | escrownonmone-
Transactions Batch Trans- s | s | m| tarytransactions in

actions m | the background at
o | the specified time
n | interval.

TPE Escrow Anal- | tesanl_b- | Escrow N | Y | N | C | This process posts
ysis & Dis- j_100_01 | Analysis o|e |o | o | allapproved
bursements Posting s m | escrow analysis to

m | the account
o}
n

TPE Escrow Anal- | tesanl_b- | Create N [Y | N | C | This process cre-
ysis & Dis- j_100_02 | batches for o |e |0 | o | atescompany
bursements Customer s m | branch wise

Refund m | batches for cus-
Requests o | tomer refund
n | requests.

TPE Escrow Anal- | tesanl_b- | Create N | Y | N | C | This process popu-
ysis & Dis- j_100_03 | Transaction | o | e | o | o | late customer
bursements of Customer s m | refund request in

Refund m | respective batch
Requests o0 | created above

n
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TPE Escrow Anal- | tesanl_b- | Compute N |Y | N | C | This process popu-
ysis & Dis- j_100_04 | controltotals | o | e | o | o | lates control totals
bursements for cus- s m | for the bathes cre-
tomer refund m | ated for customer
request o | refund requests.
batches n
TPE Escrow Anal- | tesanl_b- | Escrow N |Y | N| C | This process
ysis & Dis- j_100_05 | compliance 0| e |0 | o | checks escrow-
bursements checking S m | able account for
m | compliance
o]
n
TPE Escrow Anal- | tesds- Escrow dis- N | Y | N | C | This process posts
ysis & Dis- b _b- bursement O | e | o | o | processed escrow
bursements j_100_05 | posting & s m | disbursement and
requisition m | creates requisi-
creation o | tions.
n
TPE Non Mone- tnmb- NON MON- N | Y | Y | C | This process posts
tary Transac- | mt_b- ETARY o | e |e | o | nonmonetary
tions j_100_01 | TRANSAC- s | s | m | transactions in the
TIONS m | background at the
POSTING o | specified time
n | interval.
TPE Compensa- tpr- Compensa- N |Y | N|L | This process cre-
tion com_b- tion o | e | 0 | 0| atestransaction for
ji_111_01 S a | month-end pro-
n | ducer compensa-
tion
TPE Statement tprps- Producer N |Y | N|L | This process cre-
g_b- Statement o |e |0 | o | atesthe month-
j_111_01 s a | end interest
n | accrual transac-
tions on month-
end.
TPE Monetary txnacr_b- | INTEREST N | Y | N | C | This process posts
Transactions | j_100_01 | ACCRUAL o|e |0 | o |anypayment
AND DELIN- s m | batches open in
QUENCY m | the system. This
PROCESS- 0 | process can be set
ING n | to run periodically.
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TPE Monetary txnact_b- | ACCOUNT N |Y | N | C | Thisjob activates
Transactions | j 100_01 | ACTIVA- O | e | o | o | newaccountsi.e.
TION s m | changes status
m | from PENDING to
o | ACTIVE.
n
TPE Monetary txnad- Advance N | Y | N|L | This process posts
Transactions | v_b- Posting o |e |o |i | anyadvance
ji_112_01 S n | batches openin
e | the system. This
process can be set
to run periodically.
TPE Monetary txnan- ANNIVER- N |Y | N| C | This process car-
Transactions | n_b- SARY PRO- | o | e | 0 | o | ries out the anni-
j_100_01 | CESSING s m | versary processing
m | for eligible
0 | accounts
n
TPE Monetary txnbmt_b | MONE- N | Y | N | C | This process posts
Transactions | j_100_01 | TARY o | e | o | o | monetary transac-
TRANSAC- S m | tions in the back-
TIONS m | ground at the
POSTING o | specified time
n | interval.
TPE Monetary txnch- Chargeoff N |Y | N| C | This process
Transactions | g_b- Processing o | e | o | o | charges off eligi-
j_100_01 S m | ble or scheduled
m | for chargeoff
o | accounts.
n
TPE Monetary txnch- Chargeoff N |Y | N| C | Onposting charge
Transactions | g_b- reversal o | e | o | o | offreversal trans-
j_100_03 s m | action, this pro-
m | cess moves the
0 | remaining expense
n | and fee from
charge off balance
to active balance.
TPE Monetary txncls_b- | VOID/PAID N |Y | N | C | This process
Transactions | j_100_01 | ACCOUNT o |e | o | o | closes void and
CLOSE s m | paid off accounts.
PROCESS- m
ING o}
n
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TPE Monetary txnddt_b- | BILLING/ N [Y | N | C | This process cre-
Transactions | j 100_ 01 | DUEDATES | o | e | o | o | ates/updates the
PROCESS- s m | due dates for the
ING m | accounts in the
0 | system.
n
TPE Monetary txnfpd_b- | FIRSTPMT | N | Y | N | C | This process posts
Transactions | j 100_01 | DEDUC- o |e |0 | o | thefirst payment
TION PRO- S m | deduction pay-
CESSING m | ment to the eligi-
o0 | ble accounts.
n
TPE Monetary txnfpr_b- | FIRSTPMT | N |Y | N | L | This process posts
Transactions | j_111_01 | REFUND o | e |0 | o | thefirst payment
PROCESS- s a | deduction pay-
ING n | ment to the eligi-
ble accounts.
TPE Monetary txnitc_b- | LATE N |Y | N| C | This process
Transactions | j_100_01 | CHARGE O | e | o | o | assesses late
PROCESS- S m | charge depending
ING m | on the rules, for all
o | accounts in the
n | system.
TPE Monetary txnmt- MONTH N |Y | N | C | This process popu-
Transactions | d_b- END PRO- o|e |0 | o | latesthe month
j_100_01 | CESSING s m | end balances and
m | carries over the
o | balances to next
n | month.
TPE Monetary txnp- Payment N |Y | N| C | This process does
Transactions | mt_b- Posting o | e | o | o | thedaily accrual
j_100_01 s m | and delinquency
m | processing.
o]
n
TPE Monetary txn- PROMO- N |Y | N| C | Thisprocess'ends'
Transactions | prm_b- TION END o | e | o | o | thepromotionon
j_100_01 | PROCESS- s m | the account.
ING m
o}
n
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TPE Monetary txn- TLP PRO- N |Y | N | C | This process 'can-
Transactions | prm_b- MOTION o|e |0 | o |cels'the promo-
j_100_03 | CANCEL s m | tion on the
PROCESS- m | account.
ING o}
n
TPE Monetary txnrat_b- | RATE N |Y | N| C | This process
Transactions | j_100_01 | CHANGE o | e | 0o | o | changes the prev-
PROCESS- s m | alent rate on an
ING m | account.
o]
n
TPE Monetary txn- SCHEDULE | N | Y | N | C | This process puts
Transactions | sch_b- FOR o | e | o | o | the'Schedule for
j_100_01 | CHARGED s m | Charge Off' condi-
OFF PRO- m | tion on eligible
CESSING 0 | accounts.
n
TPE Monetary txntip_b- | TERMINA- N | Y | N | C | This process puts
Transactions | j 100_01 | TIONPRO- | o |e | o | o | the"Paid" status
CESSING S m | on eligible
m | accounts
o}
n
TPE Monetary txnytd_b- | YEAR END N |Y | N| C | This process popu-
Transactions | j 100_01 | PROCESS- | o | e | o | o | lates the year end
ING S m | balances and car-
m | ries over the bal-
0 | ances to next year.
n
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Engine Type

Description

Batch
Job

Description

Comment

X
U
Py

DEALER
TRACK
PRO-
DUCER
LOAD

XPRP-
ST EW_
100_01

DEALER
TRACK
PRO-
DUCER
LOAD

Z | Origination

<'| Servicing

<'| Collection

5 03 39 0| Product

This process
dumps producer
details maintained
in the system into
Dealer Track.

System can either
use MDB flow by
generating out-
bound JMS mes-
sage if system
parameter ‘OUT-
BOUND_DL-
R_TRACK_Q'is
set to Y’ or use
existing flow by
making database
synchronous out-
bound calls to pro-
ducer data dump
web service.

XPR

ROUTE ONE
PRO-
DUCER
LOAD

XPRP-
ST EW_
100_01

ROUTE
ONE PRO-
DUCER
LOAD

So3300

This process
dumps producer
details maintained
in the system into
ROUTEONE.

System can either
use MDB flow by
generating out-
bound JMS mes-
sage if system
parameter ‘OUT-
BOUND_ROU-
TEONE_Q' is set
to ‘Y’ or use exist-
ing flow by making
database synchro-
nous outbound
calls to producer
data dump web
service.

LTR

CONDI-
TIONAL
ADVERSE
ACTION
LETTER

LORAC
O_B-
J_100_0

CONDI-
TIONAL
ADVERSE
ACTION
LETTER
GENERA-
TION

S50 O

This process gen-

erates the adverse
action letter for rel-
evant applications.
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w Olwm|O|a
LTR ADVERSE LORAD- | ADVERSE Y | N| N | L | This process gen-
ACTION V_B- ACTION e | o | o | o | eratesthe adverse
LETTER J_100_ 0 | LETTER s a | action letter for rel-
1 GENERA- n | evant applications.
TION
RPT | ACCOUNT ROPAC- | ACCOUNT NlY | N|C
LIST C_EM_1 | LIST ole|o|o
00_01 s m
m
o]
n
RPT | ADVANCE ROPAD- | ADVANCE N|Y|N|C
POSTING V_EM_1 | POSTING ole|o|o
LIST 00_01 LIST s m
m
o]
n
RPT | ASSET ROPAT- | ASSET N|Y|N|C
TRACKING K EM_ 1 | TRACKING |o |e |0 |oO
DETAILS 00_01 DETAILS s m
m
0
n
RPT | BANK- ROPBN BANK- N|Y|N|C
RUPTCY K EM_1 | RUPTCY ole|o|o
ACCOUNT 00_01 ACCOUNT s m
LIST LIST m
o]
n
RPT | COLLEC- ROP- COLLEC- NIY | N|C
TORACTIV- | COL_EM | TORACTIV- |o |e |0 | O
ITY DETAILS | _100_01 | ITY s m
DETAILS m
o]
n
RPT | DEFI- ROP- DEFI- N|Y|N|C
CIENCY DEF_EM | CIENCY olel|o|o
ACCOUNT _100_01 | ACCOUNT s m
LIST LIST m
o}
n
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RPT DELIN- ROP- DELIN- N|Y|N|C
QUENT DLQ_EM | QUENT olel|o|o
ACCOUNT _100_01 | ACCOUNT s m
LIST LIST m
o}
n
RPT FUNDING ROP- FUNDING NlY | N|C
CONTRACT | FUN_EM | CON- o|le|o|o
LIST _100_01 | TRACT LIST s m
m
o]
n
RPT | GLTXN ROP- GL TXN NlY | N|C
DETAILS GLI_EM | DETAILS ole|o|o
LIST _100_01 | LIST s m
m
o]
n
RPT | APPLICA- ROPOR | APPLICA- N|Y|N|C
TIONSLIST | G EM_1 | TIONSLIST |o |e |0 | O
00_01 s m
m
o}
n
RPT PAYMENT ROP- PAYMENT NlY | N|C
ALLOCA- PAL_ EM | ALLOCA- ole|o|o
TION POST- | _100_01 | TION POST- s m
ING ING m
DETAILS| DETAILS| o}
n
RPT PAYMENT ROP- PAYMENT NIY | N|C
POSTING PMT_EM | POSTING ole|o|o
LIST _100_01 | LIST s m
m
o]
n
RPT PAYABLE ROP- PAYABLE N|Y|N|C
REQUISI- PRQ_E REQUISI- ole|o|o
TION LIST M_100_0 | TION LIST s m
1 m
o}
n
2-65 ORACLE



& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=] D 2| =3
c = 0| O| =
w Olwm|O|a
RPT | REPOSSSE- | ROPRE REPOS- N|Y|N|C
SION/FORE- | P_LEM_1 | SSESION/ olel|o|o
CLOSURE 00_01 FORECLO- s m
ACCOUNT SURE m
LIST ACCOUNT o}
LIST n
RPT | SCHEDULE | ROP- SCHEDULE |[N|Y |N|C
TO CHAR- SCH_EM | TO CHAR- ole|o|o
GEOFF LIST | _100_01 | GEOFF s m
LIST m
o]
n
RPT | TERMINA- ROP- TERMINA- N|Y|N|C
TION IN TIP_EM_ | TION IN ole|o|o
PROGRESS | 100_01 PROG- s m
LIST RESS LIST m
o]
n
RPT | NON MON- ROPTN- | NONMON- [ N|Y [N |C
TETARY M_EM_1 | TETARY ole|o|o
TXN POST- 00_01] TXN POST- s m
ING LIST ING LIST m
o}
n
RPT | MON- ROPTX- | MON- NIY | N|C
TETARY N_EM_1 | TETARY ole|o|o
TXN POST- 00_01 TXN POST- s m
ING LIST ING LIST m
o}
n
RPT | BATCHJOB | CMN- BATCHJOB |[N|Y [N | C
SETUP BJB_EM | SETUP o|le|o|o
100 _01 s m
m
o]
n
RPT | BATCH JOB | CMN- BATCHJOB [N|Y [N |C
LOG BJB EM | LOG o|le|o|o
~100_02 s m
m
o}
n
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RPT NUMBER OUN- NUMBER N|Y|N|C
OF CREDIT | ADE_EM | OFCREDIT |o |e |0 | O
APPLICA- _100_01 | APPLICA- s m
TIONS TIONS m
ENTERED ENTERED o}
BY USER BY USER n

RPT | CREDIT OUN- CREDIT N|Y | N|C
APPLICA- ADE_EM | APPLICA- ole|o|o
TIONS _100_02 | TIONS s m
IMAGES BY IMAGES BY m
STATUS STATUS o}

n

RPT UNDER- OUNUN | UNDER- NlY | N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUS BY 11_11 STATUS BY s m
MONTH MONTH m
AND PRO- AND PRO- o]
DUCER DUCER n
(LOAN) (LOAN)

RPT UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUS BY 11_12 STATUS BY s m
MONTH MONTH m
AND AND o}
UNDER- UNDER- n
WRITER WRITER
(LOAN) (LOAN)

RPT UNDER- OUNUN | UNDER- NIY | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY 11_13 STATUS BY s m
MONTH MONTH m
(LOAN) (LOAN) o]

n

RPT UNDER- OUNUN | UNDER- NlY | N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUS BY 11_14 STATUS BY s m
UNDER- UNDER- m
WRITER WRITER 0
(LOAN) (LOAN) n

RPT UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D _EM_1 | WRITING ole|o|o
STATUS BY 12_11 STATUS BY s m
MONTH MONTH m
AND PRO- AND PRO- o}
DUCER DUCER n
(LINE) (LINE)
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RPT UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D_EM_1 | WRITING o|le|o|oO
STATUS BY 12_12 STATUS BY S m
MONTH MONTH m
AND AND o]
UNDER- UNDER- n
WRITER WRITER
(LINE) (LINE)

RPT UNDER- OUNUN | UNDER- NlY | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY 12_13 STATUS BY s m
MONTH MONTH m
(LINE) (LINE) 0

n

RPT UNDER- OUNUN | UNDER- N|Y | N|C
WRITING D _EM_1 | WRITING ole|o|o
STATUS BY 12_14 STATUS BY s m
UNDER- UNDER- m
WRITER WRITER 0
(LINE) (LINE) n

RPT UNDER- OUNUN | UNDER- NIY | N|C
WRITING D_EM_1 | WRITING o|le|o|oO
STATUSBY | 21_ M1 STATUS BY S m
MONTH MONTH m
AND PRO- AND PRO- o]
DUCER DUCER n
(LEASE) (LEASE)

RPT UNDER- OUNUN | UNDER- N|Y | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY | 21_12 STATUS BY s m
MONTH MONTH m
AND AND 0
UNDER- UNDER- n
WRITER WRITER
(LEASE) (LEASE)

RPT UNDER- OUNUN | UNDER- NIY | N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUS BY | 21_13 STATUS BY s m
MONTH MONTH m
(LEASE) (LEASE) 0

n
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RPT | UNDER- OUNUN | UNDER- Y| N|N|L
WRITING D_EM_1 | WRITING elo|o|e
STATUS BY | 21_14 STATUS BY | s a
UNDER- UNDER- s
WRITER WRITER e
(LOAN) (LOAN)

RPT | ACCOUNT OFNA- ACCOUNT Y|N|N|C
PAYABLE PY_EM_ | PAYABLE elo|o|o
(ORIGINA- 100_01 (ORIGINA- s m
TION) TION) m

o]
n

RPT | ACCOUNT OFNA- ACCOUNT N|Y | N|C
PAYABLE PY_EM_ | PAYABLE ole|o|o
(SERVIC- 100_02 (SERVIC- s m
ING) ING) m

o]
n

RPT | PRE-FUND- | OFNF- PRE-FUND- | Y [N | N |L
ING CON- ND_EM_ | ING CON- elo|o|o
TRACTS 111_01 TRACTS s a
(LOAN) (LOAN) n

RPT | FUNDED OFNF- FUNDED Y| N|N]|I
CON- ND _EM_ | CON- e|o|o|o
TRACTS 111_02 TRACTS S a
(LOAN) (LOAN) n

RPT | PRE-FUND- | OFNF- PRE-FUND- | Y [N | N |L
ING CON- ND_EM_ | ING CON- e|o|o|oO
TRACTS 112_01 TRACTS S a
(LINE) (LINE) n

RPT | FUNDED OFNF- FUNDED Y|N|N|C
CON- ND EM_ | CON- e|o|o|o
TRACTS 112_02 TRACTS s m
(LINE) (LINE) m

o}
n

RPT | PRE-FUND- | OFNF- PRE-FUND- [ Y [N|N|C
ING CON- ND_EM_ | ING CON- elo|o|o
TRACTS 121_01 TRACTS s m
(LEASE) (LEASE) m

o}
n
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RPT | FUNDED OFNF- FUNDED Y| N|N|L
CON- ND _EM_ | CON- e|o|o|o
TRACTS 121_02 TRACTS s a
(LEASE) (LEASE) n
RPT | ACCOUNT OCSAP- | ACCOUNT Y|N|NJ|L
PAYABLE P_EM_1 | PAYABLE elo|o|o
LOG BY 00_01 LOG BY S a
PRODUCER PRODUCER n
RPT | ACCOUNT OCSAPV | ACCOUNT Y|N|NJ|L
PAYABLE _EM_10 | PAYABLE elo|o|o
LOG BY 001 LOG BY S a
VENDOR VENDOR n
RPT | COLLAT- OCSAS- | COLLAT- Y| N|N|C
ERAL T EM_1 | ERAL elo|o|o
TRACKING 00_01 TRACKING | s m
LOG LOG m
o}
n
RPT | GL POST- OCSs- GL POST- Y|N|N|C
ING LOG GLI_EM | ING LOG elo|o|o
_100_01 s m
m
o}
n
RPT | PAYMENT OCSP- PAYMENT Y|N|N|C
POSTING MT_EM_ | POSTING elo|o|o
(DAILY 100_01 (DAILY s m
CASH) LOG CASH) LOG m
o]
n
RPT | PAYMENT OCSP- PAYMENT Y|N|N|C
POSTING MT_EM_ | POSTING elo|o|o
ERROR 100_02 ERROR s m
LOG LOG m
o}
n
RPT | ACCOUNT OCSAC- | ACCOUNT Y| N|NJ|L
LISTING C_EM_1 | LISTING elo|o|o
(LOAN) 11_01 (LOAN) S a
n
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RPT | EXCESS OCSP- EXCESS Y| N|N|L
PAYMENT MT_EM_ | PAYMENT elo|o|o
(REFUND) 111_03 (REFUND) s a
LOG (LOAN) LOG n

(LOAN)

RPT | PAYMENT OCSP- PAYMENT Y|N|NJ|L
HISTORY MT_EM_ | HISTORY elo|o|o
(LOAN) 111_04 (LOAN) s a

n

RPT | PAYMENT OCSP- PAYMENT Y|N|NJ|L
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 111_05 TIONS LOG | s a
(LOAN) (LOAN) n

RPT | PAYMENT OCSP- PAYMENT Y| N|N|L
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 111_06 TIONS LOG | s a
BY GL POST BY GL n
DT (LOAN) POST DT

(LOAN)

RPT | PRO- OCSPS- | PRO- Y|N|NJ|L
DUCER M_EM_1 | DUCER elo|o|o
STATE- 11_01 STATE- S a
MENT MENT n
(LOAN) (LOAN)

RPT | PRO- OCSPTX | PRO- Y|N|N]J|L
DUCER _EM_111 | DUCER elo|o|o
MONETARY | 01 MONE- S a
TXNS LOG TARY TXNS n
BY GLPOST LOG BY GL
DT (LOAN) POST DT

(LOAN)

RPT | SCHED- 0OCSS- SCHED- Y| N|N|L
ULED FOR CH_EM_ | ULED FOR elo|o|o
CHAR- 111_01 CHAR- s a
GEOFF GEOFF n
ACCOUNTS ACCOUNTS
LOG (LOAN) LOG

(LOAN)

RPT | AMOR- OCSTA AMOR- Y|N|NJ|L
TIZEDTXNS | M_EM_1 | TIZED e|o|o|oO
LOG BY GL 11_01 TXNS LOG s a
POST DT BY GL n
(LOAN) POST DT

(LOAN)
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RPT | SCHED- OCSTER | SCHED- Y| N|N|L
ULED FOR _EM_111 | ULED FOR elo|o|o
TERMINA- _01 TERMINA- s a
TION TION n
ACCOUNTS ACCOUNTS
LOG (LOAN) LOG
(LOAN)
RPT | MONETARY | OCSTX- | MONE- Y| N|N|L
TXNS LOG N_EM_1 | TARYTXNS |e |o |0 | O
BY GLPOST | 11_01 LOGBYGL |s a
DT (LOAN) POST DT n
(LOAN)
RPT | ACCOUNT OCSAC- | ACCOUNT Y|N|N]J|L
LISTING C_EM_1 | LISTING elo|o|o
(LINE) 12_01 (LINE) S a
n
RPT | ADVANCE OCSAD- | ADVANCE Y| N|N|L
POSTING V_EM_1 | POSTING elo|o|o
LOG (LINE) 12_01 LOG (LINE) | s a
n
RPT | ADVANCE OCSAD- | ADVANCE Y| N|N|L
POSTING V_EM_1 | POSTING elo|o|o
ERROR 12_02 ERROR S a
LOG (LINE) LOG (LINE) n
RPT | PAYMENT OCSP- PAYMENT Y| N|N|L
HISTORY MT_EM_ | HISTORY elo|o|o
(LINE) 112_04 (LINE) s a
n
RPT | PAYMENT OCSP- PAYMENT Y| N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 112_05 TIONS LOG | s m
(LINE) (LINE) m
o}
n
RPT | PAYMENT OCSP- PAYMENT Y|N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 112_06 TIONS LOG | s m
BY GLPOST BY GL m
DT (LINE) POST DT o}
(LINE) n
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RPT | SCHED- OCSS- SCHED- Y| N|N|C
ULED FOR CH_EM_ | ULED FOR elo|o|o
CHAR- 112_01 CHAR- s m
GEOFF GEOFF m
ACCOUNTS ACCOUNTS o}
LOG (LINE) LOG (LINE) n
RPT | AMOR- OCSTA AMOR- Y|N|N|C
TIZEDTXNS | M_EM 1 | TIZED elo|o|o
LOG BY GL 12 01 TXNS LOG s m
POST DT BY GL m
(LINE) POST DT 0
(LINE) n
RPT | SCHED- OCSTER | SCHED- Y|N|N|C
ULED FOR _EM_11 ULED FOR elo|o|o
TERMINA- 2 01 TERMINA- s m
TION TION m
ACCOUNTS ACCOUNTS o]
LOG (LINE) LOG (LINE) n
RPT MONETARY | OCSTX- | MONE- Y|N|N|C
TXNS LOG N_EM 1 | TARYTXNS |e |o |0 | O
BY GLPOST | 12_01 LOGBYGL |s m
DT (LINE) POST DT m
(LINE) o}
n
RPT | ACCOUNT OCSAC- | ACCOUNT Y|N|N|C
LISTING C_EM_1 | LISTING elo|o|o
(LEASE) 21_01 (LEASE) s m
m
o}
n
RPT PAYMENT OCSP- PAYMENT Y|N|N|C
HISTORY MT_EM_ | HISTORY elo|o|o
(LEASE) 121_04 (LEASE) s m
m
o
n
RPT PAYMENT OCSP- PAYMENT Y|N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG 121_05 TIONS LOG | s m
(LEASE) (LEASE) m
o}
n
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RPT PAYMENT OCSP- PAYMENT Y| N|N|C
ALLOCA- MT_EM_ | ALLOCA- e|o|o|oO
TIONS LOG 121_06 TIONS LOG | s m
BY GLPOST BY GL m
DT (LEASE) POST DT o]
(LEASE) n
RPT | SCHED- OCSS- SCHED- Y|N|N|C
ULED FOR CH_EM_ | ULED FOR elo|o|o
CHAR- 121_01 CHAR- s m
GEOFF GEOFF m
ACCOUNTS ACCOUNTS o}
LOG LOG n
(LEASE) (LEASE)
RPT | AMOR- OCSTA AMOR- Y|N|N|C
TIZEDTXNS | M_EM_1 | TIZED elo|o|o
LOG BY GL 21_01 TXNS LOG s m
POST DT BY GL m
(LEASE) POST DT 0
(LEASE) n
RPT | SCHED- OCSTER | SCHED- Y|N|N|C
ULED FOR _EM_12 | ULED FOR e|o|o|oO
TERMINA- 101 TERMINA- S m
TION TION m
ACCOUNTS ACCOUNTS o]
LOG LOG n
(LEASE) (LEASE)
RPT MONETARY | OCSTX- | MONE- Y|N|N|C
TXNS LOG N EM 1 | TARYTXNS |e |o |0 |0
BY GLPOST | 21_01 LOGBYGL |s m
DT (LEASE) POST DT m
(LEASE) o]
n
RPT BANK- OCOBN | BANK- Y|N|N|C
RUPTCY K EM_1 | RUPTCY elo|o|o
LOG 00_01 LOG S m
m
o
n
RPT | COLLEC- OCO- COLLEC- NIN|Y |C
TOR ACTIV- | COL_EM | TORACTIV- |[o |0 | e | O
ITY _100_01 | ITY s |m
(DETAILED) (DETAILED) m
LOG LOG o]
n
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RPT | COLLEC- OCO- COLLEC- NIN|Y|C
TOR PRO- COL_EM | TOR PRO- o|lol|e|o
DUCTIVITY | _100_02 | DUCTIVITY s |m
BY QUEUE BY QUEUE m
o}
n
RPT | DELIN- 0OCO- DELIN- N{N|Y | C
QUENCY COL_EM | QUENCY o|lo|e|o
ANALYSIS _100_03 | ANALYSIS s |m
BY PRO- BY PRO- m
DUCER DUCER o}
n
RPT | DELIN- OCO- DELIN- NI{N|Y | C
QUENCY COL_EM | QUENCY o|o|e|o
ANALYSIS _100_04 | ANALYSIS s |m
BY CREDIT BY CREDIT m
GRADE GRADE 0
n
RPT | DELIN- OCO- DELIN- NIN|Y|C
QUENCY COL_EM | QUENCY o|lol|e|o
ANALYSIS _100_05 | ANALYSIS s |m
BY STATE BY STATE m
o}
n
RPT | PAYMENT OCO- PAYMENT N{N|Y |C
PROMISE COL_EM | PROMISE o|lol|e|o
LOG _100_06 | LOG s |m
m
o}
n
RPT | COLLEC- OCO- COLLEC- NI{N|Y |C
TORACTIV- | COL_EM | TORACTIV- |o |o |e |0
ITY LOG _100_07 | ITYLOG s |m
m
o
n
RPT | DEFI- OCODE- | DEFI- NIN|Y|C
CIENCY F_EM_1 | CIENCY o|lol|e|o
LOG 00_01 LOG s |m
m
o}
n
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RPT | DELIN- OCODL DELIN- NIN|Y |C
QUENCY Q_EM_1 | QUENCY o|lol|e|o
LOG 00_01 LOG s |m
m
o}
n
RPT | REPOSSES- | OCORE | REPOS- NIN|Y |C
SION/FORE- | P_EM_1 | SESSION/ o|lol|e|o
CLOSURE 00_01 FORECLO- s |m
LOG SURE LOG m
o]
n
RPT | NON MONE- | OCOTN- | NONMON- |[N|N|Y |C
TARY TXNS | M_EM_1 | ETARY o|o|e|o
LOG 00_01 TXNS LOG s |m
m
o]
n
RPT | VENDOR OCOVIN | VENDOR NIN|Y|C
INVOICE _EM_10 | INVOICE o|lol|e|o
LOG 0_01 LOG s |m
m
o}
n
RPT | VENDOR OCOVN | VENDOR N{N|Y | C
WORK A_EM_1 | WORK o|o|e|oO
ORDER 00_01 ORDER s |m
LOG LOG m
o}
n
RPT | POOL OCS- POOL N|IY|N|C
DELIN- SEC_EM | DELIN- ole|o|o
QUENCY _111_01 | QUENCY s m
SUMMARY SUMMARY m
(LOAN) (LOAN) o]
n
RPT | POOL 0OCSs- POOL N|Y|N|C
DEFAULTS SEC_EM | DEFAULTS ole|o|o
(NON LIQUI- | _111_02 | (NON LIQ- S m
DATED) UIDATED) m
(LOAN) (LOAN) o}
n
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RPT | POOL PAY- 0OCS- POOLPAY- [N|Y |N|C
OFFS SEC _EM | OFFS o|le|o|o
(LOAN) _111_03 | (LOAN) s m
m
o}
n
RPT | POOL OCSs- POOL N|Y|N|C
RECOVERY | SEC_EM | RECOV- ole|o|o
(LOAN) _111_04 | ERY (LOAN) s m
m
o]
n
RPT | POOL OCS- POOL N|IY|N|C
DELIN- SEC_EM | DELIN- ole|o|o
QUENCY _111_05 | QUENCY s m
(LOAN) (LOAN) m
o]
n
RPT | POOL 0OCSs- POOL N|Y|N|C
REPUR- SEC_EM | REPUR- olel|o|o
CHASED _111_06 | CHASED s m
ACCOUNTS ACCOUNTS m
(LOAN) (LOAN) o}
n
RPT | POOL OCSs- POOL N|Y|N|C
MONTHLY SEC_EM | MONTHLY ole|o|o
ACTIVITY _111_07 | ACTIVITY s m
(LOAN) (LOAN) m
o}
n
RPT | POOL LIQ- OCS- POOL LIQ- NlY | N|C
UIDATED SEC_EM | UIDATED ole|o|o
CON- _111_08 | CON- s m
TRACTS TRACTS m
(LOAN) (LOAN) o
n
RPT | POOLTXNS | OCS- POOLTXNS [N|Y [N |C
LOG BY GL SEC_EM | LOGBYGL |o|e |0 |0
POST DT _111_09 | POST DT s m
(LOAN) (LOAN) m
o}
n
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SET- | Realtime QCSPR Real time N |Y | Y | C | This batch job pro-
QRT | Queues pro- | C_B- Queuespro- | 0 | e | e | O | cesses queues
cessing J_100_0 | cessing s | s | m| marked as real
2 m | time based on
o | refresh frequency
n | setup in the job
set.
TAM | MONTH TPR- MONTH N|Y|N|C
END COM- COM_B- | END COM- olel|o|o
PENSATION | J 100 0 | PENSA- s m
DISBURSE- | 1 TION m
MENT PRO- DISBURSE- o]
CESSING MENT PRO- n
CESSING
TAM | PRO- TPRPS- | PRO- N|Y|N|C
DUCER G _B- DUCER o|le|o|o
STATE- J_100_0 | STATE- s m
MENTS 1 MENTS m
o]
n
TAM | PRO- TPRSTA | PRO- N|Y|N|C
DUCER _BJ_100 | DUCER ole|o|o
STATUS _01 STATUS s m
CHANGE CHANGE m
o}
n
TPE Escrow Anal- | TXNCH- | CHAR- N [Y | N | C | This package con-
ysis & Dis- G _B- GEOFF o0 | e | o | o | tains procedures
bursements J_100_0 | PROCESS- s m | related to Batch
2 ING FOR m | Job for chargeoff
ACTIVE 0 | processing
ACCOUNTS n
ESC | ESCROW TESAN- | ESCROW N [Y | N | C | This package con-
ANALYSIS L_B- ANALYSIS o | e | o | o | tains procedures
POSTING J 100 0 | POSTING s m | related to Batch
1 m | Job for escrow
o | analysis process-
n | ing
ESC | CREATE TESAN- | CREATE N | Y | N | C | This package con-
BATCHES L B- BATCHES o | e | o | o | tains procedures
FOR CUS- J 100 0 | FOR CUS- s m | related to Batch
TOMER 2 TOMER m | Job for escrow
REFUND REFUND o | analysis process-
REQUESTS REQUESTS n | ing
2-78 ORACLE




& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
ESC | COMPUTE TESAN- | COMPUTE N|Y|N|C
CONTROLS | L _B- CON- o|le|o|o
FOR CUS- J_100_0 | TROLSFOR s m
TOMER 4 CUS- m
REFUND TOMER o}
REQUEST REFUND n
BATCHES REQUEST
BATCHES
ESC | ESCROW TESAN- | ESCROW NlY | N|C
COMPLI- L_B- COMPLI- o|le|o|oO
ANCE J_100_0 | ANCE s m
CHECKING 5 CHECKING m
o}
n
ESC | CREATE TESDS- | CREATE NlY | N|C
PAYABLE B_B- PAYABLE ole|o|o
REQUISI- J_100_0 | REQUISI- s m
TIONS 1 TIONS m
FROM FROM o]
APPROVED APPROVED n
DISBURSE- DISBURSE-
MENT MENT
REQUESTS REQUESTS
PUR | ARCHIVE PACARC | ARCHIVE N|Y|N|C
ACCOUNT _BJ_100 | ACCOUNT olel|o|o
DATATO _01 DATATO s m
OTABLES OTABLES m
o}
n
EVE BATCH EVBAC- | BATCH Y
EVENTS C _B- EVENTS e
FOR J_100_0 | FOR S
ACCOUNTS | 1 ACCOUNTS
EVE BATCH EVBAP- | BATCH Y
EVENTS P_B- EVENTS e
FOR APPLI- | J 100 0 | FORAPPLI- | s
CATIONS 1 CATIONS
EVE MAIN EVB- MAIN Y
BATCH JOB | PRC_B- | BATCH JOB e
FORBATCH | J_100_0 | FORBATCH s
EVENTS 1 EVENTS
PROCESS- PROCESS-
ING ING
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ODD | BATCHJOB | CBUUT- | BATCHJOB | Y
2 TO GENER- | L_B- TO GENER- | e
ATE METRO | J_100_0 | ATEMETRO | s
2 DATA 2 2 DATA
ODD | BATCHJOB | CBUUT- | BATCHJOB |Y
2 FOR CRE- L_B- FOR CRE- e
ATING J_100_0 | ATING S
METRO 2 3 METRO 2
DATA FILE DATA FILE
ODD | THIRD ACT- THIRD Y
2 PARTY ACH | PRC_B- | PARTY ACH e
PROCESS- J_100_0 | PROCESS- S
ING 1 ING
ODD | THIRD OBI- CREATE Y This process pulls
2 PARTY OUT- | PRC_B- | THIRD e the customer
PUT DATA J_100_ 0 | PARTY s account details
DUMP SER- | 1 CUS- shared in input
VICING TOMER data files for pro-
FILE cessing.
ESC | JOBTO OED- JOB TO Y
GENERATE | PRC_B- | GENERATE e
ESCROW J_100_0 | ESCROW S
DISCLO- 1 DISCLO-
SURE SURE
STATEMENT STATE-
MENT
EDF | ADRFILE EDFADR | ADR FILE Y
_BJ_100 e
01 s
EDF IVR FILE EDFIVR | IVRFILE Y
_BJ_100 e
01 s
TPE CONTRAC- TXN- CONTRAC- Y
TUAL PRO- PRM_B- | TUAL PRO- e
MOTION J_100_0 | MOTION S
CANCEL 4 CANCEL _
PROCESS- PROCESS- _
ING ING
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TPE RATE TXN- RATE Y
CHANGE RAT_B- CHANGE e
PROCESS- J_100_0 | PROCESS- S
ING FOR 2 ING FOR
BACK- BACK-
DATED DATED
INDEXES INDEXES
RDB | LOAD RACD- LOAD Y
1 ACCOUNT MP_B- ACCOUNT e
RELATED J_100_0 | RELATED s
DATA INTO 1 DATA INTO
T TABLES T TABLES
TPE EXPIRED TXNINS | EXPIRED Y
INSUR- _BJ_100 | INSUR- e
ANCE PRO- | 01 ANCE PRO- s
CESSING CESSING
ADT UPDATE ADT- UPDATE Y
ROWID IN PRC_B- | ROWID IN e
AUDIT J_100_0 | AUDIT S
TABLE (RUN | 1 TABLE
THIS JOB (RUN THIS
AFTER JOB AFTER
EXPORT- EXPORT-
IMPORT OF IMPORT OF
TABLES) TABLES)
RDB | LOAD RIND- LOAD Y
1 INSUR- MP_B- INSUR- e
ANCE DATA | J_100_0 | ANCE DATA s
TO T- 1 TO T-
TABLES TABLES
AGS | SALE LEAD | AGS- SALE LEAD | Y
AGING SAL_B- AGING e
J_100_0 S
1
BOD | PROCESS JOB- PROCESS Y
PARKED BOD_B- | PARKED e
TRANSAC- J_000_0 | TRANSAC- S
TIONS 2 TIONS
BOD | MARK SYS- | JOB- MARK SYS- Y
TEM FOR BOD B- | TEM FOR e
BEGINING J_000_0 | BEGINING s
OF DAY 1 OF DAY
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EOD | SET SYS- JOBEOD | SET SYS- Y
TEM MODE | _BJ_000 | TEM MODE e
TO END-OF- | _01 TO END- S
DAY OF-DAY
ACR | DAILYTRIAL | TABAC- DAILY Y
BALANCE C _B- TRIAL BAL- e
DATA J_100_0 | ANCE DATA s
1 GENERA-
TION
LTR2 | RATE LCS- RATE Y
CHANGE RAT_B- CHANGE e
PRE-INTI- J_100_0 | PRE-INTI- s
MATION 1 MATION
LETTER LETTER
BLK BULK BLK- BULK Y
UPLOAD PRP_B- UPLOAD e
FOR PRIC- J_100_0 | FOR PRIC- S
ING SETUP 1 ING SETUP
BLK BULK BLK- BULK c
UPLOAD GLS B- UPLOAD 0
FOR GL J 100 0 | FORGL m
ATTRI- 1 ATTRI- m
BUTES BUTES o}
n
BLK BULK BLK- BULK c
UPLOAD GLS B- UPLOAD 0
FOR GL J_100_ 0 | FORGL m
TRANSLA- 2 TRANSLA- m
TION TION DEFI- 0
NITION n
BLK BULK BLK- BULK c
UPLOAD GLS_B- UPLOAD o]
FOR GL J_100_0 | FORGL m
TRANSAC- 3 TRANSAC- m
TIONTYPES TION o]
TYPES n
DETAILS
BLK BULK BLK- BULK c
UPLOAD GLS B- UPLOAD 0
FOR GL J 100 0 | FORGL m
TRANSAC- 4 TRANSAC- m
TION LINKS TION LINKS 0
n
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ODD | RATE OLSRAT | RATE Y
2 CHANGE _BJ_100 | CHANGE e
LETTER _01 LETTER S
FILE FILE CRE-
ATION
TPE EXPIRED TXN- EXPIRED Y
DRAW DRW_B- | DRAW e
PERIOD J 111 0 | PERIOD s
PROCESS- 1 PROCESS-
ING (STAGE ING (STAGE
FUNDED FUNDED
LOANS) LOANS)
ODD | DEALER OPSSB- | DEALER c
2 SUBVEN- V_B- SUBVEN- 0
TION J_100_0 | TION m
STATE- 1 STATE- m
MENTS MENTS 0
GENERA- n
TION
TAM | SUBVEN- TPRSB- | SUBVEN- c
TION V_B- TION o]
RECEIV- J_100_0 | RECEIV- m
ABLE PRO- 1 ABLE PRO- m
CESSING CESSING o]
(PAY AS GO) (PAY AS n
GO)
ODD | PRO- OPCPR PRO- c
2 DUCER C _B- DUCER o]
CHECK J_100_0 | CHECK m
PRINT 1 PRINT m
GENERA- o]
TION n
BSR | BEHAV- BSR- BEHAV- y
IORAL PRC_B- | IORAL e
SCORING J_100_0 | SCORING S
1
AGE | TRANSAC- TXNAGE | TRANSAC- y
TION IN _BJ_100 | TIONIN e
WAITING _01 WAITING S
FOR FOR
APPROVAL APPROVAL
AGING AGING
PROCESS
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ACR | PREPARE TXNA- PREPARE y
BATCH CR_B- BATCH e
DATA FOR J_100_0 | DATA FOR S
INTEREST 2 INTEREST
ACCRUAL ACCRUAL
AND DELIN- AND DELIN-
QUENCY QUENCY
PROCESS-
ING
PDC | POST PDCPR POST y
DATED C_B- DATED e
CHECKS J_100_0 | CHECKS S
1
PDC | PENDING PDCPN PENDING y
PDC D_B- PDC PRO- e
J_100_0 | CESSING S
1
LTR2 | PDC LCSPD- | PDC y
RENEWAL C_B- RENEWAL e
LETTER J_100_0 | LETTER S
1 GENERA-
TION
DOT | APPLICA- DOL- APPLICA- Y
TION DOCU- | PRC_B- | TION DOC- | e
MENT LOAD | J 000 0 | UMENT S
2 LOAD
ODD | ONE TIME OLSPD- | ONE TIME Y
2 ACH POST P_B- ACH POST e
DATED PAY- | J_100_0 | DATED S
MENT LET- 1 PAYMENT
TER LETTER
PROCESS-
ING
WFP | BILLING WTX- BILLING Y
BIL_B- PROCESS- e
J_132_0 | ING S
1
WFP | DELIN- WTX- DELIN- Y
QUENCY DLQ_B- | QUENCY e
J 132 0 | PROCESS- s
1 ING
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WFP | LATE WTX- LATE Y
CHARGE LTC_B- CHARGE e
J_132_0 | ASSESS- S
1 MENT
WFP | STATEMENT | WTXPS- | STATE- Y
G_B- MENT GEN- e
J 132 0 | ERATION s
1
WFP | RATE WTX- RATE Y
CHANGE RAT_B- CHANGE e
J_132_0 | PROCESS- S
1 ING
WFP | TERMINA- WTX- TERMINA- Y
TION TIP_B- TION PRO- e
J_132_0 | CESSING S
1
TPE PERIODIC TXNPM- | PERIODIC
MAIN- F_B- MAIN-
TAINENCE J_100_0 | TAINENCE
FEE 1 FEE PRO-
CESSING
WFP | UNIT WUP- UNIT c
UPLOAD PRC_B- | UPLOAD 0
J 132 0 m
1 m
o]
n
ODD | BATCHJOB | CBUUT- | BATCH JOB
2 FOR L_B- FOR
MONTHLY J_100_0 | MONTHLY
HANDSOFF | 4 HAND-
FILE FOR SOFF FILE
SIMAH FOR SIMAH
PUR | PURGE ALL | PTTPRC | PURGE ALL c
PTT TABLES | _BJ 100 | PTT o}
_01 TABLES m
o]
n
TPE BATCH JOB | TXN- BATCH JOB y
FOR SET- MAC_B- | FOR SET- e
TING J_100_0 | TING S
MATURED 1 MATURED
ACCOUNT ACCOUNT
CONDITION CONDITION
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TPE NON TXNRF- | NON c
REFUND GL | D_B- REFUND o]
J_100_0 | GL PRO- m
1 CESSING m
o]
n
TPE PAYMENT TXNPA- PAYMENT y
ARRANGE- P_B- ARRANGE- e
MENT J_100_0 | MENT PRO- s
1 CESSING
TPE DELAY FEE | TXND- DELAY FEE y
LY B- PROCESS- e
J_100_0 | ING S
1
TPE STATE- TXNST- STATE- y
MENT PAST | M_B- MENT PAST e
MATURITY J_100_0 | MATURITY S
1 PROCESS-
ING
TPE BLACK VEVBB- | BLACK c
BOOK K _B- BOOK o]
INTERFACE | J 100_0 | INTERFACE m
1 m
o]
n
LBT BULK NSF TXNNS- | BULK NSF
PAYMENT F_B- PAYMENT
REVER- J_100_0 | REVER-
SALS 1 SALS
ACR | STOP TXNA- STOP y
INTEREST CR_B- INTEREST e
ACCRUAL J_100_0 | ACCRUAL S
3 PROCESS-
ING
QRT | CUSTOMER | QCSPR CUS- y
SERVICE C _B- TOMER e
REAL TIME J _100_0 | SERVICE S
QUEUE 2 REAL TIME
QUEUE
PROCESS-
ING
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ODD | OUT- OCP- OUT- y
2 BOUND PRC_B- | BOUND e
CUSTOMER | J_100_0 | CUS- s
EXTRACTS 1 TOMER
TO PAY- EXTRACTS
MENT TO PAY-
AGENCIES MENT
AGENCIES
IFP OFFLINE ICAPRC | OFFLINE y
CALL _BJ 100 | CALL e
ACTIVITY _01 ACTIVITY s
POSTING POSTING
ACR | RE-START TXNA- RE-START y
INTEREST CR_B- INTEREST e
ACCRUAL J_100_0 | ACCRUAL s
4
IFP UPLOAD ITUPRC | UPLOAD y
TRANSAC- _BJ_100 | TRANSAC- e
TIONS _01 TIONS s
IFP POST ITUPRC | POST y
UPLOADED | BJ 100 | UPLOADED e
TRANSAC- _02 TRANSAC- s
TIONS TIONS
IFP INPUT FILE ICE- CUR- Y |Y | Y| C | This process
PROCESS- PRC_B- | RENCY e | e | e | o | extracts currency
ING - CUR- J_100_0 | EXCHANGE | s | s | s | m | exchange rates
RENCY 1 RATE FILE m | from desired
EXCHANGE UPLOAD 0 | source at sched-
RATE FILE n | uled intervals.
UPLOAD
IFP INPUT FILE IDDPRC | INPUT Y This process
PROCESS- _BJ 000 | DATA e updates customer
ING - INPUT | 01 INSERTION s account informa-
DATA tion corresponding
INSERTION to the details
received from
external system.
Ex: Bankruptcy
details in External
Interface screen or
Cure Letter details
in Account Infor-
mation screen.
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IFP INPUT FILE IPIPRC_ | PIINFRO- Y | Y| Y| C| This process
PROCESS- BJ 100 _ | MATION 0 | uploads input file
ING 01 FILE m | with PII data into
UPLOAD m | the data masking
PROCESS- 0 | screen.
ING n
PUR | ARCHIVE PJR- PURGE Y |Y|Y | C| This process
PURGE JOB | PAC_B- ACCOUNTS 0 | purges accounts
SET J_100_0 | DATA m | data in archival
1 m | tables based on
0 | the days defined in
n | system parameter
PAC_PURGE_-
DAYS.
PUR | ARCHIVE PJRPA- PURGE Y |Y|Y | C| This process
PURGE JOB | P_B- APPLICA- 0 | purges application
SET J 100 _0 | TION DATA m | data in archival
1 m | tables based on
0 | the days defined in
n | system parameter
PAC_PURGE_-
DAYS.
PUR | ARCHIVE PJRP- PURGEGL |Y |Y |Y | C | This process
PURGE JOB | GL_B- TXNS DATA 0 | purges general
SET J 100 0 m | ledger transaction
1 m | data in archival
o | tables based on
n | the days defined in
system parameter
PAC_PURGE_-
DAYS.
PUR | ARCHIVE PJRP- PURGE Y | Y |Y | C| This process
PURGE JOB | PA B- POOLS 0 | purges pools and
SET J_100_0 | DATA m | its transactions
1 m | data in archival
o | tables based on
n | the days defined in
system parameter
PAC_PURGE_-
DAYS.
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PUR | ARCHIVE PJRP- PURGE Y | Y| Y| C| This process
PURGE JOB | PX B- PRO- 0 | purges producer
SET J _100_0 | DUCER m | transaction data in
1 TXNS DATA m | archival tables
o0 | based on the days
n | defined in system
parameter
PAC_PURGE_-
DAYS.
PUR | ARCHIVE PJRPTX- | PURGE Y |Y | Y| C | This process
PURGE JOB | _BJ 100 | TXNS DATA 0 | purges account
SET _01 m | transaction data in
m | archival tables
o0 | based on the days
n | defined in system
parameter
PAC_PURGE_-
DAYS.
PUR | ARCHIVE PJRPVA | PURGE Y |Y | Y| C | This process
PURGE JOB | BJ 100 | VENDOR 0 | purges vendor
SET _01 ASSIGN- m | assignment data in
MENTS m | archival tables
DATA o0 | based on the days
n | defined in system

parameter
PAC_PURGE_-
DAYS.

Producer Cycles

The Producer setup screen enables you to define the dealer or producer status cycle. This
tells the system which status a producer can cycle through. (This information is recorded in

the Status field on the Producers section of the Producer setup screen.

For example,
ACTIVE

| TEMPORARY | [INACTIVE]

The Producer Setup screen also defines the user responsibilities capable of changing the
producer status.

Note
The system enables only producers/dealers with a status of ACTIVE to fund contracts.
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To set up Producer Cycles

1. On the Oracle Financial Services Lending and Leasing home screen, clickSetup >
Setup > Administration > System > Producer Cycles.

2. The system displays the Producer Cycles screen. The producer cycle screen contains
three section:

e Cycle Definition
e Current/Next Status
e Status Change Responsibilities

ORACLE’
Financial Services Lending and Leasing
Close
> DashBoard it B
> Origination -
X Cycle Definition
() View = Fomat > B} Freeze [fiDetach Wrap )
> Collections Cyde Type
> WFP FRO PRODUCER CYCLE
 Tools
Setup Current/ Next Status dpadd || [Fvew || o udt
Setup = View v Format v Freeze i Detach ol Wrap o]
Administration it Next Code
Systam R ACTIVE
System Parameter o NACTIVE
Lookups ACTIVE TEMPORARY
User Defined Tables A ACTIVE
Audit Tables NACTIVE INACTIVE
User Defined Defaults INACTIVE TEMPORARY
Transaction Codes |2 TEMPORARY ACTIVE
Data Fies TEMPORARY INACTIVE
Dedupe TEMPORARY Revporsay
Searitization b
Events
Kas Status Change Responsibilities Fadd | FEt | [Huew | o audt
Producer Cydes
e View v Format~ [} Freeze EfiDetach wap
Colicton Cydes Responsbity )
Reports AL ¥
Error Messages
Translat oy
Userra”“ s Status Change Responsibiiities
— [ ssveandstay | [ saveandRetum | {aRetin
Comparies
Access * Responsbilty AL [=]
Users * Alowed Ind [{]
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bark Detals
Check Details
Standard Payees
Currendies =

3. Inthe Cycle Definitions section, you can view the following information.

Field: View This:
Cycle Displays the cycle name.
Type Displays the cycle type.

4. In the Cycle/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Current Code Select the current code from which you need to perform transition,
from the drop-down list.

Next Code Select the code to which you need to perform transition, from the
drop-down list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Status Change Responsibilities section, perform any of the Basic Operations
mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Responsibility Code Select the responsibility that will be capable of executing this
transition, from the drop-down list.

Allowed Indicator Check this box to enable the responsibility to execute the
transition.

2.11 Vendors

During the life of an account, a financial institution might require the use of specialized
services of a vendor for various purposes; for example, repossessing a vehicle, retaining an
attorney for bankruptcy court proceedings, or making field calls. With the system’s Vendors
screen, you can define the following:

e Cycles
e Vendor Services
e Vendor Fees

2111 Cycles Tab

The Cycle link allows you to define the various vendor cycles and the responsibilities that can
gain access to the various transactions in each cycle. The different categories are:

e You can define vendor status cycle and restrict the status change based on

responsibility.
lacTive == NACTIVE

e You can define vendor invoice status cycle and restrict the status change based on
responsibility.

By —S|OFEN —=lclosE

VoD

e You can define vendor assignment status cycle and restrict the status change based on
responsibility.

IEw — 1 ——COMPLETED ———>|CLOSE

WOID

e You can define vendor invoice payment status cycle and restrict the status change
based on responsibility.

FHEW CFERN CLOSE

oI

1. Click Setup > Setup > Administration > System > Vendors > Cycles. The screen
contains three sections:

To set up the vendor cycles

e Status Cycle
e Current/Next Status
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e Status Change Responsibilities

ORACLE SHEKAR 1 Signout
Financial Services Lending and Leasing

@@ Vendors .
Status Cycle
View = Formatv [ Freeze  pfiDetach rap oh)
> DashBoard
Cyde Type Order Type
> Origination %
> Serviding VEN_REPO_ALL VENDOR. ASSIGNMENT STATUS CYCLE AL 3
Gk VEN_COLLECTION VENDOR ASSIGNMENT STATUS CYCLE COLLECTION
3 VEN_CYC_2 VENDOR ASSIGNMENT STATUS CYCLE IMPOUND INVOLUNTARY REPOSSESSION
> wr VEN_REPO VENDOR ASSIGNMENT STATUS CYCLE REPOSSESSION -
 Tools
Setup Status Cyde
St e [ saveandadd || [ saveandstsy | [ saveandReturn | (aRetum
System Parameter 1
e L e Type VENDOR ASSIGNMENT STATUS CYCLE s s (A = ||
User Defined Tables i
Audit Tebles Current/ Next Status A add | ZEd 7 hud
User Defined Defaults Vew Fomat~ B | [Fece GHDemd | Jwen | @)
T'E”s"‘““”" o Current Code: NextCode Action Code Result Code
Taipis No data to display.
Dedupe
Seauritization
ks Status Change Responsibilities dradd | P || Efven | o Audt
Batch Jobs s e iy 2 e @
- v Freeze  iDetad rep
Producer Cydes s 4
SR Responsbilty Allowed
Collection Cycles o] ||| Hesamindeay. L

2. Inthe Status Cycle section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields are given below:

Field: View this:

Cycle Specify the status cycle for the vendor.

Type Displays the type of vendor assignment status cycle.

Order Type Select the work order type for the vendor from the drop-down
list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Current/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Current Code Select the current code from which you need to transition,
from the drop-down list

Next Code Select the Next status code to which you need to transition,
from the drop-down list

Action Code Select the call activity action code from the drop down list.

Result Code Depending on the call activity action code, you can select the
result code from the drop down list.

Note

When there is a change in status from ‘Current’ to ‘Next’, system posts respective call ac-
tivity on the account based on selected Action and Result code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
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6. Inthe Status Change Responsibilities section, perform any of the Basic Operations
mentioned in Navigation chapter:

A brief description of the fields is given below:

Field: Do this:

Allowed Select ‘Yes’ to enable the responsibility to execute the transition and
‘No’ to disable

Responsibility Select the responsibility that will be capable of executing this transition
(from current code to the next code), from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Vendor Services Tab

The Vendor Service screen enables you to establish the links between the service type,
vendor group, and the work order type. It records which vendor groups can provide which type
of services and which service type belongs to which work order types.

For each service type (Service Type field), there can be multiple vendor groups and/or
multiple work order type(s).Each vendor (Group field) can belong to one or multiple vendor

group(s).
1. Click Setup > Setup > Administration > System > Vendors > Vendor Services. The
screen contains three sections:
e Services
e Vendor Groups
e Work Order Types

opacse

Financial Services Lending and Leasing

i Vendors [
> Origination Cycles Vendor Services
 Servicing
> Collections Serics
— View Fomatv [ [Freez gfvench dwap @)
£ Senice e Enbled
> Tools ATTORNEY FEE ¥
Setup TRANSPORT OF UNIT Y
AUCTION/SALE CHARGES Y
Setup SEARCH BIY/DHV RECORDS ¥
Adniristation B0ND CHARGES " -
System
System Parameter
Loig Vendor Groups opadd | [ view | of Audt
User Defined Tables
Audit Tables Vien Fomat v [} Freeze i Detach wep @)
User Defined Defaults Gioup
Transaction Codes
Data Fies | | ATTOREY
Dedupe BANKRUPTCY TRUSTEE
Securitization
Events Vendor Groups
Eatch Jobs [ saeandadd | [ Saveand stay | [ smve andRetum | Gapetum
Producer Cycles
Vendors *Grap 7
Collection Cydles
Reports
Error Messages Work Order Types Puid || At | [Fview | o auit
Translations Views Fomatv By [Freeze  Detach wep @
User ‘Work Order Type Transaction
Oietanm) BANKRLPTCY LEGAL BAKRUPTCY EXPENGES
Companies COLLECTION REPOSSESSION EXPENSES
Access RECOVERY REPOSSESSION EXPENSES
Users
Credit Bureau
Correspondence
General Ledger b
Aueiee
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2. Inthe Services section, you can view the following information:

Field: View this:
Service Type | Displays the service type.
Enabled Displays if the service is enabled or not.

3. Inthe Vendor Groups section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Group

Select the vendor group from the drop-down list.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Work Order Types section, perform any of the Basic Operations mentioned in
Navigation chapter:

A brief description of the fields is given below:

Field:

Do this:

Work Order Type Select the work order type from the drop-down list.

Transaction

Select the associated transaction for the service type from the
drop-down list.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Vendor Fees Tab

The Vendor Fees tab allows you to define fee structure (with specific amount) for each service
offered by specific vendor. The defined fees is auto populated as the estimated cost of the
assignment when a specific vendor and service is selected during work order creation.
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To define vendor fees

1. Click Setup > Setup > Administration > System > Vendors > Vendor Fees. The

screen consists of Vendor Service Fee Definition section with option to define vendor

fees.
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In the Vendor Service Fee Definition section, perform any of the Basic Operations

mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Start Dt System defaults the current date as the start date. You can modify the
same to a future date using the adjoining calendar.

End Dt Specify the end date from the adjoining Calendar.

Enabled Select the check box to enable the fee structure.

Amt Specify the amount charged by the vendor for a specific service.

Selection Criteria

Vendor Select the vendor group from the drop-down list. You can also select

Group ‘ALL’ (default option) if the fee structure is applicable across vendor
groups.

Vendor Select the vendor from the drop-down list. You can also select ‘ALL’ if
you have selected the ‘Vendor Group’ as ‘ALL’. The list is sorted
depending on the vendor group selected.

Services Select the service from the drop-down list. The list is sorted depending
on the services offered by the selected Vendor.

Company System defaults this value based on the vendor selected. You can
also select the required company from the drop-down list.

Branch System defaults this value based on the vendor selected. You can

also select the required branch from the drop-down list.
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Field: Do this:

Vendor System defaults this value based on the vendor selected. You can
Channel also select the required vendor channel from the drop-down list.
State System defaults the state in which the vendor operates. You can also

select the state from the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.11.4 Invoice Rules tab

The Invoice Rules tab allows you to define state specific rules with a combination of service
and work order status. This helps to decide if a particular service fees in a work order is
‘Collectable or Not’ from the customer.

When the same combination of service, work order status and state is detected during auto
invoice validation, the ‘Collectible’ check box in Vendors > Invoice tab > Invoice Details
section is selected. Further, the collectible amount is posted as an expense on the customer
account.

To define invoice rules

1. Click Setup > Setup > Administration > System > Vendors > Invoice Rules.

2. Inthe Invoice Rules section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Service Select the service from the drop-down list. The list consists of services
offered by Vendors which can be associated with a work order.

Work Order Select the work order status from the drop-down list.

Status

Close Rea- Select the close reason from the drop-down list. This field is enabled

son only if the work order status is selected as ‘CLOSE’.

State Select the state from the drop-down list. The selection here indicates
that the state rules allow to collect the service fee for selected service
from the customer.

Enabled Select the check box to enable the invoice rule.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

212 Reports

The Reports screen allows you to setup reports in the system.

To set up the Reports

1. Click Setup > Setup > Administration > System > Reports link. The system displays
the Report screen. The details are grouped into two:

e Reports
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e Report Parameters

2. In the Reports section, perform any of the Basic Operations mentioned in Navigation
chapter.
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A brief description of the fields is given below:

Field Do this:

Code Specify the code of the report.

Description Specify the description of the report.

Package Specify the package .

Module Select the code of the report from the drop-down list.

System Select ‘Yes’, if you wish to maintain the Report as system defined
Defined Yes/ | and ‘No’, if you do not want to maintain it as system defined.

No System defined entries cannot be modified. If the entry is not
system defined, then it can be modified.

Enabled Check this box to enable the report definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Report Parameters section,perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Parameter Specify the parameter code of the report.

Description Specify the description of the parameter.
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Field Do this:

Parameter Type Select the parameter type of the report from the drop-down list.

Parameter Sub Type Select the parameter sub type of the report from the drop-down
list.

Default Specify the default value for the report parameter (value to
initially populate, or used if no value is supplied) (optional).

Sort Specify the sort order for the lookup code. This determines the
order these report parameters are displayed or processed.

Enabled Check this box to enable the report definition.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.13 Error Messages

In the Error Messages Setup screen, you can translate or modify the text of error messages.
the system displays all messages as they appear to the system users in the Error Message
section’s Message field.

New messages created with the Error Messages screen can then be translated with the
Setup > Setup > Administration > System > Translation > Message Translation screen.

To set up the Error Messages Setup screen
1. Click Setup > Setup > Administration > System > Error Messages. The system
displays the Error Message screen.

2. Onthe Error Messages Setup screen’s Error Type section, use the Error Type field to
select the error type. These are the categories of error messages available for creating or
editing.

3. The error messages associated with the error type you selected appear in the Error
Message section.
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4. Inthe Error Messages section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field Do this:

Region Specify the region code.

Country Specify the country code.

Customer Specify the customer code.

Engine Specify the engine code.

Error Code Specify the error code.

System Defined Displays whether the record is system defined or not.

Enabled Check this box to enable the data error message.

Error Message Specify the error message.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14 Translation

You can setup translation properties.

Navigating to Translation

1. Click Setup > Setup > Administration > System > Translation. The system displays
the Translation screen. On this screen you can,

e Setup Translation
e Translate Error Messages
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Setup Translation

In the Setup Translation tab, you can translate the contents of a predefined list of setup
description fields into a different language.

After you translate an entry in the Translation Data section, the system adds the new data to
the setup form.

To set up the Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Setup Translation.

2. In the Language section, you can select the language for which you need to setup the
translation.
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For more information, refer Language setup at the end of this chapter.

3. Inthe Source Type section, you can select the source (or location in the system) of the
item you want to translate.

4. Click Populate All in the Source Type section and the system loads the setup data
descriptions in the Translation section screen for the selected source type.
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If you have new entries and are unsure as to which setup items have been updated
since the last translation, click Populate All, the system loads the additional data for all
items with no impact to the previously translated data for any of the entries.

5. In the Translation Data section, Select:

e All-to view all the records (both translated and un-translated) in the Translation Data
section.

e Translated — to view all the translated records in the Translation Data section.
e Un Translated — to view all the un-translated records in the Translation Data section.

6. Inthe Translation Data section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

You cannot add a new record.

A brief description of the fields is given below:

Field Do this:

Key 1 Displays the first reference key value.

Key 2 Displays the second reference key value.

Key 3 Displays the third reference key value.

Key 4 Displays the fourth reference key value.

Key 5 Displays the fifth reference key value.

Key 6 Displays the sixth reference key value.

System Defined Select ‘Yes’, if you wish to maintain the data as system defined

and ‘No’, if you do not want to maintain it as system defined.

Enabled Check this box to indicate that the record is active.

Desc 1 Translation 1 | Specify the first translated description.

Desc 2 Translation 2 | Specify the second translated description.

Desc 3 Translation 3 | Specify the third translated description.

Desc 4 Translation 4 | Specify the fourth translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14.2 Message Translation Setup

In the Message Translation tab, you can translate the contents of a predefined list of error
messages into a different language.

After you translate an entry in the Error Message section, the system adds the new data to
the error message.
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To set up the Message Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Message
Translation.

2. Inthe Language section, you can select the language for which the translation needs to

ORACLE’ & Welcome, PRAKRRAD ~ (w]
Financial Services Lending and Leasing
— Translations x (3 close
> Origination Setup Translation  Message Translation
> Servicing
»» Collections Language
T Viewv Formate [ Freeze i Detach ol wrap ®
Language
> Tools R
Setup DEFAULT
Setup FRENCH
Administration [}

System
System Paramets Error Type
Lookups Viewv Formatw [ Freeze Y Detach ol wrap W) 48 Populate All
User Defined Tat. Error Type
Aucit Tables
User Defined Def A
Transaction Code
Data Files v
Dedupe SERVER ERROR

4 Error Message ZEdt | Hview || o audit
Producer Cycles o -
R View~ Formatw [ Freeze i Detach il wrap ® @ A0 Translated O Untranslated % Populate Details
Collection Cycles Region Country Customer # Engine Error Code System Defined Enabled Message English Translation
Reports S5 svs S5 uAD 000001 (7 ¥ Only one ACH Defi_.. Only one ACH Defi.
Error Messages sYs SYs sYs UAD 0 Y ¥ Please select a pro... Please selecta pro... A
S svs svs svs BT ¥ ¥ ACH details are no... ACH details are no.

User SYs sYs 5Ys UBT Y Y Can not view as=..  Can not vie se. W
Ccariidion s¥s svs s¥s BT ¥ ¥ Manual batch crez... Manual batch crea..
Companies
Accass Error Message
Users Ga Retum
Credit Bureau
Correspiondencs, Region SYS Enabled ¥
General Ledger Country 5YS Message OMLY ONE ACH DEFINITION OF
e Customer # SYS System Define THE SRETTPECAREE
Printers. & ENABLED AT ONE TIME
Bank Details English Translation ONLY ONE INITION OF
Caidi Easen 47 o TIvE
Standard Payess FABLEDATC
Currencies
Zip Codes v

Products
< >

For more information, refer Language setup at the end of this chapter.

3. Inthe Error Type, you can select the type of error message you want to translate.

4. Click Populate All in the Error Type section and the system loads the error messages
in the Error Message section for the selected error type.

If you have new entries and are unsure as to which error messages have been updated
since the last translation, click Populate All, the system loads the additional data for all
items with no impact to the previously translated data for any of the entries.

5. Inthe Error Message section, select:

e All —to view all the records (both translated and un-translated) in the Error Message
section.

e Translated — to view all the translated records in the Error Message section.
e Untranslated — to view all the un-translated records in the Error Message section.

6. Inthe Error Message section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

You cannot add a new record.
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A brief description of the fields is given below:

Field Do this:

Region Displays the region code.

Country Displays the country code.

Customer Displays the customer code.

Engine Displays the engine name.

Error Code Displays the error code.

System Defined Check this box to indicate that the record is system defined.
Enabled Check this box to indicate that the record is active.
Message Specify the error message.

English Translation Specify the English translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Language setup

On the Lookup master tab’s Lookup Types screen, you can add other languages to the
TRD_LANGUAGE_CD lookup type and perform translations for those languages.

However, translated data only appears in one language, which is defined by the User
Language parameter. This parameter can be defined in the system configuration file, typically
named DBKWEB.CFG, which defines the parameter as:

Parameter: otherparams=0ORA_USER=<schema_name> USR_LANG=<native language>

Note

<native language> should match lookup codes in the TRD LANGUAGE_CD lookup type
on the Administration form’s Lookups screen.

The system supports the following pre-defined list of setup items for translation:

9.

© N o g~ w DN =

Asset Sub Types

Asset Types
Assignments

Audit Table Columns
Audit Tables

Call Action Result Types
Call Action Types
Checklist Action Types
Checklist Types

10. Commission Plans

1

1. Companies
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12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
20.
30.
31.
32.
33.
34.
35.
36.
37.
38.
39.
40.
41.
42.
43.
44,

Company Branch Departments
Company Branches
Compensation Plans

Credit Bureau Score Reasons
Credit Models

Credit Scoring Parameters
Edits

Escrow Disburse Rules
Escrow Sub Types

Flex Table Attributes

Flex Tables

GL Transaction Types

GL Translators

Job Sets

Jobs

Lookup Codes

Lookup Types

Portfolio Companies

Portfolio Company Branches
Producers

Product Instruments

Product Insurances

Product Pricings

Products

Promotions

Spreads

Standard Correspondences
Standard Document Definitions
Standard Element Definitions
Standard Function Definitions
Transaction Codes

Error Messages

Org. Fees

Seed Data

Seed data in general is referred to as any data delivered with the standard product installation
and is required to be present in the production environment for application to work properly.
Seed data basically consists of Table with its associated data that are uploaded into the

system through DAT files.
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Seed Data screen in Oracle Financial Services Lending and Leasing displays the seed data
details maintained in the system along with the updated seed data provided with the latest
release or patch installation.

Note that, when you upgrade OFSLL from an existing version to higher version,

e New seed data provided as part of that release is automatically updated into the system.

e Seed data which are modified from previous release to current release needs to be
manually accepted and updated into the system.

The modified seed data can have updates on base tables and/or its associated data and the
changes can either be updated or skipped depending on the need.

Navigating to Seed Data screen

1. Click Setup > Setup > Administration > System > Seed Data. The system displays the
Seed Data screen.

2. On this screen you can do the following:

e View the factory shipped seed data and update/skip the seed data differences between
existing and updated seed data in ‘Factory Data’ tab.

e View the customized (i.e. changed or configured) seed data as part of implementation
in ‘Current Data’ tab.

o View the differences between Factory data and Current data in ‘Comparison Data’ tab.
e Download all or only the required table specific seed data in “Download Data’ tab.

Factory Data

The Factory Data tab displays the list of both existing and updated seed data which are
provided though release/patch installation. In the Factory Data tab you can select and update
only the required seed data changes into the respective seed data tables. During update, you
can also skip the seed data changes for later updates (if required).

Accordingly, you can sort the view in Factory Data tab by selecting ‘Skipped’, ‘Update’ or ‘All
options to display the list of corresponding seed data.

In the ‘Patch # drop-down list, you can further sort the list to display ‘ALL’ the seed data or
only the additions or updates available as part of latest patch which has seed data changes.

To View Factory Data

Click Setup > Setup > Administration > System > Seed Data > Factory Data tab.
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The ‘Factory Data’ section displays the list of seed data with the following details:

Field View this:

Table Displays the seed data table name.

Type Displays the category of seed data as either System or
Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type

Displays the unique identifier column data types.

Other Columns

Displays the non unique identifier column names.

Other Column Types

Displays the non unique identifier column data types.

Count

Displays the total count of updated records in the seed data
table.

The ‘Factory Data Details’ section displays the associated data of the selected seed data
table along with the following details:

Field

View this:

Key Column Data

Displays the unique identifier column names.

Other Column Data

Displays the non unique identifier column names.

Patch # Displays the patch number with which the seed data changes
are identified.
Status Displays the current status of seed data as one of the

following:
INSERT: This status indicates new seed data.

UPDATE: This status indicates if there are changes in the
record when compared to the seed data released in previous
patch.

POSTED: This status indicates that the seed data changes
are updated into the main tables and is subsequently updated
from previous status - SKIPPED OR UPDATE OR INSERT.

SKIPPED: This status indicates that the seed data is not
updated into the main tables.

DEPRECATED - This status indicates that the seed data is no
longer used.

In the ‘Factory Data’ tab, you can click (refresh) to fetch the latest details and click ‘View’
to display the detailed information of the selected record.

Update/Skip Seed Data

The ‘Update’ option in the Factory Data tab allows you to replace the existing seed data with
the current update. However, ensure to double check the details before performing ‘Update’
operation since the same can have significant impact on system behaviour.

To Update/Skip Data
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1. Inthe Factory Data’ tab, select ‘Update’. System displays those records which can be
updated to the existing seed data tables.

2. Inspect the required record in Factory Data section with the Factory Data Details in
subsequent section.

3. Select the required record to be updated by clicking on the adjacent check box. You can
also click ‘Select All' to select all the records.

4. Do one of the following:

— Click ‘Update Data’. This action updates the existing seed data with the updated
seed data provided as part of the current patch release.

— Click ‘Skip Data’. This action skips the seed data changes received as a part of the
patch release. The skipped records can be viewed by selecting ‘Skipped’ option in
Factory Data tab. However, the same can further be updated into the system, by
selecting ‘Update Data’.

5. Click ‘Yes’ in confirmation dialog to confirm the setup data changes.

On successful update, system does the following:

e When individual records are selected and updated, the same is removed from Factory
Data Details section and the ‘Count’ column in Factory Data section is updated with the
remaining number of records.

e In case of Bulk update, the record is removed from Factory Data tab.

2.15.2 Current Data

The Current data tab displays the customized seed data which are changed or configured as
part of implementation. In the ‘Current Data’ tab, you can click (refresh) to fetch the latest
details and click ‘View’ to display the detailed information of the selected record.

Additionally you can click “Refresh Data’ to pull the seed data details from the production
system and update the current seed data tables.

To View Current Data

Click Setup > Setup > Administration > System > Seed Data > Current Data tab.

ORACLE’ [ FFUSER ~  ig sgnout &
Financial Services Lending and Leasing

@ SeedData » [3€]Close
FactoryDatz | Current Data | Comparison Data 2
> DashBoard
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INPUT_FILE_DEFINITIONS CO... IDF_NAME VARCHAR2 IDF_DESCIIDF DI... VARCHAR2IVARCHARZIVARCHAR2IVARCHAR2IVARC .. 5 34
Repors INPUT_FILE RECORD_DETAILS  CO... IRD_IDF_NAME|IR... VARCHAR2IVARC... TRD_INPUT_COLU... NUMBER|VARCHAR2|VARCHAR?|VARCHAR2INUMBER .. 157 03723 105:13 AM
Ernoreeones i LOOKUP_TYPES S¥5... LKT_TYPE VARCHAR2 LKT DESCILKT 5Y... VARCHAR2IVARCHAR2IVARCHAR2 502 03/23/2017 10:05:13 AM
iy OUTPUT FILE_RECORD_DETAILS  CO... ORD_ODF_MAMEI.. VARCHARZIVARC.. ORD DATA_COLLL. NUMEERINUMBERIVARCHARZIVARCHARZINUMBERIN... 2281 03/23/2017 10:05:13 AM
Sesinet EVENT_TYPES CO... EVI_EVENT_TYPE_... VARCHARZIVARC... EVT_EVENT_DESC|... VARCHARZIVARCHARZIVARCHAR2 102 03/23/2017 10:05:13 AM
User 1 FLEX_TABLES CO.. FTB_TABLE VARCHAR2 FTB_SUPER_PROD... VARCHAR2|VARCHAR 2]VARCHAR 2|VARCHAR2|VARC . 175 03/23/2017 10:05:13 AM
Organization = FLS_ACCESS_DETAILS CO.. FAD_FAC_ACCESS.. VARCHARZ|VARC.. FAD_ALLOWED_IN... VARCHAR2|VARCHAR2 3908 03/23/2017 10:05:13 AM -
Comparies
Access
teers Current Data Details Bl ven
CreditBureau View = Fornat | [0 Freee  [fiDetach wap | B
Correspondence <
General Ledger 4
Queues Key Column Data Other Column Data
Printers PAINOD 1{BATCHDETAL S | /Amt |7 11NN -
Bark Details = ETALLS|/CatTrfTanf|33 (111w J
nam ran e im0 win

2-107 ORACLE



2.15.3

The ‘Current Data’ section displays the following details:

Field

View this:

Table

Displays the current seed data table name.

Type

Displays the category of seed data as either System or
Combination Data.

Key Column

Displays the unique identifier columns.

Key Column Type

Displays the unique identifier column data types.

Other Columns

Displays the non unique identifier column names.

Other Column Types

Displays the non unique identifier column data types.

Count

Displays the total count of records in the seed data table.

Last Refreshed Dt

Displays the date and time when seed data for the selected
table was last updated in the system.

The subsequent ‘Current Data Details’ section displays the associated data of the selected

seed data table along with the following details:

Field

View this:

Key Column Data

Displays the unique identifier column names.

Other Column Data

Displays the non unique identifier column names.

Comparison Data

The ‘Comparison Data’ tab displays the differences between factory shipped seed data and
current customized seed data.

To View Comparison Data

Click Setup > Setup > Administration > System > Seed Data > Comparison Data tab.
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2.15.4

The ‘Comparison Data’ section displays the list of seed data records with the following details:

Field View this:
Table Displays the seed data table name to be inserted or updated.
Type Displays the category of seed data as either System or

Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data types.
Count Displays the total count of records in the seed data table.

The subsequent ‘Comparison Data Details’ section displays the associated data of the
selected seed data table along with the following details:

Field View this:

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

Patch # Displays the patch release version with which the seed data
was inserted/updated.

In the ‘Comparison Data’ tab, you can click (refresh) to fetch the latest details and click
‘View’ to display the detailed information of the selected record.

Download Data

The Download Data tab allows you to download table specific seed data available in the
system in ‘.dat’ format. While migrating from one environment to other, you can use the
Download Data tab to download the existing seed data and perform a bulk upload of all/
required files.

Similar to other file download process, based on the value defined for the system parameter
‘CMN_FILE_PROCESS_TO_LOB’, the seed data download file can be accessed from the
Process Files interface (if value is ‘Y’) or Database Files system (if value is ‘N’). For more
information on handling Incoming/Outgoing process files, refer to ‘Dashboard’ section in User
Guides.
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To Download Data

1. Click Setup > Setup > Administration > System > Seed Data > Download Data tab.
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= =
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Audit Tables [F]  asser_sus_Tpes PRODUCT_DATA

User Defined Defaults 1 ASSET_TYPES PRODUCT_DATA

Transaction Codes =
ASSIGNMENT_CONDITIONS PRODUCT_DATA

Data Files

The Download Data section displays the list of tables maintained in the system with ‘Table
Name’ and ‘Table Type’. Click (refresh) to fetch the latest details.

2. Select the check box adjacent to the required table in the list. You can choose ‘Select All
check box to select all the tables with seed data maintained in the system.

3. Click ‘Submit For Download’ button. System displays an information message in the
header indicating that the request has been submitted along with a reference number.
The reference number is generated in format - useridDDMMHHMISS# followed by table
name with ‘.dat’ extension. For example, (USER1230603121517#lookups.dat)

4. (Optional) If ‘CMN_FILE_PROCESS_TO_LOB’ is set to ‘Y’, navigate to DashBoard >
Process Files screen > Outgoing Process File tab to download the selected seed data file
which will be listed with the same reference number. The file can be downloaded to
Application server.

Sales Tax

The Sales Tax screen facilitates to define state and county-wise Lease Sales and Usage Tax
rules which are used in Origination and Customer Service modules to calculate the taxes on
lease asset sales.

For information about this screen, refer to Sales Tax Setup section in Appendix chapter.

For detailed information on how lease sales tax calculation is supported in OFSLL, refer to
Lease Sales and Usage Tax Appendix chapter.

Data Masking

Data masking screen in Oracle Financial Services Lending and Leasing facilitates to mask
Personally Identifiable Information (PII) displayed in the application to safeguard the sensitive
and confidential information while protecting them from offenders.

As part of the product installation, standard set of identified fields (seed data) which is likely
to contain either organization / customer Pl information are provided for data masking in
disabled status. Based on need, the required fields can be enabled and masked for specific
user responsibility in the Data Masking screen. Also if there are additional Pl fields identified
for masking, the same can be pooled into the system using input file processing method and
masked using Data Masking screen.

2-110 ORACLE



The data masking process involves the following steps:

e Identify and enable field(s) (seed data) to be masked

e Select user responsibility for whom the data has to be masked

e Execute batch job to create data redaction policy

e Compile the data redaction policy

e (Optional) Process user identified Pll data for masking

The following table indicates the standard pre-defined fields (seed data) identified in
respective screens/tabs which can be readily masked using the Data Masking screen.

Tab Name Field Names
Origination
Applicant First Name, MI, Last Name, Family Name, Birth Dt, Nationality,

National ID, Visa #, Passport #, License #, Marital status, Mother's
maiden name, Passport number, Gender, Language, Dependents,
Ethnicity, Disability, Email, Race, and Education.

Applicant > FATCA

Birth Place, Birth Country, and Permanent US Resident Status.

Applicant > Power

Holder Name, Address, Country, Nationality, and Telephone

of Attorney Number.

Applicant Active Military Duty, Military Effective Date, Duty Order Number,
and Active Military duty Release date.

Addresses Country, Postal Address Type, Address #, Street Pre, Street
Name, Street Type, Street Post, Apt #, Address 1, Address 2,
Address 3, Zip, Zip Extn, City, State, and Phone.

Telecoms Phone and Extn

Employments

Employer, Country, Address #, Address 1, Address 2, Zip, Zip
Extn, City, State, Phone, Extn, Income Amt - Stated, Income Amt -
Actual, Salary - Stated, Salary - Actual, and Title.

Applicant >
Financials

Type, Source, Account #, and Currency.

Existing Accounts

Account # and Title.

Servicing

Customer

Name, Birth Dt, Nationality, National ID, Visa #, Passport #,
License #, Marital status, Mother's maiden name, Passport #,
Language, Disability, Email, and Education.

Customer > FATCA

Birth Place, Birth Country, and Permanent US Resident Status.

Customer > Power
of Attorney

Holder Name, Address, Country, Nationality, and Telephone
Number.

Customer

Active Military Duty, Military Effective Date, Duty Order Number,
and Active Military duty Release date.
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Tab Name Field Names

Addresses Country, Postal Address Type, Address #, Street Pre, Street
Name, Street Type, Street Post, Apt #, Address 1, Address 2,
Address 3, Zip, Zip Extn, City, State, Phone, and Address.

Employments Employer, Country, Address #, Address 1, Address 2, Zip, Zip
Extn, City, State, Phone, Extn, and Title.

Assets tab

Assets Identification #, Lien Status, Lien Event Date, Second Lien Holder,

Comments, Lien Release Entity, and Entity Name.

Masking Format

Oracle Financial Services Lending and Leasing supports only complete masking (not partial)
of both factory shipped and user identified Pll data. On masking, the masked data is
presented in same structural format to facilitate internal validations. The below table indicates
the default values used for masking fields based on data type:

Data Type Masking Value
NUMBER 9

VARCHAR X

DATE 31/12/9999

Phone number For Ul represented format - 000-000-0009
(Masked with O’s and last digit as 9) and for
generic, masked as 9999999999

Email XXXXX.XXX@<domain>.com

Note

Itis recommended to avoid modifying masked data for user(s) with masked responsibility.
However, while editing masked data (if permitted) requires to input full data replacing the
masked characters. For example, editing a masked SSN (xxx.xx.xxxx) requires to specify
all nine digits of SSN and not just the last four digits.

2.17.1 Setup Data Masking

1. Click Setup > Administration > System > Data Masking.

2. Define the parameters available in ‘Data Masking Details’ and ‘User Access Details’ tabs.

212 ORACLE



2.17.1.1 Data Masking Details

On clicking Data Masking link, the Data Masking Details tab is displayed by default and allows
you to enable the required fields for masking.

ORACLE & Welcome, PRITAM ~  Accessibiity 48 Sign ut ‘&
Financial Services Lending and Leasing

-

Data Masking [3] Close

Data Masking Details = ser Access Details

Data Masking Details A Edit view | < Audit
view v Formatv [Ep Freeze  pfi Detach =l Wrap (00
Table Name Field Mame Enabled System Defined YN
ACCOUNTS ACC_ACH_BAMK_NAME N ¥ -
ACCOUNTS ACC_ACH_BANK_NAME_CUR N ¥ [
ACCOUNTS ACC_PHP_DRAWER_CITY N ¥
> ACCOUNTS ACC_PRIMARY_CUS_LANGUAGE_CD N Y
ACCOUNTS ACC_TITLE Y ¥
ACCOUNT_ACH_DETAILS  AAC_ACH_ACCOUNT_BIC_CD N ¥
ACCOUNT_ACH_DETAILS AAC_BANK_CITY N ¥
ACCOUNT_ACH_DETAILS AAC_BAMK_CITY N Y
ACCOUMT_ACH_DETAILS AAC_BAMK_NAME N ¥
ACCOUNT_ACH_DETAILS AAC_BAMK_STATE_CD N ¥ -

“ i ’

1. In the Data Masking Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields are given below:

Field Do this:

Table Name View the table name which contains the selected field details.

Field Name View the selected field name.

Enabled Check this box to enable masking of the selected field.

System Defined View the type of seed data maintained in the system. Y’
indicates factory shipped seed data and ‘N’ indicates user
defined seed data.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.17.1.2 User Access Details

The User Access Details tab facilitates to define the user responsibility to whom the Pll data
should be masked. By default, all the selected PII data in Data Masking Details tab appears
as masked for one or more user(s) selected in this tab.
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1. Click Setup > Administration > System > Data Masking > User Access Details.

ORACLE’ & Welcome, PRITAM +  Accessbiity 4 Signout &
Financial Services Lending and Leasing

P

Data Masking [] Close

Data Masking Details  User Access Details

User Access Details o add | 7 Edit =] vie <7 Auit
View ~ Format~ [ Fresze A% Detach ‘Wrap [oh)
Responsibility Masked
UNDERWRITER L
i PAYMENTS SUPERVISOR. i 8

User Access Details
E Save and Stay a Save and Return <::| Return

* Responsibiity | PAYMENTS SUPERVISOR. [=]
*Masked []

2. Inthe User Access Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields are given below:

Field Do this:
Responsibility Select the user responsibility from the drop-down list.
Masked Check this box to enable masking for the selected user.

Note: Defining a user and not selecting the masked check box
will only create the record and masking rules are not applied.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.17.2 Create data redaction policy

Once the data masking details are defined and stored in the database, you need to create a
data redaction policy which facilitates for field level masking while displaying the details to the
respective user. A data redaction policy file contains the policies on the columns enabled in
the Data Masking Details screen.

To create data redaction policy

Click Setup > Administration > System > Batch Jobs and execute the following batch job
(in single thread mode only):

Set Code | Description Job Code

SET-RED | POLICY CREATION FOR PERSONAL | REDPRC_BJ_100_01
IDENTIFIABLE INFORMATION DATA

This batch job can either be scheduled for regular run or executed on-demand and facilitates
to generate data redaction policy picking only the enabled data masking field information from
database. On every run, the batch job drops and re-creates new set of policies in the file
based on the details updated in Data Masking Details screen.

The generated policy is either written into CLOB or sql file depending on the following option:

e if the value of system parameter ‘CMN_FILE_PROCESS_TO_LOPB’ is setto ‘Y’, the
policy file is generated in CLOB and can be accessed by navigating to DashBoard >
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Process Files screen. For more information on handling Incoming/Outgoing process
files, refer to ‘Dashboard’ section in User Guides.

e If the value of system parameter ‘CMN_FILE_PROCESS_TO_LOB'is ‘N’, the policy is
generated as an sql file and stored in the repository path as defined in the system
parameter - CMN_SERVER_HOME. For example, /scratch/OFSLL/<release>/sql.

Further, the policy file needs to be manually compiled into database schema to apply the
masking rules for respective fields for that particular user. Either a system administrator or any
other user having administration privileges needs to compile the policies in the database.

Note

For every change in the data masking details such as masking additional fields or unmask-
ing / disabling masked fields, a new policy is to be created by executing the batch job.

Masking User defined data

Apart from factory shipped seed data, additional user identified PIl data can be masked by
uploading an input file with field details and processing it in Data Masking screen using input
file processing method.

1. On identifying the fields, create an input file (in text file format) with table name, column
name, and enabled indicator (Y/N) for each field level record. If enabled indicator is ‘N’,
the record is not processed for data masking.

For example, BUSINESS_APPL_DETAILS,BSD_LEGAL_NAME,N

2. Place the input file to the path as defined in system parameter IPI_DIRECTORY. For
example, $OFSLL_HOME/input/ipi

3. Navigate to Setup > Administration > System > Batch Jobs screen and execute the
following batch job:

Set Code | Description Job Code

SET-IFP PI INFROMATION FILE UPLOAD PROCESSING | IPIPRC_BJ_100_01

On execution, the batch job picks the file from the location, processes it and loads the seed
data into Data Masking screen. By default, all the user identified PII data from input file is
categorized separately in Data Masking screen by assigning the value of ‘System Defined’
property as ‘N’.

Once the data is available in Data Masking screen, enable the required fields, assign user
responsibility and run the processing batch job - redprc_bj_100_01 to generate a redaction
policy. For more details, refer Create data redaction policy section.

Note

In addition, an xml sample file with PII fields data is provided in the installation bundle
(docs folder). The same is generated through Application Data Model (ADM) and can be
imported to view the details of Pll masked fields. However to do so, you need to have Or-
acle Cloud 13c installed.
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3.1

3. Administration User

In the Administration > User, you can record setup data that define your organization
structure and its users. Information in this link is more “data” related, whereas the information
stored on the System drop-down link functions more like switches that control system
behavior.

Navigating to Administration System

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User.

The User drop-down link records the following data:
e Organization
e Companies
e Access
e Users
e Credit Bureau
e Correspondence
e Queues
e Printers
e Bank Details
e Check Details
e Standard Payees
e Currencies
e ZipCodes

Organization

The Organization screen records the operational hierarchy of your business in terms of
people. It groups the human resources of your business in three categories: organization,
division, and department. The system uses this data to control access of users to applications
(The Companies screen allows you to setup the location of these applications .)

Note

You can have only one active organization, so use the Organization field to define your
organization at its highest level.

Divisions are groups within your organization that will have access to the same applications .
Larger organizations often define their divisions by region. Smaller organizations may define
division as branch offices or even departments, and might only have one division defined.
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Departments are smaller units within a division. They expand on who is in the corresponding
Division field. The system uses this sub screen, for example, when setting up the Services
screen on the Utility form. At least one department must be defined for each division.

I—Qrganization —‘ '
I—.. Division A —l | I— Divisioln .B —I

' Deptl Dept2 Dept 3 Deptl Dept2 . Dept 3
{PEOPLE)

As an example of an organization setup, Oracle Corp. might be defined as:
Organization: O-00010racle Corp.ORA

Division: OD-001Central RegionC01

Department. ODD-010riginationORG

Department. ODD-02FundingFUN

Department. ODD-03ServicingSER

Division: OD-002Eastern RegionE01

Department. ODD-11ServicingSER

Department. ODD-12CollectionCOL

™ ]

I—Central Region (C01) —I Eastern Region (E0L)
Crigination Funding Servicing Servicing .Collcctions
(ORG) {FUN) (SERV) (SER) (coL)

Note

The Short Name field on the Organization screen allows you to create the ID that Oracle
Financial Services Lending and Leasing will use when referring to the organization, divi-
sion, and department throughout the system.

To setup the Organization screen
1. Click Setup > Setup > Administration > User > Organization.
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2. In the Organization Definition section, there can be only one active entry, so use this
screen to define your organization at its highest level. Perform any of the Basic
Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Organization Specify the organization ID (the ID is the unique identifier used
internally by Oracle Financial Services Lending and Leasing to
represent your organization).

Note: Do not edit this field.

Organization Name Specify the organization name.

Short Name Specify the short name for the organization.

Note: This ID represents this organization throughout the sys-
tem.

Enabled Check this box to enable the organization.

Note: Only one enabled organization is currently allowed by
Oracle Financial Services Lending and Leasing.

Country Select the country where the organization is located from the
drop-down list.

City Specify the city where the organization is located.

State Select the state where the organization is located from the
drop-down list.

Address Line 1 Specify the address line 1 for the organization.

Address Line 2 Specify the address line 2 for the organization.
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Field: Do this:

Zip Select the zip code of the location where the organization is
located from the drop-down list.

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the organization.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the organization .

Extn 2 Specify the phone extension for the alternate phone number, if
specified.

Fax 1 Specify the primary fax number for the organization.

Fax 2 Specify the alternate fax number for the organization.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Division Definition section, you can setup the information for the groups within
your organization that will have access to the same applicationsPerform any of the Basic

Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Division

Specify the division ID. The ID is the unique identifier used inter-
nally by the system to represent the division within the organiza-
tion.

Note: Once specified, do not edit this field.

Division Name

Specify the division name.

Short Name Specify the short name for the division.
Note: This ID represents this division throughout the system
(required).

Enabled Check this box to enable the division.

Country Select the country where the division is located from the drop-
down list.

City Specify the city where the division is located.

State Select the state where the division is located from the drop-down

list.

Address Line 1

Specify the address line 1 for the division.

Address Line 2
(unlabeled)

Specify the address line 2 for the division.

Zip

Select the zip code of the location where the division is located
from the drop-down list.
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Field: Do this:

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the division.
Extn 1 Specify the extension for the primary phone number.
Phone 2 Specify the alternate phone number for the division.
Extn 2 Specify the extension for the alternate phone number .
Fax 1 Specify the primary fax number for the division.

Fax 2 Specify the alternate fax number for the division.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click Setup > Setup > Administration > User > Organization > Department
Definition.

7. On the Department Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Department Specify the department ID.

Note: The ID is the unique identifier used internally by the sys-
tem to represent the department within the division.

Department Name Specify the department name.

Short Name Specify the short name for the department.

Note: This is the ID that appears throughout the system to repre-
sent this department.

Enabled Check this box to enable the department.

Country Select the country where the department is located from the
drop-down list.

City Specify the city where the department is located.

State Select the state where the department is located from the drop-
down list.

Address Line 1 Specify the address line 1 for the department.

Address Line 2 Specify the address line 2 for the department.

Zip Select the zip code where the department is located from the

drop-down list.

Extn Specify the zip extension where the department is located.
Phone 1 Specify the primary phone number for the department.
Extn 1 Specify the phone extension for the primary phone number.
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3.2

Field: Do this:

Phone 2 Specify the alternate phone number for the department.
Extn 2 Specify the phone extension for the alternate phone number.
Fax 1 Specify the primary fax number for the department.

Fax 2 Specify the alternate fax number for the department.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Click Setup > Setup > Administration > User > Organization > Display Format.

10. On the Display Format section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Format Type Select the type of format from the drop-down list.

Format Sub Type Select the sub type of the format from the drop-down list. The format
sub type will be displayed based on the format type selected.

Format Specify or select the format based on the format type and format sub

type selected. For Date and Time Zone format, select the required
option from the drop-down list.

Format Mask

Specify the format mask.

Format Filler

Specify the format filler.

Special Data

Specify the special data, if any.

Enabled

Check this box to enable the display format.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

Companies

The Companies screen records the hierarchical structure of your portfolio companies and
their branches. Just as Oracle Financial Services Lending and Leasing uses the Organization
screen to determine the location of people, it uses the information on the Companies screen
to determine the location of applications . In completing the Companies screen, there can be
more than one company, and each company can have more than one branch.

Accounting is performed at the company level. Accountsand applications can be sorted down
to the branch level. For this reason, branches are set up to reflect different business practices.
You would set up different branches if, for example:

e The General Ledger (GL) differs between branches

e The branches work with different accounts
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e There is a difference between branches in terms of the tasks they perform (loan
origination, servicing, collections, and so on)

l—' CamanyA —l = Cornplaan =]

Branch 1 Branch 2 Branch 3 Branch 1 Branch 2 Branch 3
(APPLICATIONS/ACCOUNTS)

As an example of the companies setup, Oracle Corp. might have the following companies and
branches defined as:

Company: C-0001TrustOne Financial CorpTOFC
Branch: CB-01TOFC - HeadquartersHQ

Branch: CB-02Kennedy Plaza KP

Company: C-0002Credtyme Credit CorpCCC
Branch: CB-11CCC - HeadquartersHQ

Branch: CB-12CCC - MissoulaMT

— The system does not limit the number of companies or associated branches with
the company you can enter.

— The Short Name field on the Companies screen allows you to create the ID that the
system will use while referring to the company and branch.

KEY CONCEPT: Note the difference between the Company screen and the Organization
screen:

e On the Organization screen, Oracle Financial Services Lending and Leasing users
belong to an organization and division.

e Onthe Companies screen, creditapplications belong to a company and branch.

As you can see in the following Access screen section, the information on the Organization
and Companies screens define the operational hierarchy of your companies in terms of which
Oracle Financial Services Lending and Leasing users will have access to which applications

To setup the Companies

1. Click Setup > Setup > Administration > User > Companies. The Companies screen
defines entities within your organization that service Leases.
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2.

Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

In the Company Definition section, perform any of the Basic Operations mentioned in

& Welcome, DEMOSUFR v i Sign out (O

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Setup
User Defined Defaults
Transaction Codes
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cycles
Vendors
Callection Cycles
Reports
Error Messages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Quaues
Printers
Bank Details
Check Details
Standard Payess
Currencies
Zip Codes
Products
Asset Types
Index Rates
Currency Exchange
Scoring Parameters
Products
Pricings
Contract
Edits

Companies x,

Company Definition
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Company Name Short Name
c-00001 ABC A
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c-0002 DEMOBANKNL  NLO2
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<
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* Company
* Name
= Short Name
* Currency US DOLLAR
i * Enabled [
* Country |UNITED STATES
zp
Extn
City
State
Branch Definition
View + Format~  [Ep Freeze  Ef Detach
Branch Name Short Name

No data to display.
<

3l Clos=
4k add | Edit | View | < Audit
wee | @
Currency Enabled Country ity State Addressline 1 Addrest
N
US DOLLAR N UNITED STATES SPRINGFIELD MASSACHUSETTS ~
US DOLLAR Y CANADA TOTONTO ‘CANADA LINE1 LINE2
EURD ¥ NETHERLANDS ~ AMSTERDAM ALASKA LINEL LINE2 &
SAUDI RIVAL ¥ SAUDI ARABIA  JEDDAH SETME LINEL LINE2
>
B save and add || [ save and stay save and Retumn || {3 Retun
Extn 1
Remittance Address Phona
Extn 2
> * Country UNITED STATES ] *Fax1 (000)-000-0000
Remittance Address T
Line 1 =2
[¥]  Remittance Address s
Line 2 B
o = * Contact
= Exn = Coupon Order Code
o * HMDA 2]
State K]
*Phone 1 (000)-000-0000
£
G add | Ledt | B view | o audt
Wirap i)
Enabled Sub Unit Country ity State Address Line 1 Address Lit
>

A brief description of the fields is given below:

Field:

Do this:

Company Specify the portfolio company ID. (This ID is the unique identifier
used internally by the system to represent the company).
Name Specify the name of the portfolio company (required).

Short Name

Specify the short name for the portfolio company (ID displayed to
represent the company).

Currency

Select the currency of the portfolio company from the drop-down
list. The system displays the default value as ‘US DOLLAR’.

Enabled

Check this box to enable the portfolio company.

Country

STATES'.

Select the country where the portfolio company is located from the
drop-down list. The system displays the default value as ‘UNITED

City

Specify the city where the portfolio company is located .

State

drop-down list.

Select the state where the portfolio company is located from the

Address Line 1

Specify the address line 1 for the portfolio company.

Address Line 2

Specify the address line 2 for the portfolio company.

Zip

Select the zip code of the location where the portfolio company is
located from the drop-down list.
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Field:

Do this:

Extn Specify the extension of the zip code where the portfolio company is
located.

Phone 1 Specify the primary phone number for the portfolio company.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the portfolio company.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the portfolio company.

Fax 2 Specify the alternate fax number for the portfolio company.

Tax ID # Specify the tax identification number for the portfolio company.

TCC Specify the transmitter control code for the portfolio company (1098
Electronic Filing).

Contact Specify the contact information about the portfolio company.

Coupon Order
Code

If you are using coupons, Specify the coupon order code to be used
by a third party printing the coupons for billing statements.

HMDA

Select the HMDA agency (Home Mortgage Disclosure Act reporting
agency for the company).

Remittance Address section

Country Select the remittance address country from the drop-down list. The
system displays the default value as ‘UNITED STATES'.

City Specify the remittance address city.

State Select the remittance address state from the drop-down list.

Remittance Specify the remittance address line 1, if it is different from the com-

Address 1 pany address. This address is included as the remittance address
on statements.

Remittance Specify the remittance address line 2.

Address 2

Zip Select the zip code of the remittance address line 1 from the drop-
down list.

Extn Specify the extension of the remittance address zip code.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. On the Branch Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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3.3

A brief description of the fields is given below:

Field: Do this:

Branch Specify the portfolio branch ID. (This ID is the unique identifier used
internally by the system to represent the branch within your company).

Name Specify the name of the portfolio branch (required).

Short Name Specify the short name for the portfolio branch (ID displayed to repre-
sent the branch) (required).

Enabled Check this box to enable the portfolio branch.

Sub Unit Select the Sub Unit from the drop-down list.
Sub Unit refers the entity which is the source of funds for the credit
application/Account.
System associates the selected sub unit with the particular company/
branch combination and displays by default when the same is selected
during an application/Account creation.

Country Select the country from the drop-down list. The system displays the
default value as ‘UNITED STATES'.

City Specify the city where the portfolio branch is located.

State Select the state from the drop-down list.

Address Line 1

Specify the address line 1 for the portfolio branch.

Address Line 2

Specify the address line 2 for the portfolio branch.

Zip Select the zip code of the location where the portfolio branch is located.

Zip Extn Specify the extension of the zip code, where the portfolio branch is
located.

Phone 1 Specify the primary phone number for the portfolio branch.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the portfolio branch.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the portfolio branch.

Fax 2 Specify the alternate fax number for the portfolio branch.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Access

Using the organizations, divisions, companies, and branches created on the Organization and
Companies screens, you can control the access privileges of applications. On the Access
screen, you define which organization/division (users) can gain access to which company/
branch (applications and) locations.
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3.3.1

Normally, for each division within an organization, you would define a record with Company
value of ALL and a Branch value of ALL, then select the Allowed box. You then define other
records for the same Organization and Division for other Company and Branch combinations
with the Allowed box cleared to restrict access.

t‘mglnaunn
(ORG)
{FUN)

Sarveing
(SER)

.;xtrv\ang
(SER}

Collections
(coL)

Funding

'Su per Solutions Corp. (SSC)

-7 8t.Paul, MN (HQ)
Central Region (CO1) ‘4

A\ /st.Louis, MO(KP)

.]—Easuem Region (E01)

| \.CCC-Headquarters —

. cce-Missoua —

(PECPLE) {APPLICATIONS!
ACCOUNTS)
Organization
’Deptl | A 'Brapch 1 - :
. Division A <> Branch 2 Company A
Dept 2 Division A < -
= “._ sBranch3
Dept 3 ) )
b-ept]_ - “ Branch 1 -
s — Division B “—___ 4 Company B
Dept 2 . Branch 2
‘I:‘,'ept 3 ; 'Eranch 3

';'(IJFC-HeadquarErs —

Kennedy Plaza |

| TrustOne Financial

~ Missoula,MT (MT)

To setup the Access

1. Click Setup > Setup > Administration > User > Access. The system displays the
Access screen. In this screen, you can control the access privileges of the user for the
following categories:

e Data
e Screen
e Reports

e Correspondence

Data

The Data screen allows you to restrict access to different data.

To setup the Data

1. Click Setup > Setup > Administration > User > Access > Data.
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2. Inthe Access Grid section, perform any of the Basic Operations mentioned in Navigation

chapter.
ORACLE
Financial Services Lending and Leasing
DashBoard Access x =

_» Origination Data Screen  Reporis  Comespondence  Transaction

»» Servicing

> Collections Access Grid dpadd | et | B view | o auit

 WEP View v Formatv Fresze i Detach Wirsp )]

= Organization Division Company Branch Allowed

Setup DmMC LSS] r:\.l. f‘.l. "fq

pr A s o= ift y
22::;“““ Access Grid
User Defined Tat [ saveand add || [l save and Stoy || [ Save and Retum || 3 Retum
Audit Tables
Pl © 5
Data Files. * Division 3] * Allowed []
i =
s |
Producer Cycles
Vendars
Collaction Cyclas
:j:x:tﬁu:eau
Correspondence
General Ledger
Qne:;
o
Check Details
Sunda@ ?EVEES

< miEmiEn >

A brief description of the fields is given below:

Field: Do this:

Organization Select the organization for which you are defining access privileges
from the drop-down list.

Division Select the division within the organization for which you are defining
Access privileges from the drop-down list.

Company Select the portfolio company to which you are defining access privi-
leges for the organization and division specified from the drop-down
list.

Branch Select the portfolio branch of the company to which you are defining
access privileges for the organization and division specified from the
drop-down list.

Allowed Check this box to provide access to the data pertaining to the com-
pany and branch, for the organization and division specified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
3.3.2 Screen
In the screen, you can control the access to the following:

1. Menu — Control access at the application menu level. For example, for Setup menu you
can provide access only to an Administrator.
2. Screens — Control access to the screens available in the application

3. Buttons — Control access based on the stage.
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For example, Add and Edit buttons can be disabled once an application is funded.

If you want to restrict updating the Applicant details, then edit button has to be disabled
for the stage.

The screen allows you to restrict access to different screens.
To set the Screen Security
1. Click Setup > Setup > Administration > User > Access > Screen.

2. In the Security Super Group section, you can view the details of the super group you
want to work with.

ORACLE 8 Welcome, PRAKRRAD + o
Financial Services Lending and Leasing
Close.
DashBoard Ao g
> Origination Data || Screen | Reports | Corespondence | Transaction
> Servicing
> Collections Security Super Group [Elview || o audit
e Vieww Formate [ Fresze i Detach J wrap ®
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e FLLCMIN.RRO.REVIEWREQUEST EDIT. A CMN RRQ REVIEW REQUESTS EDIT BUTTON RRQ o Y
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Dedupe FLL.CMN.RRQ.REVIEWREQUEST AUDIT.BUTTON ACCESS TO CMN RRQ REVIEW REQUESTS AUDIT BUTTON RRQ g v
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User Type REVIEW REQUEST
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3. Inthe Security Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

Note

You can not add a new record

A brief description of the fields is given below:

Field: Do this:

Access Code The system displays the selected access code.
Description Modify the description of the access code.
Type The system displays the type of security access definition.

System Defined | If ‘Yes'’ is selected, the security access definition entry is system
defined.

If ‘No’ is selected, the security access definition entry is manually
defined.
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3.3.3

Field: Do this:

Enabled Check this box to enable the security access definition entry is
enabled.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Inthe Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select the access type of the user who will have access to this
screen from the drop-down list.

Active Value Select the active value of the user who will have access to this
screen from the drop-down list.

Allowed Select ‘Yes'’ to allow access to this screen or ‘No’ to deny access to
this screen.

System Select ‘Yes', if the screen user access definition entry is system

Defined defined.

Select ‘No’, if the screen user access definition entry is manually
defined.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Reports

In the Reports screen you can control access to generate certain reports.

To set up Reports
1. Click Setup > Setup > Administration > User > Access > Reports.
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2. In the Reports section, you can view the following information:

ORACLE" . . 2 Welcome, PRAKRRAQ = o
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A brief description of the fields is given below:
Field View this:
Code Displays the code of the report.
Module Displays the code of the report from the drop-down list.
Description Displays the description of the report.
Enabled Displays whether the report definition is enabled or not.

3. Inthe Reports User Access Definition section, you can set the access rights for the
report selected in the Reports section. Perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select the access grid function type from the drop-down list.
Access Value Select the access function grid value from the drop-down list.
Allowed Select ‘Yes’ to allow access or ‘N0’ to restrict access to the entry

based on the access type and value.

Yes/No defined.

defined.

System Defined | Select ‘Yes', if the report user access definition entry is system

Select ‘No’, If the report user access definition entry is manually
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3.34

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Correspondence

The Correspondence screen allows you to restrict access to different correspondence
commands on the Letters menu, thus restricting your ability to generate certain
correspondence.

If you do not have the responsibility to create a type of correspondence, the corresponding
command on the Letters menu is unavailable (dimmed).

To setup the Correspondence
1. Click Setup > Setup > Administration > User > Access > Correspondence.

2. Inthe Correspondence Codes section, perform any of the Basic Operations mentioned
in Navigation chapter.
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A brief description of the fields is given below:
Field: Do this:
Code The system displays the correspondence code name you want to work
with.
Description The system displays the description for the correspondence code (dis-
play only).
Enabled Check this box to enable the selected correspondence code entry.

3. Inthe Correspondence User Access Definition section, perform any of the Basic
Operations mentioned in Navigation chapter.
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3.3.5

A brief description of the fields is given below:

Field: Do this:

Access Type Select the access grid function type from the drop-down list.
Access Value Select the access function grid value from the drop-down list.
Allowed Select ‘Yes’ to allow access or ‘N0’ to restrict access to the entry

based on the access type and value.

System Defined | Select ‘Yes', if the correspondence user access definition entry is
Yes/No system defined.

Select ‘No’, If the correspondence user access definition entry is
manually defined.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Webservice

The Webservice screen in Access setup allows you to configure access to the available
RESTful webservices in the system. The associated seed data for all the RESTful
webservices are loaded during product installation and process of installing the same is
detailed in the Installation guide.

As an administrator/superuser, you can Enable/Disable Web Service access to users based
on their responsibility and ensure that only authorized user have access to those specific
webservices in the system. Following list indicates some of the available RESTful
webservices in the system:

Generic Post Transaction Service
Call Activity Service

Scheduler Service

Account Search Service
Account Boarding Service
Payment Posting Service
Account Detail Service
Calculator Service

Application Search Service

Get Scenario Analysis Service
Post Scenario Analysis Service
Lookup Service

Dialer Integration Service
Application GET Service
Application Entry service
Application Update Service
Application Status Change
Application Checklist
Application ACH GET Service
Application ACH POST Service
Application Comment GET Service
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e Application Comment POST Service
e Application Document GET Service
e Application Document POST Service
e Account Comment GET Service

e Account Comment POST Service

e Account Document GET Service

e Account Document POST Service

e Process File Upload Service

e Process File Download Service

e Process File List Service

e Product Service

e Asset Service

e Asset Sub-Type Service

e Scheduler Force ReSubmit

e Remarketing GET Service

e Remarketing POST Service

e Invoice GET Service

e Invoice POST Service

To setup the Webservice access

1. Click Setup > Setup > Administration > User > Access > Webservice. The screen
consists of the following tabs:

e Security Super Group
e Security Access Definition
e Security User Access Details

ORACLE w ABSHEKAR g signgut =
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RESPONSIBILTY AL {afies o Yes(3) No
RESPONSIBILTY SUPERLISER: 9 es ) No fes @ N

2. The ‘Security Super Group’ section, contains the following super group categories for
selection:

¢ COMMOM

e INTERFACES

e ORIGINATION

e SERVICING and COLLECTIONS
e SETUP

3-18 ORACLE



e WHOLESALE FLOOR PLANNING

3. Select the required Super Group and the associated data in sub tabs are categorized
accordingly.

4. Inthe ‘Security Access Definition’ section, you can view the following field details and edit
only the ‘Description’ and ‘Enabled’ status of selected Security Access Definition.

Field: Do this:
Access Code The system displays the webservice access code.
Description The system displays the description of the associated webser-

vice access code and can be edited for required changes.

Type The system displays the type of security access definition.

System Defined If selected as ‘Yes’, the security access definition entry is system
defined. If selected as ‘No’, the security access definition entry is
manually defined.

Enabled Check this box to enable the selected webservice access code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select ‘Responsibility’ (default) as the access type from the drop-
down list. For this access type to be available in the drop-down list,
ensure that the Lookup Type ‘ACCESS_GRID_TYPE_CD’ is main-
tained in the system.

Access Value This field is ‘Read-only’ for ‘System Defined’ Security Access Defini-
tions which are loaded as part of seed data during installation.

For non-system defined Security Access Definitions, select the
access value which is the user responsibility who needs to have
access to this webservice from the drop-down list.

For user responsibilities to be populated in the drop-down list, ensure
that the Lookup Type ‘RESPONSIBILITY_CD’ is maintained in the
system.

Allowed Select ‘Yes’ to allow user access to this webservice or ‘No’ to deny
access. By default, No’ is selected.

System Select ‘Yes', if the webservice user access definition entry is system
Defined defined.
Select ‘No’, if the webservice user access definition entry is manually
defined.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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3.4 Users

The Users screen allows you to create and set up an user. In the User Definition section, you
can assign a user an identification name and password to log on to the system. You can also
assign the organization, division, and department where each user is located. Additional fields
allow you to record information for contacting the user. You can also define the time frame
within which a user has access to the system to ensure compliance to the company’s
schedule. This is a very useful feature to prevent logins during scheduled maintenance.

The Responsibility field records the job function of the user and defines the level of access
that user has within the system; in particular:

e What menu items does the user have access to?
e What edits can the user perform on the Verification link during origination?

Note

The system’s SUPERUSER responsibility grants access to the entire system. Give careful
consideration to the number and type of users who receive this responsibility.

To set up the Users screen

1. Click Setup > Setup > Administration > User > Users. The system displays the Users
screen.

2. In the User Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’ * ACHA g signout &
Financial Services Lending and Leasing
@b Usersy [ Close
User Definition dp add | 2 Edit ] viev o Audit
P view v Format v [0 Freeze EfiDetach Wrap 0]
> Origination
& By £ =
> Servicing
5 User Organization Division Department Start Dt End Dt System Defined Enabled First Name 3 L
» Collections
> WP 988476 oMe usD1 oRG 10/10/2000 12/31/2020 ¥ ORACLE 1
988477 11/01/2000 /3Y200 ¥ ORACLE (a
> Tools sy =
983567 omc uso1 oRG 10/10/2000 1/33/2020 ¥ ORACLE 1
Setui
B ABSHEKAR oMe usD1 oRG 11/16/2016 12312020 ¥ ANAND
SeedData B
" G AQMISHRA oMc usD1 oRG 01/01/2000 12/3/2020 ¥ ABHINAY ]
jser
Sriiitin ARUN oMc usD1 oRG 0772512015 12/31/2020 ¥ ARUN l
DEMOLEAD oMe usD1 FUN 06/01/2016 12/31/2020 ¥ DEMO L
Comparies
s DEMOSALES oMe usD1 oRG 05/12/1994 /3y200 ¥ DEMO
Users | pevosum omc uso1 oRG 05/12/1994 033200 ¥ DEMO B
Credit Bureau < [} »
Correspondence
General Ledger User Definition
Queues |5 save and add Save and Stay. saveandRewmn || GaRewn
Printers L
B:”';?m"s‘ User ABSHEKAR Mz Fax2 2(354)-235-2352
Check Detais i
Siad Payess Organization | DMC = *LastName SHEKAR Replacement User =
Currendes * Division | Us D1 =] * Responsibilty PROCESSOR = Dt &
Zip Codes * Department | ORG [= * Review Request Supervisor DEMO LEAD - *Type EMPLOYEE = b
Products
*strtot 11/1s/2016 By *Phone 1 3243(232)-523-6532 Reference -
AssetTypes
Index Rates *EndDt 12312000 [ Exin 1 324132 Emal
Currency Exchange * System Defined @ Yes ©) No Phone 2 2352(352)-352-3523 *Default pEFALLT [l
Scoring Parameters * Enabled [7] . Language =
Products . Time Zane ~
& Ertiems (ANAND *Fax 1 2354235(252)-352-3523
ricings o Time Zone Level USER TIME ZONE [=]

A brief description of the fields is given below:

Field: Do this:

User Specify the user ID.

Note: This field is a unique indicator and cannot be updated,
edited, or deleted once saved.
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Field:

Do this:

Organization

Select the organization to which the user belongs, from the drop-
down list.

Division Select the division to which the user belongs, from the drop-down
list.

Department Select the department to which the user belongs, from the drop-
down list.

Start Dt Specify the start date for the user. You can also select from the
adjoining calender icon.

End Dt Specify the end date for the user. You can also select from the

adjoining calender icon.

System Defined

Select ‘Yes/, if the entry is system defined. System defined entries
cannot be modified.

Select ‘No/, if the entry is not system defined and it can be modified.

Enabled Check this box to enable the user.
First Name Specify the first name of the user.
MI Specify the middle initial of the user.
Last Name Specify the last name of the user.

Responsibility

Select the responsibility for the user from the drop-down list.

Note: The users mapped to the role ‘Responsibility’ can only view
the screens.

Review Request

Select the supervisor responsibility who can also review and

Supervisor respond to review requests from the drop-down list.
The list displays the corresponding Review Request Supervisors
who are either one or more levels higher from the above selected
user ‘Responsibility’ as maintained in ‘RESPONSIBILITY_CD’
lookup code.

Phone 1 Specify the user’s primary phone number.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the user’s alternate phone number.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the user’s primary fax number.

Fax 2 Specify the user’s alternate fax number.

Replacement
User

Select the user ID of the replacement user from the drop-down list.
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3.41

Field: Do this:

Dt Specify the date from when the replacement is effective. You can
also select from the adjoining calender icon.

Note: These two fields allow you to create a replacement user for
the current user. This is particularly useful when a new employee
assumes the duties of a former. By completing the Replacement
User and Replacement Dt field, the system recognizes the replace-
ment user as the current user on the effective date. For more infor-
mation, refer the section, ‘Replacement Users’.

Type Select the user type from the drop-down list.
Reference # Specify the reference number for the user from the drop-down list.
Email Specify user’s email address.

Default language | Select the default language from the drop-down list.

Time Zone Select the required Time Zone from the drop-down list, The speci-
fied time zone would be applicable at company level.

Time Zone Level | Select the time zone level (Organization, Company or User) that
would apply by default, when specific time zone is not specified at
Company and User level.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Replacement users

By completing the Replacement User and Dt fields on the Users screen, you can replace an
existing user with a new user. The system assigns all responsibilities of the original user to
the new user as of the date of the replacement.

The Replacement User and Dt fields allow you to designate a replacement for the current

user in the User ID field. When you complete the Replacement User and Dt fields, save your
entry, and then enable the record, the system replaces the original user. The system changes
the End Dt field to the date when the original user was replaced (the same date in the Dt field).

The system assigns the queues of the original user to only those replacement users who have
the same user responsibilities (or Super User responsibility) as set in the system.

The system updates the following when replacing users:

1. Assigns all applications in the replaced user’s underwriting queue with the status NEW to
the replacement user’s queue.

2. Assigns all applications in the replaced user’s funding queue with a status other than
FUNDED to the replacement user’s queue. The system currently stores the collector
name in the back end tables, which are updated with the replacement users ID in the case
of the replacement of any user.

3. Also updates the Producer Management screen with the replacement user in the
Underwriter and Collector fields. The system assigns all applications routed to the
original user to the replacement user. This also includes any future applications for the
replaced user.
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3.4.2

3.5

4. The system automatically updates the Collector ID field in all accounts to the
replacement user and routes all accounts assigned to the original user to the replacement
user.

Note

The system will not update the replacement user ID for accounts that are closed.

5. Onthe queue setup of Customer Service screen’s Responsibilities sub screen, the record
for the original user will be disabled and a new record will be created for the replacement
user. If the replacement user already exists in the setup, The system will not create a new
record. It updates the user ID and routes all accounts that were assigned to the original
user, based on the account condition, to the replacement user.

Application and Oracle Identity Manager Synchronization

Oracle Identity Manager is for user administration. Oracle Financial Services Lending and
Leasing has been developed in such a way that it can be implemented with or without Oracle
Identity Manager. In case OID has been employed, the user definition is done in OID and then
synchronized to the Oracle Financial Services Lending and Leasing Users table using a utility
JAR called OID Synchronization JAR. In OID, users are defined across various groups
belonging to a realm which is nothing but the directory structure in OID. A user can be
configured to belong to multiple groups in a realm. Every time the user tries to login to Oracle
Financial Services Lending and Leasing or OBIEE, the system validates the login ID and the
password with OID and provides access to those applications.

Credit Bureau

In the system, an important part of the origination process is pulling a credit report from a
credit bureau and scoring that information against a user-defined risk model. These credit
reports can be pulled both automatically and manually.

After you enter an application, the system compares its contents against pre-screen criteria.
If the application passes a pre-screen edits check, the system advances the status of the
application and automatically pulls a credit report.

You can manually request a credit report for an applicant or any other party included on the
application, such as co-signers and spouses by selecting the bureau from which you want to
pull the report. If more than one report type is defined for the selected bureau, then you can
indicate the type of report you want to pull.

The following are few additional Credit Bureau Setup details:

e The credit bureau from which the report is pulled is determined by the applicant’s zip
code. The credit bureau interface searches the information in the Credit Bureau Zip
Matrix tab and matches the applicant’s zip code to determine the bureau(s) from which
to request a report.

e The number of credit reports automatically pulled per applicant is controlled through the
credit request parameter CRB. MAX BUREAU_ PULL. If this parameter is setto 1, a
credit bureau request will be made for the Bureau credit bureau from the zip code
matrix. Likewise, if this parameter is set to 2, a credit bureau request will be made for
the Bureau1 and the Bureau? credit bureaus from the zip code matrix.

e The system automatically pulls credit reports for only the primary applicant and the
primary applicant's spouse (for joint applications) unless the
CRB_ALL_APL BUREAU PULL credit request parameter is set to Y. However, if the
parameter is set to Y, the system pulls credit reports for all of the applicants on the
Lease, regardless of their relationship to the primary borrower.
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3.5.1

3.5.1.1

e Passwords, default report formats, and other required information from the credit
bureaus are set up in the Report Formats screen.

e Foridentity scan data to flow into Equifax ACRO/ACRO Plus credit reports, the add-on
has to be enabled at contract level. Please speak to your representative for enabling the
add-on.

Member codes and passwords when switching credit bureau access methods (moving from
dial-up to Net Connect). The member codes and passwords are not dependent on the
connection method used to access the bureau.

Frame relay access is from the database server to the Experian host though a TCP/IP socket
connection. The connection is outbound only and it is to a specific port (699 or 700) on the
Experian host.

The credit bureau service will be accessing Experian Net Connect service through HTTP to
the ECALS URL supplied by Experian as well as by the HTTPS to the URL returned as a
response to the ECALS URL inquiry (the credit request URL). This access is from the
database server access.

Credit Bureau

The setup for Credit Bureau spans across the following links:

e Report Formats
e Connections

e Zip Matrix

e Parameters

e Score Reasons
e Reporting

Navigating to Credit Bureau

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Credit Bureau.

Report Formats

The Reports Formats screen captures and tracks the attributes related to the multiple types
of reports offered by the credit bureau agencies. When a company enlists the service of a
credit bureau, the credit bureau provides a membership code and password. This information
needs to be entered on the Reports Formats screen before you can request a credit report.
You must define at least one report for each credit bureau from which you want to pull reports.

The information on the Report Formats screen is location-specific. If the business requires
different membership codes for each location, be it a company or branch, then individual
records must be set up.

The Score Type, Additional Product, and Inquiry Limit fields on the Credit Report Setup
section are optional. They may not apply to all credit bureau types and even if they do apply,
you may want to leave them blank and rely on a default value set up at the credit bureau.

Note

For more information, refer to the the application Installation Guides.
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To setup Report Formats

1. Click Setup > Setup > Administration > User > Credit Bureau > Report Formats

2. In the Credit Bureau section, perform any of the Basic Operations mentioned in

Navigation chapter.:

Jwep | @

Country

UNITED STATES
UNITED STATES
UNITED STATES

Zip

30348
75013
12064

ORACLE’
Financial Services Lending and Leasing
DashBoard Credit Bureau x.
> Origination Report Formats ~ Connections  Zip Matrix ~ Parameters  Score Reasons  Reporting
>+ Servicing
> Collections Credit Bureau
- WEP View v Format- By Freeze B} Detach
> Took Bureau Name Short Name Source
ools
Setup EQUIFAX EQUIFAX EFX
Setup EXPERIAN EXPERIAN EXP
Administration ~ TRANSUNION TRANSUNION Tuc
System <
System Parameter
Lookups Credit Bureau
User Defined Tables
Audit Tables

User Definad Default
Transaction Codes
Data Fles

Dk = Saurce
Securitization

Events

Batch Jobs “
Producer Cydes

Vendors

Collection Cydles

Reports Credit Bureau Report Formats
View v Formatw [Ep Freeze

* Bureau Name

* Short Name

* Gountry UNITED STATES
* Address Line 1

Address Line 2

Ertor Messages
Translations
User
‘Organization
Companies
Access

i} Detach

Company Branch Description

No data to display.

Users
Credit Buresu
Carrespondence
General Ledger
Queues Report
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes

Products

Report Format Details
View v Formatw  [Ep Freeze i} Detach
Report Type

No data to display.

< >

e [<]

*Phone 1 ((

wio |

Consumer Member  Business Member

wee | @

= State

Bxtn1

Report Class

Exm

Customer Code

Multi Request

Change Dt Markst Sub Market Industry
>
Feadd | Ledt | EHvew | oF sudi
Score Type Addl Product Inquiry Limit Default

& Welcome, PRAKRRAD + o
3 Cose
g add | A Edit | View | o7 Audit
City State Address Linz 1 Address Lin
ATLANTA GEORGIA P.0. BOX 105873 SUITE 600
ALLEN TEXAS P.0. BOX 2104
SPRINGFIELD PENNSYLVANIA  P.0.BOX 390
>
I saveand add | [ Save and Stay || [ Save and Retum | GaRetum
- Phone 2
Bdn 2

*Fax 1 (000}-000-0000

I Fax2

Frad | Fedt | [Hview | o dudit

Auth Password

A brief description of the fields is given below:

Field: Do this:

Bureau Name

Specify the name of the credit bureau company.

Short Name

Specify the abbreviated or short name for the bureau.

Source

Select the credit bureau source from the drop-down list.

Country
list.

Select the country of the credit bureau address from the drop-down

City

Specify the city for the credit bureau address.

State

Select the state of the credit bureau address from the drop-down list.

Address Line 1

Specify the address line 1 for the credit bureau.

Address Line 2

Specify the address line 2 for the credit bureau.

down list.

Zip Select the zip code for the credit bureau address from the drop-

Extn

Specify the extension of the zip code for the credit bureau address.

Phone 1

Specify the primary phone number for the credit bureau.

Extn 1

Specify the extension for the primary phone number.
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Field: Do this:

Phone 2 Specify the secondary phone number for the credit bureau.
Extn 2 Specify the extension for the secondary phone number.
Fax 1 Specify the primary fax number for the credit bureau.

Fax 2 Specify the alternative fax number for the credit bureau.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Credit Bureau Report Formats section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Company Select the portfolio company that will be using the above credit
bureau from the drop-down list.

Branch Select the portfolio branch from the company that will be using the
above credit bureau from the drop-down list.

Description Specify the credit report format description.
Member Code Specify the credit bureau member code (assigned by bureau).
Password Specify the credit bureau password.

Customer Code Specify the customer code.

Auth Password Display the last authorization password change date. The Experian
Change Dt Net Connect product requires that the Auth Password (or SSP
Password in Experian jargon) be changed every 90 days (or
sooner). Equifax may have similar requirements, but they were not
known at the time of this writing. Use the date displayed in this field
to identify when the password needs to be changed.

Note: The password needs to be changed both in the system and at
the credit bureau. Changing the password does not initiate or per-
form a change at the bureau. Changing the password at the bureau
must be done outside the system. Contact the credit bureau for the
procedure for changing the password (display only).

Auth User ID Displays the authorization user ID (display only).

Auth Password Displays the authorization password (display only).

Note: This field is not displayed to the user and is also encrypted
before being stored in the database (display only).

Change Authorization User Id/Password section

New Auth User Id | Specify the authorization user ID.

New Auth User Specify the authorization user password.
Password
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Field Do this:

TransUnion Details section

(Note: This is only applicable for TransUnion.)

Market Specify the TransUnion market id.
Sub Market Specify the TransUnion Sub Market id.
Industry Specify the TransUnion Industry code.

Experian Details section

(Note: This is only applicable for Experian.)

Preamble Specify the Experian preamble code.
Host Code Specify the Experian host ID.
uiCc Specify the Experian UIC.

Equifax Details section

(Note: This is only applicable for Equifax.)

Service Name Specify the equifax service name. The service name will be pro-
vided to you by Equifax when your company's Internet System to
System account is created. Possible values for pulling credit reports
are acrotest (for access to the test system) and acro (for access to
the production system).

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Report Format Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Report Specify the report name to be accessed from the credit bureau.

Report Type | Select the report type of the credit bureau report from the drop-down list.

Score Type Select the credit score type from the drop-down list.

Addl Product | Select the product code from the drop-down list.

Inquiry Limit | Select the inquiry limit for the credit report from the drop-down list.

Enabled Check this box to enable the report as default.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.2 Connections
The Connections screen records and supports various connections to the credit bureau to
receive reports from the agencies. The system supports connections to the bureaus through

one or more modems attached to the database server, network accessed modem server, or
direct network connection (usually frame relay).
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For modem-based connections, multiple credit bureaus can be accessed over the same
modem. If there are multiple requests in the queue, the order in which the bureaus are listed
determines the order in which the requests are processed.

For example,

If the credit bureau service checks the submitted credit requests and finds three Experian, one
Equifax, and two TransUnion credit requests and the connections setup is Bureau1=TUC,
Bureau2=EFX, and Bureau3=EXP, the two TransUnion requests will be processed first, the
Equifax request next, and then the three Experian requests.

Note

For this above example, adding two more modems and assigning a specific bureau to
each one would help to avoid the delay caused by queuing all requests through a single
modem.

IMPORTANT: Direct network connections must be set up for only one bureau.

Like the Credit Bureau section on the Report Formats screen, the data fields used on the
Connections screen are generic and not all fields are used for all access methods. The
following table summarizes the data needed for each access method:

Method Name Bureau 1 | Bureau Bureau Device Device Speed
2 3
Dial-up Required Required Optional Optional Required (can be either | Required for
{can he {can be (can he alocal serial port device | locally attached
EXP, EXP, EXZP, ot anIP address and modems
TUC, or TUC, oz TUC, aor port number of a
EFX) EFx) EFE) netwrark mode )
Experian Fequired | Mustbe Leave Leawe Lulust be the IP address | Iot appliceble
Frame-relay EXT blank blank and port number of
Experian host
Ecuifax Required Must be Leave Leawe Must be the IP address Mot applicable
Frame-relay EFX blatlc bl arnk and port number of
Equifax host
TranslUnion Reguited | Must be Leave Leawe Liust be the IP address | Mot applicable
Frame-relay TUG blarile blank and pott number of
TransUnion host
Experian Net Reqguired Must be Leave Leawe DTiust be the ECALS Mot applicable
Connect EXP blatk blatk URL provided by
Experian
Eguifax Requited | Musthe Leave Leawe Llust be the URL Mot applicable
[nternet EFX blaride blank provided by Eguifax for
Systemto connecting to the
System Internet System to
System service
CEC Internet Required hust be Leave Leawe Dlust be the URL Mot applicable
o3 blank blank provided by C3C
CredcoConnect | Requited | Must be Leave Leawe Dulust be the URL Mot applicable
CRD blarile blank provided by Credco

For frame relay access, specify the IP address provided by the bureau followed by a space
and then the port number (for example, 192.168.36.2.700).

Experian Net Connect

At the time of this writing, the Experian product ECALS URL is:
http://www.experian.com/lookupServletl?lookupService

Name=AccessPoint&lookupServiceVersion=1.0&serviceName=Net
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Connecté&serviceVersion=2.0&responseType=text/plain

Note

The URL given above is one continuous string. This can be verified by entering the URL
with a browser. The displayed value will be an HTTPS URL.

Enter the entire ECALS URL provided by Experian into the Device field. Notice that this URL
does not start with https. The ECALS URL is a URL used by the credit bureau service to
request the HTTPS URL. The HTTPS URL is not displayed on any setup screen and is only
known to the credit bureau interface at runtime.

Equifax Internet System to System

At the time of this writing, the Equifax Internet System to System URL is:

https://transport5.ec.equifax.com/servlet/stspost

CSC Tri-Merge
At the time of this writing, the CSC URL is:

https://www.emortgage.Equifax.com/cgi-bin/emspop.exe
To setup the Connections
1. Click Setup > Setup > Administration > User > Credit Bureau > Connections.

2. In the Credit Bureau Connections section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE" - x & Welcome, PRAKRRAD = o
Financial Services Lending and Leasing
T Credit Bureau [ Close
> Origination Report Formats  Conmections  Zip Mabrix ~ Parameters  Score Reasons  Reporting
> Servicing
> Collections Credit Bureau Connections deadd | Fedt | [Eview | o Audit
- View v Format~ B Freezze & Detach J wrap o0}
> Tool Name Bureau 1 Bureau 2 Bureau 3 Device Device Spaed Enabled
ools
N
Setup EFX TEST FILES EFX hitps://transports. . NA ¥
Setup EXPTESTFILES  BXP https:/jdm1.exper... NA ¥
b ~ TUCTESTFILES  TUC htips://netaccess-.. NA Y
System
System Parameter Credit Bureau Connections
Lookups Saveand Add || [ Save and Stay || [ Save and Retun || {3 Retum
User Defined Tables
Audit Tables -
* L * Enabled
User Defined Default e borel 3 [~] Enated []
Transaction Codes Bursaul 2] * Device
gatda Files Bureau 2 [v] * Device Spesd
edupe
Securitization
Events

Batch Jobs i
Producer Cycles
Vendors
Collection Cycles
Reports
Error Messages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence:
General Ledger
Queves
Printers
Bank Details
Check Details
Standard Payees
Currencies
7ip Codes
Products
< >
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A brief description of the fields is given below:

Field: Do this:

Name Specify connection name.

Bureau 1 Select first credit bureau from the drop-down list.
Bureau 2 Select 2nd credit bureau from the drop-down list.
Bureau 3 Select 3rd credit bureau from the drop-down list.

Note: The Bureau1, Bureau2, and Bureau3 fields in the Credit Bureau
Connections section specify which bureau types can be accessed over
the connection.

Device Specify the connection device name. The Device field lists the physical
device name for a modem, or the IP address for a network accessed
connection.

Device Speed | Select the connection device speed. The Device Speed field is only
applicable to server-attached modems. It is used to specify the com-
munications speed between the server and the modem.

Enabled Check this box to enable the connection.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.3 Zip Matrix

The system uses the zip code of the applicant’s current home address to determine which
credit bureau to use when automatically pulling a report. The Zip Matrix screen allows you to
record the credit bureau from which a report is pulled based on a range of zip codes, as well
as the company, branch and country of the account.

When searching for a zip code match, the system:

1. Reads the first credit bureau defined in the matrix

2. Reads the credit report format to get the appropriate membership code and password for
the user’s location

3. Requests a credit report.

If the system cannot pull a report from the first bureau, it pulls one from the second. If the zip
code you entered does not fall in the matrix setup, then the system uses a default zip matrix
(0000000000 to 0000000000) to select the required bureau.

To set up the Zip Matrix
1. Click Setup > Setup > Administration > User > Credit Bureau > Zip Matrix
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2. Inthe Credit Bureau Zip Code Matrix section, perform any of the Basic Operations

mentioned in Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

APKELKAR ~ o

 DashBoard CrEpoeasy
> Origination Report Formats | Connections | Zip Matrix | Parameters | Score Reasons | Reporting
_» Servicing
b Callections, Credit Bureau Zip Code Matrix .
i View w Formatw Freeze iffiDetach gl Wrap o]
Company Branch Country
7 Tools AL AL UNITED STATES
Setup AL AL UNITED STATES
AL AL UNITED STATES
setup i ALL ALL UNITED STATES
Admiistration AL AL UNITED STATES
System ALL ALL UNITED STATES
System Parameter ALL ALL UNITED STATES
Lookups AL AL UNITED STATES
User Defined Tables AL AL UNITED STATES
Audit Tables AL AL UNITED STATES
User Defined Defaults AL AL UNITED STATES
Transaction Codes  |& AL AL UNITED STATES
Data Fies AL AL UNITED STATES
Dedupe AL AL UNITED STATES
Securitzation AL AL UNITED STATES
Events f
Kbt ks Credit Bureau Zip Code Matrix
Producer Cydles
Vendors
Collection Cycles
Reports *Company | ALL =
Errar Messages *Branch | ALL =]
Translations
fo *Country | UNITED STATES [«
Organization
Companies
Aceess
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currendes 3

From Zip

0000000000
0000000000
0000000500
0000001400
0000003000
0000007000
0000015000
0000017800
0000020000
0000025300
0000025500
0000025500
0000025700
0000025800
0000026100

*From Zp 0000000000
*ToZip 0000000000

*Bureau1 TUC

To Zip

0000000000
0000000599
0000001399
0000002559
0000006999
0000014399
0000017799
0000019999
00000252589
000002549
0000025599
0000025699
0000025799
0000026099
0000026299

o o
Bureau 1 Bure
T =]
Tue EFX
EXP EFX
Tue EXP
T EFX
T e
Tue EFX
EFX Tue
EFX Tuc
EFX BXP
EFX Tuc
Tue X
EFX Tue
EFX BXP
EFX Tue
[ save and stay
Bureau 2
Bureau 3

EN

Bureau 3

R 7
EXP o
TUC

EFX

EXP

EFX

BXP

P

EXP

TUC

EXP

EXP

P

TUC

EXP -

au 2

[ save and Retum

CaRetum

EXP =
EFX [«

A brief description of the fields is given below:

Field: Do this:

Company

Select the portfolio company from the drop-down list.

Branch

Select the portfolio branch from the drop-down list. The branch will be
displayed based on the company selected.

Country

Select the country from the drop-down list.

From Zip

Specify the starting zip code (From).

To Zip

Specify the ending zip code (To).

Bureau 1

Select the preferred bureau #1 (first bureau pulled), from the drop-down
list. You must enter at least one credit bureau in the Bureau 1 field for
each zip code range. The bureau entered in the Bureau 1 field for each
range is the primary bureau. For any given range, do not list the same
credit bureau in more than one field.

Bureau 2
down list.

Select the preferred bureau #2 (second bureau pulled) from the drop-

Bureau 3
list.

Select the preferred bureau 3 (third bureau pulled) from the drop-down

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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3.5.1.4 Parameters

The Parameters screen records parameters specifically dealing with credit bureau
information. These parameters are divided into three groups:

e Parsing parameters
e Request parameters
e Configuration parameters

Parameters can be defined at the company or branch level. The following credit bureau
parameters are configured during the installation:

PARSING PARAMETERS FOR CREDIT BUREAU SERVICE
CONFIGURATION PARAMETERS FOR CREDIT BUREAU SERVICE
The following credit bureau parameters are configured during implementation:

REQUEST PARAMETERS FOR CREDIT BUREAU SERVICE
To setup the Parameters
1. Click Setup > Setup > Administration > User > Credit Bureau > Parameters.

2. Inthe Credit Bureau Parameters section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE | ) ) | R — o
Financial Services Lending and Leasing
DashBoard Credit Bureau y 3 Close:
> Origination Report Formats | Connections | Zip Matrix = Parameters | Score Reasons | Reporting
> Servicing
D Colletions Credit Bureau Parameter G add | AEdt | Elview | o Audit
S WP View ~ Formatw (B Fresze ! Detach I Wrap @
Company Branch Parameter Group  Parameter Parameter Value  Enabled
> Tools -
Setup ALL ALL PARSING PARAME... AL N ¥ ~
Setup ALL ALL PARSING PARAME . A Y id
Administration ~ ALL AL PARSING PARAME... MAXIMUM AMOUN... -2 ¥
SY;EW ALL AL PARSING PARAME... MINIMUM AMOUN... -2 id
System Parameter ALL AL PARSING PARAME .. MAXIMUM AMOUN... -2 Y
Lockups AL AL PARSING PARAME... MINIMUM AMOUN... -2 ¥
S — AL AL PARSING PARAME.. ACCOUNTS WITH.. Y ¥
e De‘,'z'er Febles ALL AL PARSING PARAME.. COLLECTIONTTE.. N Y
fud Taf'e; : AL aL PARSING PARAME... COLLECTION ITE... N ¥
Leeulipmed Dol AL AL PARSING PARAME... CSCCLOSED STA.. 8,9 ¥
[ Cides AL AL PARSING PARAME... DAYS OLD THAT... -1 Y
Detaifden AL AL PARSING PARAME... DELETE THE BXPE.. N ¥
Dedupe AL AL PARSING PARAME... DERIVE MISSING.. Y ¥ v
i ALL ALL PARSING PARAME .. EOQUIFAX NARRAT .. . ¥
Events
Era;t;;b;da_ ! Credit Bureau Parameter
R Bl soveandadd | B soveand Stay | B soveand Return || GaRetum
Collection Cycles
Reports = Company ALL [v] = Parameter >
Error Messages — sy
Transiations Bearch ALl ] Enabled []
fik * Parameter Group
Organization
Companies
Access
Users.
Credit Bureau
Comespondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products ™
< I >
A brief description of the fields is given below:
Field: Do this:
Company Select the portfolio company from the drop-down list.
Branch Select the portfolio branch from the drop-down list. The branch will
be displayed based on the company selected.
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Field: Do this:

Parameter Group Select the credit bureau parameter group from the drop-down list.

Parameter Select the credit bureau parameter from the drop-down list

Parameter Value Specify the credit bureau parameter value.

Enabled Check this box to enable the credit bureau parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.5 Score Reasons

The Score Reasons screen allows you to define or modify the scoring reason codes and
descriptions for the predefined scoring models used by the credit bureau agencies.

Note

This information is not associated with the user-defined scores determined by the internal
Oracle Financial Services Lending and Leasing model during product setup.

To setup the Score Reasons
1. Click Setup > Setup > Administration > User > Credit Bureau > Score Reasons.

2. Inthe Score Models section, you can view the following information.

ORACLE’
Financial Services Lending and Leasing

[®dose

o— Credit Burean

 Origination ReportFormats | Connections  ZpMatrix  Parameters  Score Reasons | Reporting

> Servicing

»» Collections

> WFP

» Tools

Setup
Setup
Adrinistration
System
System Parameter
Lockups
User Defined Tables
Audit Tables
User Defined Defaults
Transaction Codes
Data Fies
Dedupe
Searitization
Events
Batch Jobs
Producer Cydes
Vendors
Collection Cycles
Reports
Error Messages
Tranglations
User

Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Frinters
Bank Details
Check Details
Standard Payees
Currendies

Score Models
View ~ Format ~

Score Model
) NEW NATIONAL RT
EQUIVALENCY MO
EXPERIAN/FICO T
EXPERIAN/FICO A.
EXPERIANJFICO P

Score Reasons
View ~ Format ~
Reason Cade
1
10
1
12
13
14
15
16
17
18
Columns Hdden 1

Score Reasons

B

Enabled

Freeze  ffiDetach

&

v
¥
¥
¥

B Freeze pfiDetach | ol wrap
Desription
Toa few accounts now current
Revalving accounts with high balance to limit ratios
Presence of non-satisfactory ratings on revolving bank accounts or lack of revolving bank accounts
Humber of revelving bank accounts
Number of recently apened retail accounts
Number of Service and Professional accounts (collections agency, medical, and utiity)
Lack of mortgage accounts
Presence of non-satisfactory ratings on mortgage accounts or lack of mortgage accounts
Lack of open retall sctounts
Mumberr of recent delinquendies

[ save and stay.

Reason Code 1
* Description TOO FEW ACCOUNTS NOW CUR!

[ save and Return

o Ayt

{aRetun

A brief description of the fields is given below:

Field:

Do this:

Score Model

Displays the credit bureau score model (display only).
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3.5.1.6

Field:

Do this:

Enabled

Displays if the credit bureau score model is enabled or not.

3. On the Score Reasons sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field

Do this:

Reason Code

Specify the reason code.

Description

Specify the description.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Reporting

The system reports to the credit bureau agencies in the Metro 2 format with the payment and
account status information of each account holder. The Credit Bureau Reporting screen
contains the program identifier to be reported to the bureaus.

To setup the Reporting
1. Click Setup > Setup > Administration > User > Credit Bureau > Reporting.

2. Inthe Credit Bureau Reporting section, perform any of the Basic Operations mentioned
in Navigation chapter.

ORACLE

Financial Services Lending and Leasing

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Setup
Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Default
Transaction Codes
Data Files:
Dedupe
Securitization
Events
Batch Jobs ‘
Producer Cycles
Vendors
Collection Cycles
Reports
Error Messages
Trenslations
User
Organization
Companies
Access
Users.
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products
< >

Credit Bureaur

Report Formats | Connections | Zip Matrix | Parameters | Score Reasons | Reporting

Credit Bureau Reporting
View ~ Formate [ Frecze i Detach { wrap (e
Company Bureau

Credit Bureau Reporting

* Company

e

* Bursau

* Program Identifier

Save and Add

e, PRAKRRAQ + [w=]
[ Clos=
o add | Edit | view || o audit

Program Identifier  Enabled
N

B saveand stey || [ Save and Retum || <3 Retum

* Enabled (]

A brief description of the fields is given below:

Field

Do this:

Company

Select the portfolio company from the drop-down list.
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Field Do this:

Bureau Select the bureau from the drop-down list.

Program Identifier Specify the program identifier. The customer receives this from
the bureau and uses it to identify itself to that bureau. You will
need to update this information.

Enabled Check this box to enable the program.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Special Metro Il Code reporting

The system allows you to report the following special Metro 1l segments to the credit bureau
output file:

e Consumer Information Indicator Code (CIIC)
e Compliance Condition Code (CCCD)
e Special Comment Code (SPCC).

The system users will need to use call Action/Results and Reason fields on the Call Activities
sub screen of the Customer Service form (Lending > Customer Service > Customer Service
(2) master tab > Account Details tab > Call Activities sub tab) to place specific account
conditions where these Metro 1l segments are to be reported. The specific segment reported
for a given condition will be based on the account condition and call activity reason codes.

Note

It is the responsibility of the Administrator or individual user to setup Special Metro Il Code
reporting functionality.

When users open one of the following conditions:

Code Description

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO?2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METRO2)

SPCC SPECIAL COMMENT CODE (METRO?2)

The system recognizes the condition, processes the selected Metro Il reporting call activity
reason code, and generates the Metro Il reporting segment in the Metro |l reporting output file.

Note

— You are responsible for selecting the correct Metro Il reporting segment reason
code to be reported. If you do not select a Metro Il reporting segment reason code,
the system will not generate information to Metro Il output file. If you select an
incorrect Metro Il reporting segment reason code, the system will report the
selected Metro Il reporting segment. the system does not validate the contents of
the Reason field with the contents of the Condition field.

— To end the reported Special Metro Il Special Code, close the open Special Metro I
Condition (no reason code needed). The system recognizes the closing of the open
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Special Metro 1l Condition and will not create a Metro Il reporting segment in the
output file.

— The CBU_FILE FREQUENCY (METRO 2 FILE FREQUENCY) Company system pa-
rameter determines if output file is generated and created daily or output file is writ-
ten with daily data and output monthly.

To setup Metro Il Code reporting

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Queues > Call Action Results to open and close the
following system defined condition codes:

Action Code | Description

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO2 - FCRA)
CCCD COMPLIANCE CONDITION CODE (METRO2)
SPCC SPECIAL COMMENT CODE (METRO2)

When setup is completed, you can open and close Special Metro Il code conditions.

Note

Opening and closing Special Metro 1l Code reporting is a manual process.

The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system parameter
determines, if output file is generated and created daily or output file is written with daily data
and output monthly.

Oracle Wallet Manager setup

The Experian Net Connect, Equifax Internet System to System, and CSC interfaces within the
the system credit bureau service use functionality provided by the Oracle Wallet feature. Use
the Oracle Wallet Manager on the database server to create and export a wallet for use by
the credit bureau service.

Note

All of the above mentioned interfaces use the same Oracle wallet. If a wallet already exists
and is in use by one of the credit bureau interfaces, there is no need to create another wal-
let. Due to differing certificate requirements, there may be a need to import additional trust-
ed certificates into the wallet, but there will not be a need to create a new one. The credit
bureau parameter ORA_ WALLET PATH contains the location of the Oracle Wallet used
by the credit bureau service.

To create and export a wallet suitable for use by the credit bureau

Refer to the Oracle documentation for more detailed instructions on how to use the Oracle
Wallet Manager to create and manage a wallet:

1. If a wallet does not already exist, create one somewhere on the database server. The
location must be readable and writable by the Oracle user. Make a note of the full path
where the wallet is stored (for example, /etc/ORACLE/WALLETS/oracle or
C:\oracle\WALLETS).
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e For Transunion credit bureau, a separate wallet file is needed under transunion folder
inside the main wallet path (for example: /etc/ORACLE/WALLETS/oracle/transunion or
C:\oracle\WALLETS\transunion).

2. The wallet needs to contain the public key for the certificate authority that issued the
server certificate for each HTTPS web site that will be connected to by the credit bureau
interface. At the time of this document, those sites are:

https://ssl.experian.com Experian

https://transport5.ec.equifax.com Equifax

https://www.emortgage.Equifax.com CSC

This list may change. Use the URL provided to you by the credit bureau when they set up your
service. To get the proper Experian HTTPS URL, enter the ECALS URL that was provided by
Experian into a web browser. The response returned to the browser is the HTTPS URL that
will be used to communicate with Experian.

1. Import the necessary certificate authority’s certificate files into the Oracle wallet that was
created in Step 1. See the appendix of this chapter for detailed instructions of how to
download and install a trusted certificate.

2. Test the wallet by connecting to each web site with a simple command issued from
SQLPlus.

SQL> select utl http.request('https://ssl.experian.com', NULL,
'file:/etc/ORACLE/WALLETS/oracle', 'password') from dual;

Replace the URL in the above command with each HTTPS URL given to you for use by
the credit bureaus. Also replace the wallet path with the path to your wallet and your
wallet password. The output from the command is not important, what is important is
that it runs without displaying an Oracle error. If there is an Oracle error, then something
is wrong with the contents of the wallet, the path to the wallet, and/or the wallet
password.

3. When the wallet contains all of the required trusted certificates, export the wallet to a text
file. On the Operations menu of the Oracle Wallet Manager, choose Export All Trusted
Certificates. The text file MUST be located in the same directory as the wallet and the
filename MUST be default.txt. Anytime a change is made to the trusted certificates in the
wallet, the wallet must be re-exported to the same text file.

4. Inthe Setup > Setup > Credit Bureau > Parameters set the ORA WALLET PATH and
ORA_WALLET PASSWORD parameters.

Oracle JVM Security setup

The Experian Net Connect interface within the credit bureau service requires the use of the
Oracle Java Virtual Machine (JVM) that is resident in the Oracle database. Furthermore,
specific permissions must be granted to the Java classes used by the credit bureau service.
These permissions have been added to the set_java_perms.sql script that is part of the
distribution. This script (as well as many other useful SQL scripts) is available from the Oracle
Financial Services Software technical support Oracle Financial Services Lending and Leasing
patches web site.

The set_java_perms.sql script needs to run as the SYS user (or a user with SYS privileges).
The script will prompt for SYS user id and password. Be prepared to provide it when
prompted. Also, the script will select the value of the ORA_ WALLET PATH parameter from
the credit bureau parameters table. Make sure that it has been updated with the proper wallet
path before running the set_java_perms.sql script (although the script can be safely run again
if necessary).
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Credit Bureau Service operation

The basic operation of the credit bureau service has not changed. Once setup, there is no
operational difference between accessing the credit bureaus via dial-up, frame relay, or the
Internet.

Importing a trusted certificate into an Oracle Wallet

The HTTPS servers used by Experian, Equifax, and CSC for their Internet based credit report
services (as well as all HTTPS servers) contain a site certificate signed by a trusted Certificate
Authority (CA). The CA is an entity that guarantees the identity of the HTTPS server. If the
client trusts the CA, and the CA says that the HTTPS server is who they say they are, then
the client inherently trusts the HTTPS server. Normally, a client tool such as Microsoft Internet
Explorer has a large store of trusted CA certificates which makes secure communication
between a client and a trusted HTTPS server relatively seamless and uneventful.
Unfortunately, the store of CA certificates in the default Oracle wallet is rather small and it is
likely that it will not contain the certificate of the CA that is certifying one or more of the credit
bureau web sites. This means that the CA certificate must be imported into the wallet. To do
this, the certificates must first be exported from a browser and then imported into the Oracle
wallet using the Oracle Wallet Manager.

Using Microsoft Internet Explorer to Export a Certificate

1. Use Microsoft Internet Explorer and connect to one of the HTTPS URLs referenced in the
Oracle Wallet Manager Setup section of this document.

If the web site asks for a user id and password, cancel the dialog box and remain on the
top-level HTTPS screen.

2. Once connected, from the browser’s File menu, choose Properties.
Click the Certificates button.

4. Click the Certification Path tab. The bottom-most certificate is the one generated by the
host itself. The one or more certificates above the bottom-most one are of greater
importance to this task. The screen shot below displays a web site with two CAs (an
intermediate, and a primary). Whether it is an intermediate CA or a primary one, the steps
are the same for saving the certificate as a text file.

Certificate

General | Detale  Certification Path l

— Cettification path

VeriSign Clags 3 Public Prinnany T
e venz ign_com/CPS Incorp.

----- 331 ewperian.cam

by Fief, LLABILITY LT ()37

4 |
Wiew Certificate... |

Certificate status:
This certificate is OK.
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® N o

10.
11.
12.
13.
14.
15.

Click the first certificate above the bottom-most certificate (it may be the only certificate
above the bottom-most certificate).

Click the View Certificate button.

Click the Details tab.

Click the Copy to File button.

Click the Next button.

Choose the Base 64 encoded format.

Click the Next button.

Enter a filename and location for the file.

Click the Next button.

Click the Finish button.

Repeat steps 5 through 14 for the next certificate in the certification path, if any.

Importing the Certificates into an Oracle Wallet

1.

Copy the certificates exported and saved during the process described above onto the
database server (not the iAS server).

As the Oracle user (or Administrator on Windows), start the Oracle Wallet Manager.

Open the wallet that will be used by the credit bureau service. Create a new wallet if one
does not already exist.

View the list of Trusted Certificates in the wallet.

Check the list of certificates against the list of certificates that are in use on the HTTPS
servers used by the credit bureaus (and that were exported and saved during the export
process described above).
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6. Click the Trusted Certificates heading in the left list box of the Oracle Wallet Manager.

=122

Wallel Operations Help

o0aie Certcates KeySze Expie Date
gCemﬁca!e:[EmpM 3 Class 1 Putli Primary Certfcaton Authorty 1024 January7, 2020
73 Class 2 Public Primary Certfication Authority 1024 January 7, 2004
A Clase | Puble B 0256 3 pubicPrimanyCerticaion Authory 1024 Januany 7, 2004
3 Class 2 Public 73, Secure Servr Certifization Authority 1000 January7, 2010
=7 Class 3 Public M= 67 oppsiTrust Root 1024 Febuary 23, 2006
7R Secure Servar | 3 GTE CyberTrust Glabal Root 1024 August 13,2018
2, 0TE CyperTrus S =3 Entrust net Secure Senver Certication Autorly 1024 May 25, 2019
R GTE CyberTrus =5 EntrusLnet Certification Authorlty (2048) 2048 December 24,2019
- Entrustnet Sec S = Entrustnet Secure Server Certfation Auhorly 1024 Fetnary 4, 2020
=3 Enlustnet CeJ 5 Class 3 Public Primary Centfication Authority 1024 August1, 2028
L Entrustriet Sec| |, wwerision comiCPS Incorply Ref LIABILIT,. 1024 Octobier 24, 2011
-3 Class 3 Public
-ﬁm.verisign.cl

7. Use Microsoft Internet Explorer to view the certificate details for the HTTPS web sites
(File > Properties > Certificates > Certification Path > View Certificate > General)
that will be contacted by the credit bureau service. Look through the list of certificates
shown in the right panel of the Oracle Wallet Manager and look for a match between the
Issued To and Valid To dates shown in the Internet Explorer View Certificate screen.

The screen shot below shows a certificate that is already in the wallet’s list of trusted
certificates (see the last entry for the www.verisign.com/CPS certificate).

Certificate

General| Details  Certfication Path I

~ Certification path

« | bl
Wiew Certificate:.. |

Cerificate status:
This certificate is OK.

3-40 ORACLE



3.5.7

8. Onthe Operations menu, choose Import Trusted Certificate and follow the prompts for
locating and loading the files that were copied onto the database server in step 1 for any
certificate not already stored in the wallet.

9. On the Wallet menu, choose Save when finished loading certificates.

De-duping Credit Bureau data

Oracle Financial Services Lending and Leasing allows you to remove duplicate (“de-dupe”)
liabilities data from the credit bureau information.

De-duping logic

The de-duping logic is based on a number of parameters that the system compares among
tradelines (only) to determine if they are duplicates. The following fields are used to
determine if two tradelines are duplicates:

Field: Description:

Account # The account number of the consumer with the lender for the particular
account.

Open Date The date the account was opened.

Member Code | The subscriber code of the lender with the respective credit bureau.

Note: Since member codes for the same lender differ across bureaus,
this field is used only for tradelines reported by the same bureau. Since
reports obtained from CSC can have tradelines from different bureaus,
this field is only for reports pulled from the credit bureaus.

All available bureau reports pulled later than DEDUP_CRB_EXPIRATION DAY days old will
be used.

The following system parameters will be set up to provide switches to allow the functionality
to be turned on and off:

Parameter Description Valid | Setup
Values Value
JOMT_DEDUP_SPOUSE_LIABILITIES | De-deup the tradelines with spouse YoM b
JOINT_DEDUP_ALLAPL_LIABILITIES De-deup the tradelines with spouse | Y, W b
and secondary applicant=(=z).
DEQCUP_CRB_EXPIRATION_DAYS Creedit report expivation days Mumker a0

Whenever two (or more) items are identified as duplicates, Oracle Financial Services Lending
and Leasing uses the following hierarchy to pick one of the items as the “correct” one:
1. Last Reported Date: The row that has been reported most recently is used.

2. Owner: In case of a tie on the last reported date, one of the tradelines is picked in the
descending order of priority depending on who the tradeline belongs to: Primary, Spouse,
then Secondary.

Debt Ratio combination

Oracle Financial Services Lending and Leasing uses the system parameter

DBR _JOINT INC DEBT WITH_SPOUSE to decide whether to combine debt ratios of the
spouse with the primary applicant. The DBR _JOINT INC DEBT WITH COAPP parameter
decides whether to do the same on a non-spousal joint application.
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When this indicator is checked, all liabilities in the Liability section on the Summary sub screen
of the Applicant (2) master tab with the Include box selected will be used in the debt ratio
calculation.

The following system parameter will be set up to provide switches to allow the functionality to
be turned on and off:

De-duping process

The de-duping logic will be integrated into the system decision-making process in the
following manner:

Initial credit pulls on new applications

e Ifthe JOINT DEDUP_SPOUSE LIABILITIES/ JOINT DEDUP ALLAPL LIABILITIES
system parameters are set to Y, uses the de-duping logic described above to uncheck
the duplicate liabilities in the spouse's/co-applicant’s liabilities.

e Ifthe DBR JOINT INC DEBT WITH_SPOUSE/
DBR _JOINT INC DEBT WITH_ALLAPL parameters are setto Y, the system includes
the liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary
applicant.

e The system will use all available credit reports at the time.

Subsequent credit pulls (manual)

e Toremove duplicate liabilities from the calculation, choose the Dedup Liabilities button
on the Underwriting form (Applicants master tab > Summary sub screen > Liability
section). (Potential record locking situations force the action to remain manual versus
the system automatically doing it).

e Ifthe Populate Debt and Include Debt boxes are selected in the Applicant/Customer
Detail section on the Bureau master tab on the Underwriting form for the credit
request and the JOINT DEDUP_SPOUSE_LIABILITIES/

JOINT DEDUP_ALLAPL_LIABILITIES system parameters are setto Y, the system will
use the de-duping logic described above to uncheck the duplicate liabilities in the
spouse's/co-applicant's liabilities.

e Ifthe DBR_JOINT INC DEBT WITH SPOUSE/

DBR _JOINT INC DEBT WITH COAPL parameters are settoY, the system will include

the liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary
applicant.

e The system will use all available credit reports at the time of the request that have been
requested within the number of days specified in the DEDUP_CRB_EXPIRATION DAY'S
parameter.

Restrictions

The de-duping logic will be limited based upon the discussion above. If the system cannot
identify two tradelines as duplicates based upon the logic mentioned above, the individual
tradelines will be retained. In such circumstances, both tradelines will be used in the debt ratio
calculation and it will be the user’s responsibility to disregard one of them by clearing the
Include check box.

Correspondence

The Correspondence screen enables you to setup the system'’s correspondence.
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The system provides two types of correspondence: predefined and ad hoc. The following
chart provides a quick summary of both:

TYPE OF CORRESFONDENCE: PREDEFINED

Created automatically
Created manually

Generated for accounts

Generated for applications

Set up with the Correspondence link

Set up with the Letters link on the Product link

This chapter explains how to setup ad hoc correspondence with the Correspondence form.

The Correspondence screens provide a cost-effective and easy to use method to build
custom documents that draw information from the system’s database without additional
programming. You can choose what to include in a letter, create a template, and then use this
template to produce a letter.

The core of the Correspondence module is the document element -- the information stored in
the database merged into the correspondence. The system has document elements defined
for commonly used data elements in correspondence, such as account numbers, account
balances, customer addresses, telephone numbers, and due dates.

Correspondence consists of a document file with text of your choice and the document
elements from the system’s database.

You can create a correspondence set that consists of one or more documents. If a
correspondence set consists of more than one document, such as the account details letter
and a payment overdue letter, it prints both documents every time the system generates
correspondence for a customer.

The Correspondence module creates the following standard ad hoc correspondence:

e Microsoft Word (RTF)
e Adobe Acrobat (PDF/XFDF)

Note

In this document and in the system, the term BANKERS SYSTEM is synonymous with
Adobe Acrobat.

Correspondence

The Correspondence screen contains the following sub screens:
e System Functions
e Elements
e E-Form Elements
e Documents
e Correspondence

Navigating to Correspondence

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Correspondence.
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System Functions

The System Functions screen enables you to view the predefined functions for the
appropriate Lease product in the system. These are attributes from the database.

Functions define how the system retrieves data to include in correspondence. The data is
retrieved as elements which are either specific database columns or calculated values.

Elements are recorded on the Elements screen.

To view the predefined system functions

1. Click Setup > Setup > Correspondence > Lease > System Functions.

2. In the Function Definition section, you can view the following information.

ORACLE

Financial Services Lending and Leasing

& Welcome, PRAKRRAO o

DashBoard
> Origination
- Servicing
> Collections
> WFP
> Tools
setup
Setup
Administration
System
System Farameter
Lookups
User Defined Tables
Audit Tables
User Defined Default
Transaction Codes
Dats Files
Dedupe

itization

Batch Jobs )
Producer Cydes
Vendors
Collaction Cycles
Reports
Error Messages
Transiations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Quaues
Frinters
Bark Details
Check Details
Standard Payess
Currencies
Zip Codes
Products
< >

Correspondence
Common | loan | Line Lease

System Functions  Elements

E-Form Elements || Documents || Correspondence

Function Definition

View~ Format~ [ Fresze i Detach ] wirap (5]
Function Name: Description
GET_ACC_121 DTLS Get Account Details (Leass CE)
GET_ACC_CON_121_DTLS  Get Account Contract Details {Lease CE)
GET_S _DTLS Get Application Details (Leas= CE)

S ADC_121_DTLS Get Application Decisions (Lease Close Ended)
GET_APP_CON_121 DTS Get Application Contract Details (Lease CE)

Function Parameters

View = Formatw [ Fréeze  Efi Detach Jl wrap 5]
Position Parameter Descriptien
1iv.10.ACCid Account 1D
2 iv_name_ar Parameter Name
3 iv_value_ar Parameter value

Function Type

COR_ELM_PROC
COR_ELM_PROC
(COR_ELM_PROC
COR_ELM_PROC
COR_ELM_PROC

[®] Close.

Source Program
CGNACC_EL 1
CGNCON_EL 1!

A brief description of the fields is given below:

Field:

View this:

Function Name

Displays the function name.

Description

Displays the function description.

Function Type

Displays the function type.

Source Program

Displays the source program.

3. Inthe Functions Parameters section, you can view the following information.

A brief description of the fields is given below::

Field:

View this:

Position

Displays the parameter position.

Parameter

Displays the function parameter.
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Field: View this:

Description Displays the function parameter description.

3.6.1.2 Elements

The Elements screen displays the predefined document elements retrieved from the
database when the correspondence is generated.

In the Element Definitions section, you can update or edit only the Description field.
To view the Elements
1. Click Setup > Setup > Administration > User > Correspondence > Lease > Elements

2. On the Element Definitions screen, perform any of the Basic Operations mentioned in
Navigation chapter. You cannot add a new record.

ORACLE’ & Welcome, PRAKRRAQ v o
Financial Services Lending and Leasing :
DashBoard Correspondence 5 [ Gose
- Origination Common | loan | fine Lease
> Senvicing System Functions  Elements  E-Form Elements | Documents  Comespondance
> Collections
> Wep Elements et | Eview || o audt
> Tools Vieww Fomate [ Fréeze  Efi Detach ) wrap
Setup Levelo Type Element Name Element Type Destription Data Type Source Function
Sutin acc ACC_ADS_LTFE_121 5 ACCOUNT ADS LIFE NUMBER GET_ACC_121_DTIS
2 T ~ ACC ACG_DEPREGIATION_METHOD_CD_121 s ACCOUNT DEPRECIATION METHOD CODE VARCHAR2 LS
i acc ACC_DEPRECIATION_START_DT_121 s ACCOUNT DEPRECIATION START DATE DATE
L AT ACC_DEPRECIATION_VALUE 121 s ACCOUNT DEPRECIATION VALUE NUMBER
:Z:S:S feaiod acc ACC_EOT_VALUE 121 s ACCOUNT EOT VALUE NUMBER
& ACC ACC_FIRST_LAST_YEAR_CONV_CD_121 s ACCOUNT FIRST LAST YEAR CONV CODE VARCHAR2
ey Dehittst Tables acc L s ACCOUNT LEASE TAX BOOK TYPE CODE VARCHAR2
Audit Tables ACC s ACCOUNT LEASE TERMINATION TYPE CODE VARCHAR2
e Dot et N acc s ACCOUNT TAX LIFE NUMBER
i acion Godes acc s ACCOUNT TAX SALVAGE VALUE NUMBER
Datz Files AcC s ACCOUNT TERM P! NUMEER
Bedipe PP s APPLI NUMBER
Securitization a7 s NUMBER
ap s NUMBER
‘4 AP s NUMBER
app s N RENT FACTOR NUMBER
Vendors App s RESIDUAL PER NUMBER
Collection Cycles = s NUMBER
Reports app 1 s APPLICATION ADS LIFE NUMBER
Error Messages aep APP_APPROX CASH PR 121 e APPLICATION APPROX CASH PRE NUMAFR
Translations <
User
Organization Elements
Comparies B saveand sy | [ seveand Retum || G Retum
Access
ge_:n —— ) Leveld Type ACC ] * Description | ACCOUNT ADS LIFE Er-j bled ¥
St Element Neme AQC_ADS_LIFE 121 el Ty Sl Default Value
General Ledger Element Type 5 Source Function GET_ACC_121_DTLS
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
7ip Codes
Products ™
< >

A brief description of the fields is given below:

Field: Do this:

Level0 Type Displays the element LevelO type.

Element Name Displays the element name.

Element Type Displays the element type.

Description Specify the element description.

Data Type Displays the element data type.

Source Function | Displays the element function.

Enabled Displays if the element is enabled or not.

3-45 ORACLE



3.6.1.3

Field: Do this:

Default Value Displays the default value.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

E-Form Elements

The E-forms Elements screen defines elements included when the system generates online
correspondence with a browser. The E-forms screen is set up only for PDF elements using
the XFDF format. These definitions translate the external element required by the vendor to

a systems correspondence element.

For example,

Type

Details

Vendor Element

AlIBorrowers.FullNameStreetCityStateZip

(Contains names of all borrowers with address of
primary customer)

The system’s Elements

PRIM_APL _NAME
SPOUSE_APL_NAME

PRIM_APA_ADDRESSI
PRIM_APA_ADDRESS2
PRIM_APA_ADDRESS3

Translation:

PRIM_APL NAME|',' || SPOUSE_APL NAME]|","||
PRIM_APA_ADDRESSI || ';'|[PRIM_APA_AD-
DRESS2 || ;' || PRIM_APA_ADDRESS3

To setup the E-forms Elements

1. Click Setup > Setup > Administration > User > Correspondence > Lease > E-Form

Elements
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2. In the E-form Elements Definitions section, perform any of the Basic Operations
mentioned in Navigation chapter.
ORACLE  Welcome, PRAKRRAD v =
Financial Services Lending and Leasing
S Correspondence . 38 Close
> Origination Common Loan Line Lease
> Servicing System Functions  Elements  E-Form Elements | Documents | Comrespondance
> Collections
> WEp E-Form Elements Fadd | Aedi | Ew 7 aud
> Tools View v Fomatv [ Freere 5 Detach -l Wrap ®
Srting Level0 Type Source Code Element Name Description Data Type Code  Translation Enabled
N
Setup
Administration ) £ 2
System
System Parameter E-Form Elements
Laokups [ save and Add || [ save and stay || [ Save and Retum || Ga Retum
User Defined Tables
:\;:‘rt;:!\r(sd Default TAeeekiTyoe [¥] *Description *Enabled []
Transaction Codes * Source Code ﬂ *Data gés: ﬂ

Data Files
Dedupe
Securitization
Events
Batch Jobs ‘
Producer Cycles
Vendors
Collection Cycles
Reports
Error Messages
Translations
User
Organization
Comparies
Access
Users
Credit Bureau
Correspondence:
General Ledger
Queues
Printers
Bank Details
Chack Details
Standard Payees
Currencies
Zip Codes
Products
< >

* Element Name *Translation

A brief description of the fields is given below:

Field:

Do this:

Level0 Type

Select the element LevelO type from the drop-down list.

Source Code

Select the element e-form source code from the drop-down list.

Element Name

Specify the element name (the name used in the external form).

Description

Specify the element description.

Data Type Code

Select the element data type code from the drop-down list.

Translation Select the translation for the e-form element (SQL statement frag-
ment defining the element data), from the drop-down list.
Enabled Check this box to enable the e-form element.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.1.4 Documents

The Documents screen enables you to set up the various documents and the data fields that
the system compiles together when creating a correspondence. The system provides two
different document formats: Word or XFDF: XML-based form.
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Note

Oracle Financial Services Software assumes that the user is familiar with Word and the
Merge Document command. If the user is creating e-form documents with XFDF, then
Oracle Financial Services Software assumes that person is familiar with Adobe forms.

To setup documents to be compiled in correspondence

1. Click Setup > Setup > Administration > User > Correspondence > Lease >

Documents.

2. In the Document Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE

Financial Services Lending and Leasing

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Setup
Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Default
Transaction Codes
Data Files:
Dedupe
Securitization
Events
Batch Jobs ‘
Producer Cycles
Vendors
Collection Cycles
Reports
Error Messages
Trenslations
User
Organization
Companies
Access
Users.
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products

< >

Correspondence

Common | loan | Lne Lease

System Functions | Elements

Documents Definition

View v Format+  Ep
Code Description
TEST3 TEST3

Documents Definition

= Code
* Description

= File Name

Document Elements
View v Formatw [

Seq Type
No data ta display.

Document Templates
View~ Formate B
File Name Product
No data to display.

E-Form Elements | Documents | Correspondence

ezz G Detach dl wrap W 3 Gen. Dats File
File Name Levelo Type
TEST3 ACCOUNT

Freeze

*Level0 Type | ACCOUNT

urce | OFSLL

* Product ALL

z=  ipfli Detach Wrap 2t}
Element Name Description
Tt Detach ¢l Wrap 2t}
Customer State  Producer State

& Welcome, PRAKRRAQ + o
[ Close
dradd | AEdt | 2 vew | o2 Aud
E-Form Source Product Source Enabled
¥
OFSLL AL ORACLE: BI PUBLISHER Y
[ saveand add | Hl saveand stay | [ save and Retwm | G Retum
[v] Source ORACLE: BI PUBLISHER [v]
) Enabled
[+
eadd | A Edt | E View || <7 Audit
Data Type Format Mask Default Value Enabled
4 Add | /7 Ed = v o ud
App/Acc St New Template Loaded Enabled

A brief description of the fields is given below:

Field:

Do this:

Code

ment.

Specify the document code to define the name for the new docu-

Description

Specify the document description for the new document. This entry
appears in the Correspondence section on the Request screen,
when you generate an ad hoc correspondence.

File Name Specify the document file name for the resulting file (Word or XFDF
document).
Level0 Type Select the levelO type from the drop-down list.

E-form Source

Select the element e-form source from the drop-down list.

Product

Select the document product from the drop-down list.

Source

Select the document source type from the drop-down list.
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Field: Do this:

Enabled Check this box to enable the document definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Document Elements section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Seq Specify the sequence number to order the document elements.
Type Select element type from the following from the drop-down list. This

list provides the following options:

System-defined — If you select, the value is supplied by the system
and cannot be changed in the Correspondence Request screen.

Constant.

User Defined Element — If you select, you can choose the value
and change it in the Correspondence Request screen.

User Defined Constant — If you choose, you can choose the value,
but you cannot change it in the Correspondence Request screen.

Translated Element — If a document contains an e-form element
and you do not select this option, then the value will not be trans-

lated.
Element Name Select the element name from the drop-down list.
Description Specify element description.

Notes:

1. Check that the element name does not have blank spaces or
special characters, such as the forward slash “/” or backward slash
“”

2. If the element is system-defined, then the system will automati-
cally complete this field.

Data Type Select the element data type from the drop-down list.
Format Mask Select the element format mask from the drop-down list.
Default Value Specify the element default value.

Enabled Check this box to include the element in the document.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Document Template section, you can set the information about the template which
is attached to the correspondence documents. The template thus saved is similar to the
template functionality available in MS word. Perform any of the Basic Operations
mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

File Name Specify the file name to define the name for the new template.

Product Select the product for which the template is valid, from the drop-
down list.

Customer State | Select the customer state for which the product is valid, from the
drop-down list.

Producer State Select the Producer state for which the product is valid, from the
drop-down list.

App/Acc St Select the Applicant/Account state for which the product is valid,
from the drop-down list.

New Template Check this box to load the template as a new template.

Loaded Check this box to indicate that the template is loaded.

Enabled Check this box to enable the template.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

The Document Elements sub screen records the system'’s application or account information
that appears in the ad hoc correspondence
To generate a data file for a document

1. In the Document Definition section of Setup > Setup > Administration > User >
Correspondence > Lease > Documents, select the record for which you want to
generate a data file.

2. Click Gen. Data File button.
The system displays a new screen with the following options:

Opening CODEL &

You have chosen to open:

*L CODE1

which is a: Adobe Acrobat Document
from: hitps://10.184.132.155:7013

What should Firefox do with this file?

@ Open with | Adobe Acrobat (default) -

=) Save File

[ Do this gutomatically for files like this from now on.

0K Cancel
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3.6.1.5

e Open with — Select to view the data file in the format you want. The adjacent drop-down
list provides a list of formats compatible with the system. The system downloads the file
and displays it.

e Save File — Select to save the data file on your system.

3. Check the box Do this automatically for files like this from now on to apply selected
properties for the files which are similar to the current one.

Correspondence

The Correspondence screen enables you to define who will receive the documents you
created on the Document Definition screen by creating correspondence sets. Each document

must belong to a set, and a set can have more than one document.

To set up a correspondence set

1. Click Setup > Setup > Administration > User > Correspondence > Lease >
Correspondence. The correspondence setup is classified into two:

e Documents

e Functions

2. In the Correspondence section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

DashBoard
» Origination
> Servicing
»» Collections
> WFP
> Tools
Setup
Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Definad Default
Transaction Codes
Data Files
Dedupe
Securitization
Everis
Batch Jobs “«
Producer Cycles
Vendors
Collection Cycles
Reports
Error Messages
Trznslations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products

< >

Correspondence
Common || Loan | Line | Lease

System Functions || Elements | E-Form Elements | Documents  Correspondence

Correspondence
Viewv Fomat~ [P Freaze (24} Detach Wirap W
Code Description Print Schedule
TEST10 TEST10 ONLINE
<
Correspondence
* Code * Level /ACCOUNT
* Description * Group
* print Schedule [~ = Company AL
Documents  Functions
Documents
View v Fomaty [ Freeze [z Detach Wrap (5]
Documents Recipient

No data to display.

Level Group

ACCOUNT

[ saveand add | [l save and Stay | [ Save and Retum

01 BANKRUPTCY SET

[ Close
Padd | LEit | Ew 2 Aud
Company Branch
L Al

>

<@ Retun
*Branch ALL ﬂ
[v]

Include

A brief description of the fields is given below:

Field: Do this:

Code Specify the correspondence code.

Description Specify the correspondence description (required).

Print Schedule Select the correspondence output schedule type from the drop-
down list.

Level Select the correspondence level type from the drop-down list.
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Field: Do this:

Group Select correspondence group from the drop-down list.
Company Select the correspondence company from the drop-down list.
Branch Select the correspondence branch from the drop-down list.
Product Select the correspondence product from the drop-down list.
Enabled Check this box to enable the correspondence.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Setup > Setup > Administration > User > Correspondence > Lease >
Correspondence > Documents.

5. Inthe Documents section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Document Select the correspondence document from the drop-down list.
Recipients Select the recipients for the document from the drop-down list.
Enabled Check this box to enable the recipient selected.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
7. Click Setup > Setup > Correspondence > Lease > Correspondence > Functions.

8. Inthe Functions sub screen, you can define the functions that should be executed before
or after correspondence is generated. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Function Select the correspondence functions from the drop-down list.
Execute Select when to execute the correspondence function from the
When? drop-down list.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.2 Creating Correspondence

1. To create a correspondence add a record in the document definition block. For example:
SAMPLE_LOAN_APP

2. Inthe Document Elements section, add the elements required in the correspondence.
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3. Click on Gen.Data File to generate PDF file of the report.

£ SAMPLE_LOAN_APP (1).pdf - Adobe Reader EaRE=x]

File Edit View Window Help

RN N = =] Lla|le@®[=]|HB| e 2|

Tools Sign Commen

ORACLE’
Financial Services Lending and Leasing

<?xml version="1.0" encoding="UTF-8" 7>

<xs:schema xmins:xs="http://www.w3.0org/2001/XMLSchema" version="1.0">
<xs:element name="SAMPLE_LOAN_APP">

<xs:element name="PRIM_APL_BIRTH_DT" type="xs:string"/>
<xs:element name="PRIM_APL_NAME" type="xs:string"/>
<xs:element name="APP_REQ_ADV_AMT_100" type="xs:string"/>
<xs:element name="APP_APPROX_CASH_PRC_111" type="xs:string"/>
<xs:element name="ASE_APP_DESC_100" type="xs:string"/>
<xs:element name="PRIM_APL_SSN" type="xs:string"/>

<xs:element name="APA_ADDRESS1" type="xs:string"/>
<xs:element name="APA_ADDRESS2" type="xs:string"/>
<xs:element name="APA_ADDRESS3" type="xs:string"/>
<xs:element name="APE_NAME" type="xs:string"/>

<xs:element name="APA_PHONE" type="xs:string"/>

<xs:element name="APE_ADDRESS1" type="xs:string"/>
<xs:element name="APE_ADDRESS2" type="xs:string"/>
<xs:element name="APE_ADDRESS3" type="xs:string"/>
<xs:element name="APE_PHONE" type="xs:string"/>

<xs:element name="APL_EMAIL_ADDRESS1" type="xs:string"/>
<xs:element name="APL_NO_OF_DEPENDENTS" type="xs:string"/>
<xs:element name="APE_ACTUAL_MTHLY_AMT" type="xs:string"/>
<xs:element name="APP_PRO_NAME" type="xs:string"/>
</xs:element>

</xs:schema>

4. Copy and save the content in the pdf file as an xml file. The saved xml file should have
the same name as entered in the Code column of Document Definition section. For

Example: SAMPLE_LOAN_APP.xml.
5. Open MS Word.

Note

Oracle Financial Services Software assumes that BIP Desktop Tool is installed and the

user is familiar with the BIP Report Tool.

6. In Bl Publisher Tab in MS Word, click on Sample XML and import the saved xml file. For

Example: SAMPLE_LOAN_APP.xml.
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7. Create the template by inserting required elements tag.

Page lajout  References  Mailings  Review  View  Developer  BIPublisher

— e P )

|B| L U ~abe x, X' Aav|%~

Requested Loan Amount
Dealer

Approx Value of Asset
Description of Asset
Name of Applicant

Date of Birth

SSN

Name & Address of Employer

Employer Phone
Monthly Salary (Gross)
Number of dependants

Residence Address

Address Phone

E-mail

Page:1of1 | Words: 100 | &

8. The template created in MS Word should be saved with .rtf extension. For Example:

SAMPLE_LOAN_APP.rtf

AsBCel AwBbC AaBb( AaBbC AaBh( aspbcer | A4

TNormal | T No Spaci.. Headingl — Heading 2 Title Subtitle 75:;”"“
es

BANK
LOAN APPLICATION FOR PURCHASE OF ASSET

APP_REQ_ADV_AMT_100
APP_PRO_NAME
APP_APPROX_CASH_PRC_111
ASE_APP_DESC_100
PRIM_APL_NAME
PRIM_APL_BIRTH_DT
PRIM_APL_SSN

APE_NAME

APE_ADDRESS1
APE_ADDRESS2
APE_ADDRESS3

APE_PHONE
APE_ACTUAL_MTHLY_AMT
APL_NO_OF DEPENDENTS
APA_ADDRESS1
APA_ADDRESS2
APA_ADDRESS3

APA_PHONE

APL_EMAIL_ADDRESS1

Note

The .xml and .rtf file should be saved with the same name as entered in the ‘Code’ col-
umn of Document Definition section.

9. Upload the rtf template in the BIP and create the data model with SQL query as “select
CDO_XML_DOCUMENT from correspondence_docs where cdo_id = :docld”.

10. After the data model creation, launch the correspondence screen and click
Correspondence tab.

11. You can setup a correspondence with the created doc.

3.6.3 Generating Correspondence

1. Togenerate a correspondence open the application for which the correspondence should
be generated.

2. Click Correspondence tab. In the Correspondence section, click on Add.
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3. Selectthe created Correspondence. Click Save and Add to save and add a new record.
Click to Save and Return save and return to main screen. Click Return to return to main

screen without modifications.

‘ORACLE p— o
Financial Services Lending and Leasing
it Clase
 DashBoard fmitn v Mo
Origination Search/Task  Underwriting: 0000001050 Reviews Requsts (Pending: )
Origination
Siles Lead Application: 0000001050 GURLEY JENNIFER / TODD St | Blvien | o auit
Simple Applicaion Enty -
A‘:D:)‘;U::‘Et:t:" i Views Fomatv [ [[Frece ffoctah  JWamp @) OwrideOK v Wamingok v
Lok Prc
E::;';;”""“ |3 App# Sub Uit Status Egg;"“”’"m“ Producer Hame: ;zammgtus{nmer E;g}:ﬁ:{fnn Contact Sales Agent Branch Pror
Applicaion Retrieval 04J06/2015 0000001050 UNDEFINED NEW - REVIEW REQUIRED  REVIEW PRAO0002: PORSCHEINDL. .. ¥ ¥ DEMOSALES  USHQ ]
Scenario Analysis )
Applicaton Docunents
Tnage aintenance
Reports
Producers summary | Applicant  Business | Request  Dedsion Bureau | Collteral | Comments Tracking | Document  Verification | Correspondence | Tools
Vendors
Correspondence  Letters
Correspondence padd | Elvew | o Audt
Views Fomatv B [Fewe Pt v @ |
10 Cortespondence Date
0 02032016
4001 SAVPLE LDAN APPLICATION 1222015
Correspondence
[ saveandads | [ smeand stay | [ soveandRetum | CaRetun
* Correspondence v Date 02/09/2016
Documents
» Seniicing Views Fomaty B [[Frece Hoead  Jum @
> Collections Document Id Document Redpiert EfomSoce  SoureType Scleced  Generated
o data to display.
> WFP
> Tools
> Setup Document Elements Evew || & auit y
e . lmE . o

4. Click Generate to generate the selected correspondence and View Correspondence to
view the Correspondence in PDF format.

APPLICATION FOR PURCHASE OF ASSET

LOAN APPLICATION

Requested Loan Amount
Dealer

Approx Value of Asset
Description of Asset
Name of Applicant

Date of Birth

SSN

Name & Address of Employer

Employer Phone
Monthly Salary (Gross)
Number of dependants

Residence Address

Address Phone

E-mail

Signature of the Applicant
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BANK
FOR PURCHASE OF ASSET

20000.00

.00

2005 TOYOTA CAMRY
ANDREW WATT
07/15/1975
HKAXXKX2147

58, EAST 19TH STREET

HOLTSVILLE NY 00544
o

552230.00

o

34, WEST 69TH STN BCHN

NEW YORK MA 01730 US
o

ANDREW.WATT@XYZ.COM

| declare that the information given in the application is true to the best of my knowledge and belief
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3.71

Queues

When processing an application, various users might work on the application to complete
different tasks. A data entry person might complete the Application Entry screen before an
underwriter works on the application using the Applications screen. Later, another user might
use the Applications screen to fund the application.

The application processing workflow facilitates the movement of the application from one
person to another with queues. Queues create a work section of accounts waiting for a
particular and common task to be performed, such as application entry or verification. The
system’s powerful queuing module automates this otherwise manual process.

In the Queues setup screen, you can setup and manage workflow and work assignments on
a daily basis to ensure that all applications are in the queues of the appropriate users at all
times.

Any time an application’s status is changed, the system checks whether the application is in
the right queue.

The system will sort queues based on an application’s status and sub status.

Origination Tab

The Origination screen on the Queue Setup form allows you to set up queues that direct
applications to users during the loan origination cycle. Origination queues are based on an
application’s status and sub status. Whenever an application changes its status/sub status,
the system moves the application to a queue based on the information on this screen.

You can define the loan origination queues and the corresponding selection criteria based on:

e Application status

e Application sub status
e Product type

e Funding type

e Product

e Underwriter

e State

e Channel

e Producer type

e Producer

With loan origination queues set up, the applications in your work queue automatically appear
on the Results screen when you open the Underwriting or Funding screen. The queue to
which you are assigned appears in the Queue Name field. You would then begin processing
the applications in the order of which they are listed, double-clicking the application at the top
of the list to load it.

On the Setup > Setup > Queues screen, you can determine the direction of the applications
to users who process then. Whenever there is a change in the status or sub status of the
application, the system places the application in a appropriate queue based on the
information available in this screen.

Applications are further filtered based on the following criteria:

e Selection Criteria
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e Sort Order

e Responsibilities and Users
e Data Node Assignments

e Group Assignment

To setup Origination Queues

You can either define new Queue Definition details or specify a new name in the New Queue
field and click Create Copy to create a copy of selected queue definition with details.

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Queues > Origination.

2. Inthe Origination Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE SHEKAR ¥ 4@ Sign Out ‘=
Financial Services Lending and Leasing
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A brief description of the fields is given below:

Field: Do this:
Queue Name Specify queue name.
Queue Description Specify queue description.

Note: The system uses this entry when referring to the queue
on other forms.

Override Responsibility | Select an override responsibility code from the drop-down list.

The system uses this data to determine the User who holds the
override responsibility for the specified queue, if an application
triggers an “override” edit.

Priority Specify the priority number.

The system sorts applications by the higher number. For
example, an application with a priority # 5 is considered to have
a higher priority than the one with a priority # 3.

Company Select the company from the drop-down list.
Branch Select the branch drop-down list.
Enabled Check this box to enable the queue.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

Selection Criteria

Here, you can further filter the applications in a particular queue. This criteria is generally used
by organizations to categories and allocate large number of applications to different queues.

Note

If you want to execute search on like operators, then use '%'.

To setup Selection Criteria
1. Click Setup > Setup > Queues > Origination > Selection Criteria > Application Status

2. Inthe Application Status section, use the Status and Sub Status fields to define the
credit application status/sub status combinations that should be considered for the queue.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Status Select application status from drop-down list.

Sub Status Select application sub status drop-down list.

Enabled Select the check box to enable the application status.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

All is the default value for each field.

5. Click Setup > Setup > Queues > Origination > Selection Criteria > Selection Criteria.
In the Selection Criteria section, use the fields to define the credit application that should
be considered for the queue.

6. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Product Type Select the product type as loan from the drop-down list.
Funding Type Select funding type from the drop-down list.

Product Select product from the drop-down list.

State Select state from the drop-down list.

Channel Select channel from the drop-down list

Underwriter Select underwriter from the drop-down list.

Producer Type Select producer type from the drop-down list.
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Field:

Do this:

Producer Group

Select producer Group from the drop-down list

Producer Select producer from the drop-down list.

Region Select region of the producer from the drop-down list.
Territory Select territory of the producer from the drop-down list.
Sales Agent Select sales agent for the producer from the drop-down list.
Funder Select funder for the producer from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Sort

In the Sort sub tab of Queue Definition, the new applications which are in origination queue
are displayed here based on sort criteria defined. In case of any overrides, applications would
be sorted automatically without the need of a setup definition. However, there is no impact if
sort is not defined for a queue.

To setup Sort Criteria
1. Click Setup > Setup > Queues > Origination > Selection Criteria > Sort

2. Inthe Sort section, use the Seq, Sort field, and Order to rearrange the queue.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify the sequence number representing the sorting priority.

Sort Field Select the sort criteria from the list of parameters available in the drop-
down list.

Order Select either 'ascending' or 'descending' as the sort order.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Responsibilities and Users

1. Click Setup > Setup > Queues > Origination > Responsibilities and Users.

2. In the Responsibilities section, use the Responsibilities field to define the
responsibilities roles which are authorized to work on the queues.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Responsibility

Select the responsibility from the drop-down list.

Enabled

Check this box to enable the responsibility.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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5. In the Users section, use the User field to define the users who are authorized to work
on the queue.

6. To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
User Select user from the drop-down list.
Enabled Check this box to enable.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Data Node Assignments

Data node Assignments provides user with the flexibility to view the tabs in origination. User
will have option to enable disable Tabs. All the enabled tabs will be displayed when
application is in that particular queue. Disabled tabs for the tabs will not be shown when
applications is in respective queue.

For example: Application entry Queue

If summary tab to be disabled, the search for the ULN Summary tab and Disable. IN
application Entry summary will not be shown

1. Click Setup > Setup > Queues > Origination > Node Assignments. You can enable
the administrator to configure the User interface nodes that should be made available for
the applications that are being processed in that particular origination queue.

2. Inthe Node Assignments section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Node Select the node from the drop-down list.
Enabled Check this box to enable the record.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Load Queue Nodes to display the respective Ul nodes in the origination module.

Group Assignment

The Group Assignment sub tab allows you to add user groups to Origination Queue.

Note

Modification of user details (adding or disabling users) within a user group which is added
to Group Assignment will implicitly be updated in Responsibilities and Users tab also.

To add User Group to Group Assighment

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > Origination > Group Assignment.
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2. Inthe User Group section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Group Name Select the user group name from the drop-down list. The list
displays the pre-defined user groups available in the system.

Enabled Check this box to enable the user group.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.2 User Groups Tab

The User Groups tab in Queues is a centralized repository which allows you to define user
groups, add and remove users from user groups.

The User Groups tab consists of User Group Definition section listing the defined User
Groups and User section below listing the associated users of the selected User Group.
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To define a User Group

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > User Groups.

2. Inthe User Groups section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Name Specify user group name.
Description Specify an appropriate user group description. The same is

used while referring this User Group on other screens.

Responsibility Select the responsibility of the user group from the drop-down
list. You can later add only those ‘Users’ who have the selected
responsibility into the user group.

Enabled Check this box to enable the user group.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

To add Users to User Group

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > User Groups.

2. Inthe User Groups section, select the required User Group.

3. Inthe Users section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Name Select the user from the drop-down list, The list displays the
available users based on the responsibility defined for the user
group.

Enabled Check this box to enable the user.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
Printers

The Printers screen allows you to set up an unlimited number of network printers and fax
devices to be used with the system server. The system uses the information on this screen
while selecting a printer, when the printing process involves a batch job or uses a job
scheduler. Examples include printing reports and correspondence.

The printers and fax devices can be set up at each organization, division, or department to
promote efficient printing of documents, and reports. The system uses this information during
product setup and on the Letters screen in the Batch Printer field.

Special printer names

The following printer names are predefined and have specific functions within the system:

Name Description

UNDEFINED Indicates that the document to be printed is to be previewed in your
browser instead of actually printing the document.

ARCHIVE Instead of sending an item to the printer, the system generates a
PDF document and saves it in the archive directory on your server.

EMAIL For origination correspondences that can be faxed, the system e-
mails the document as a PDF attachment to the consumer for direct
or to the producer in the case of in-direct .

FAX For origination correspondences that can be faxed, the system gen-
erates a PDF document and will send to the fax server defined in
System Parameters.

Additionally, you may set up composite entries in the Printer Name field to perform two or
more functions at the same time. This can be done by defining a printer name with the
following format:

PRINTER NAME = <PRINTER NAME1> + <PRINTER NAME2>
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For example, if a printer named JET4050 was previously defined, as were the special printer
names listed above, then the following additional printers could be defined:

Name

Description

JET4050+ARCHIVE Prints the document with the jet4050 printer and archives the

document.

FAX+ARCHIVE

Faxes and archives the document.

EMAIL+ARCHIVE+] | E-mails, archives, and prints the document with the jet4050

ET4050

printer.

To set up the Printers

1. Click Setup > Setup > Administration > User > Printers. The system displays the
Printers screen

2. In the Printers section, perform any of the Basic Operations mentioned in Navigation
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